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About Tektronix oscilloscopes Introduction

Introduction

This Tektronix oscilloscope provides the performance, simplicity, and connectivity needed for the
ever-changing electronics, computer, and communications industries. The easy-to-use interface includes a
large display and a touch-screen interface on a Microsoft Windows platform.

Choose the methods of controlling oscilloscope operations that are most convenient for you:
m  Customary front-panel controls

m  Menus and toolbar buttons

B Touch screen

What do you want to do next?

B Read the product description. (see page 1)

B Learn about using the online help. (see page 38)

m  Learn about working with your oscilloscope. (see page 965)

Product description

This online help supports the following series of Tektronix Digital Phosphor oscilloscopes:
= MSO70000DX and DPO70000DX Series

®  DPO70000C Series

® MSO70000C Series

= DPO7000C Series

®  MSOS5000B and DPO5000B Series

NOTE. The features and options that are documented in this online help are available for several
instrument models. Your instrument may not have every feature discussed.

Key features

Tektronix oscilloscopes are high-performance solutions for verification, debugging, and characterization of
sophisticated electronic designs. These oscilloscopes feature exceptional signal acquisition performance,
operational simplicity, and open connectivity to the design environment. Classic analog-style controls, a
large display with an optional touch-sensitive screen, and graphical menus provide intuitive control. Open
access to the Windows operating system enables unprecedented customization and extensibility.

Key features include:

MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series 1



About Tektronix oscilloscopes Product description

®  Bandwidth:

= MSO073304DX, DPO73304DX, MS072504DX, DPO72504DX, MS0O72304DX, and
DPO72304DX: 33, 25, and 23 GHz models with up to 100 GS/s real-time sampling rate on two
channels

= DPO71254C, MSO71254C, DPO71604C, MSO71604C, DPO72004C, and MSO72004C: 12.5,
16, and 20 GHz models with up to 100 GS/s real-time sampling rate on two channels

= DP0O70404C, MSO70404C, DPO70604C, MSO70604C, DPO70804C, and MSO70804C: 4, 6,
and 8 GHz models with up to 25 GS/s real-time sampling rate on four channels

- DPO7054C, DPO7104C, DPO7254C, and DPO7354C: 500 MHz, 1 GHz, 2.5 GHz, 3.5 GHz
models with up to 20 GS/s real-time sampling rate on two channels

= DPO5034B, MSO5034B, DPO5054B, MS0O5054B, DPO5104B, MSO5104B, DPO5204B, and
MSO05204B: 350 MHz, 500 MHz, 1 GHz, and 2 GHz models with up to 10 GS/s real-time
sampling rate on two channels

®  Record length: up to 1,000,000,000 samples on 2 channels and 500,000,000 samples on 4 channels,
depending on the model and options

m  Fast acquisition up to 250,000 acquisitions per second, depending on the model of instrument

®  Enhanced Bandwidth (see page 683) controls available for some models

®  Up to 1% DC vertical gain accuracy
®  Four input channels (each with 8-bit resolution)
B Auxiliary trigger input and output

B Sample, envelope, peak-detect, high-resolution, average, fast acquisition, and waveform database
acquisition modes

®  Full programmability, with an extensive GPIB command set and a message-based interface

B Extensive suite of advanced triggers including edge, bus, logic, pulse, video, communication
(optional), sequence, low-speed serial, and serial pattern

m  Powerful built-in measurement capability, including histograms, automatic measurements, eye pattern,
and measurement statistics

B Basic math as well as advanced equation editor and spectral analysis

m A large 12.1 inch (307.3 mm), 1024 x 768 resolution, XGA color display that supports color grading
of waveform data to show sample density

m  Customizable MyScope control windows (see page 387)

B An intuitive graphical user interface (GUI) with online help
B [nternal disk storage

B Wide array of probing solutions, options, and upgrades

m  GPIB Controller available on some models

B Comprehensive suite of right-click menus

2 MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series



About Tektronix oscilloscopes Product description

Parallel bus decoding, triggering and analysis

Serial bus decoding, triggering and analysis are optionally available

MSO70000C/DX Series Mixed Signal Oscilloscopes also offer:

16 digital channels plus 1 clock/qualifier channel

High resolution timing as precise as 80 ps

An analog view of any digital channel through the iCapture feature
Enhanced Logic Pattern and Logic State triggering includes digital channels
Differential (P6780) and single-ended (P6717A) logic probes

Easy connection to your device-under-test through the convenient design of the P6780 and the
P6717 Logic probes

iCapture allows analyzing the analog characteristics of the digital channels

MSOS5000B Series instruments offer:

MagniVu 60.6 ps resolution

Signal processing features

Waveform math. Set up math waveforms (see page 247) using the basic arithmetic functions,
including FFT, or create more advanced math waveforms using the math expression editor. Waveform
expressions can contain measurement results and other math waveforms.

Spectral analysis. Display spectral magnitude and phase waveforms based on your time-domain
acquisitions. Control the instrument using the traditional spectrum analyzer controls (see page 763),
such as span, center frequency, and resolution bandwidth.

Mask testing. Use Mask Testing (see page 786) for signal violation detection and pass/fail testing.
Test signals against a user defined mask, or with the Mask Testing Option (see page 914), you can
test against industry standard masks.

Display features

MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series

Color LCD display. Identify and differentiate waveforms (see page 172) easily with color coding.
Waveforms, readouts, and inputs are color matched to increase productivity and reduce operating
erTors.

Digital phosphor. The Digital Phosphor Oscilloscope can provide visual clues as to the relative rate
of occurrence of waveform features or anomalies by combining many separate acquisitions of a
waveform into a single intensity-graded or color-graded display.

Fit to screen. The Digital Phosphor technology performs the compression required to represent all
record points on the screen, even at the maximum record length settings.

MultiView Zoom. To take advantage of the full resolution of the instrument, you can zoom in on a
waveform (see page 728) to see fine details. Both vertical and horizontal zoom are available. You
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can also zoom in on multiple areas of a single waveform simultaneously and on multiple waveforms
at the same time.

Measurement features

B Cursors. Use Cursors (see page 84) to take simple voltage, time, and frequency measurements.

B Automatic measurements. Choose from a large palette of amplitude, time, histogram, and
communication measurements. You can customize the measurements (see page 728) by changing
reference levels or by adding measurement gating. Statistics (mean, maximum, minimum, standard
deviation and population) are available for each measurement value.

Trigger features

®  Simple and advanced trigger types. Choose a simple edge trigger or advanced trigger types (see
page 393) to help you capture a specific signal fault or event.

B Dual triggers. Use the A (main) trigger system alone or add the B trigger to capture more complex

events. You can use the A and B triggers together (see page 911) to set up a delay-by-time or
delay-by-events trigger condition.

Convenience features

Autoset. Use Autoset (see page 691) to quickly set up the vertical, horizontal, and trigger controls
for a usable display.

MyScope. Use MyScope (see page 387) to create your own control windows for easy access to the
controls you use most often.

Touch screen interface. You can operate all instrument functions (except the power switch) from the
touch screen interface (see page 60). You can also install a mouse and keyboard.

Toolbar or menu bar. You can choose a toolbar operating mode (see page 34) that is optimized for
use with the touch screen, or a PC-style menu-bar operating mode (see page 33) that is optimized
for use with a mouse.

Open desktop. The instrument is built on a Microsoft Windows software platform; the instrument
application program starts automatically when you apply power to the instrument. You can minimize
the instrument application and take full advantage of the built-in PC to run other applications. Moving
waveform images and data into other applications is as simple as a copy/paste operation.

Dedicated front panel controls. The front panel contains knobs and buttons (see page 39) to provide
immediate access to the most common instrument controls. Separate vertical controls (see page 62)
are provided for each channel. The same functions are also available through the screen interface.

Data storage and I/0. The instrument has a removable hard disk drive and a DVD/CD-RW drive that
can be used for storage and retrieval of data. The instrument has GPIB, USB, Centronics (available
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on some models), RS-232, XGA out, extended desktop support, and Ethernet ports for input and
output to other devices.

®  Online help. The instrument has a complete online help system (see page 38) that covers all its
features. The help system is context sensitive; help for the displayed control window is automatically
shown if you click the help button. Graphical aids in the help windows assist you in getting to the
information you need. You can also access the help topics through a table of contents, index, or
full text search.

Product software

The instrument includes the following software:

®  System Software. The product software runs on a specially configured version of Microsoft Windows
which is pre-installed and enables you to install other compatible applications. Do not attempt to
substitute any version of Windows that is not specifically provided by Tektronix for use with your
instrument.

B Product Software. This pre-installed software is the instrument application and runs on Microsoft
Windows. It provides the graphical user interface (GUI) and all other instrument control functions.
You can minimize or even exit/restart the instrument application as your needs dictate. However, it is
recommended that you exit the instrument application only when installing new software.

B Support Software. The product software DVD, included with the instrument, contains additional
software and files that may be useful to you.

®  Readme file. This text file contains release notes and updates that are not included in other product
documentation.

®  GPIB Programmer Online Help. Available as online help or a PDF file. It contains the information
you need to program the instrument through its GPIB interface.

B Specifications Performance Verification Procedures. The product DVD contains instrument
specifications and instructions to perform a manual performance verification.

See the instructions on the product software DVD for information about installing the support software.

NOTE. New versions of software for your instrument are available at our Web site. To find application
software releases that may not be on your instrument or to find the latest versions of instrument software
and application software that is on your instrument, visit www.tektronix.com/support.

Firmware upgrade

Tektronix may offer firmware upgrade kits for this instrument. Contact your local Tektronix distributor
or sales office for more information.

MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series 5
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Recommended accessories

The following accessories are recommended for your instrument.

MSO5000B and DPO5000B:

GPIB-to-USB adapter, order TEK-USB-488

Tek VPI-to-TekProbe BNC adapter, order TPA-BNC
Hard transit case, HCTEK54

Rackmount kit, order RMD5000

Deskew pulse generator, 067-1686-XX

Mini keyboard, 119-7275-XX

Service manual as a PDF, 077-0076-XX
Programmer manual as a PDF, 077-0010-XX

Specifications and Performance Verification manual as a PDF, 077-0063-XX

DPO7000C

Oscilloscope cart, order K420

Power deskew fixture, order 067-1478-XX
Mini keyboard (USB), order 119-7275-XX
Rackmount kit, order 016-1965-XX

Service manual as a PDF file, 077-0076-XX

MSO/DPO70000DX, DPO70000C, and MSO70000C:

Deskew fixture, order 067-1586-XX

Oscilloscope cart, K4000 with brackets: order 407-5187-XX and 407-5188-XX
Rack mount, order 016-1981-XX

Transit case, order 016-1977-XX

Service manual as a PDF file, 077-0076-XX

The following probes and components are recommended for your instrument:

MSO5000B and DPO5000B:

TekProbe

TekProbe component Description

ADA400A 100X, 10X, 1X, and 0.1X, high gain differential amplifier
P5100A 2.5 kV, 100X, 250 MHz high voltage passive probe

MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series
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TekProbe component

Recommended accessories

Description

P6015A

40 kVpk, 1000X, 75 MHz high voltage single-ended passive probe

TCPA300, TCPA400

Current measurement systems amplifier (requires TPA-BNC)

m  TekVPI
TekVPI component Description
TAP1500 1.5 GHz active single-ended voltage probe
TAP2500 2.5 GHz active single-ended voltage probe
TCP0020 50 MHz, 20 A AC/DC current probe
TCPO0030A DC to 120 MHz, 30 A AC/DC current probe
TCP0150 DC to 20 MHz, 150 A AC/DC current probe
TDP0500 500 MHz active differential voltage probe
TDP1000 1 GHz active differential voltage probe
TDP1500 1.5 GHz active differential voltage probe with £8.5 V differential input
voltage
TDP3500 3.5 GHz differential voltage probe with £2 V differential input voltage
TPP0502 500 MHz 2X TekVPI passive voltage probe
TPP0850 2.5 kV 800 MHz TekVPI high-voltage passive probe
TPP500, TPP1000 10X Passive Probes are compact with 10X attenuation, designed for
use with Tektronix MSO/DPO4000B and MSO/DPO5000B Series
instruments.
The bandwidth (-3 dB) for TPP500 is 500 MHz.
The bandwidth (-3 dB) for TPP1000 is 1 GHz.
THDP0100 16 kV, 100 MHz high-voltage differential probe
THDP0200 +1.5 kV, 200 MHz high-voltage differential probe
TMDP0200 1750 V, 200 MHz high-voltage differential probe
P5100A 2.5 kV, 500 MHz, 100X high-voltage passive probe
DPO7000C
= BNC
BNC component Description
CT1, CT2, CT6 Current probes, AC high-speed
P6021, P6022 Current probes, AC
B TekProbe

TekProbe component

Description

ADA400A

Differential preamplifier

P5100A

High-voltage probe

P6015A

High-voltage probe

MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series
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TekProbe component Description

P6139B Passive probe

P6158 20X low-capacitance probe, 3 GHz

P6243 Active probe, 1 GHz

P6245 Active probe, 1.5 GHz

P6246 Differential probe, 400 MHz

P6247 Differential probe, 1 GHz

P6248 Differential probe, 1.5 GHz

P6701B Converter, optical-to-electrical (multi-mode)

P6703B Converter, optical-electrical (single-mode)

TCP202A Current probe

TCP300, TCP400 Series Current measurement system (Requires TCPA300/TCPA400
amplifiers)

m  TekVPI

TekVPI component Description

TAP1500 Active probe, 1.5 GHz

TAP2500 Active probe, 2.5 GHz

TAP3500 Active probe, 3.5 GHz

TCP0020 50 MHz TekVPI 20 Ampere AC/DC current probe

TCPO0030A 120 MHz TekVPI 30 Ampere AC/DC current probe

TDP0500 500 MHz TekVPI differential voltage probe with +42 V differential
input voltage

TDP1000 1 GHz TekVPI differential voltage probe with 42 V differential input
voltage

TDP1500 1.5 GHz TekVPI differential voltage probe with £8.5 V differential input
voltage

TDP3500 3.5 GHz TekVPI differential voltage probe with +2 V differential input
voltage

TCP0150 DC to 20 MHz, 150 A AC/DC current probe

THDP0100 16 kV, 100 MHz high-voltage differential probe

THDP0200 +1.5kV, 200 MHz high-voltage differential probe

TMDP0200 1750 V, 200 MHz high-voltage differential probe

P5100A 2.5 kV, 500 MHz, 100X high-voltage passive probe

MSO/DPO70000DX, DPO70000C, and MSO70000C:
= BNC
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BNC component Description
CT1, CT2, CT6 Current probes, AC high-speed
P6021, P6022 Current probes, AC

B Logic (MSO70000C/DX Series)

Logic component Description
P6717A 16 data and 1 clock channel logic probe with accessories
P6780 16 data and 1 clock channel differential logic probe with accessories

that you solder in

MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series 9
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TekConnect

TekConnect component

Recommended accessories

Description

P7260

Low-capacitance active voltage probe, 6 GHz

P7313, P7313SMA

Differential probe, 12.5 GHz

P7350, P7350SMA

Differential probe, 5 GHz

P7360

Differential probe, 6 GHz

P7380, P7380SMA

Differential probe, 8 GHz

P7504 TriMode probe, 4 GHz

P7506 TriMode probe, 6 GHz

P7508 TriMode probe, 8 GHz

P7513A TriMode probe, 13 GHz

P7516 TriMode probe, 15 GHz

P7520A TriMode probe, 25 GHz with optional tip
P7630 TriMode probe, 30 GHz

TCA-BNC Adapter, TekConnect-to-BNC

TCA-N Adapter, TekConnect-to-N

TCA-SMA Adapter, TekConnect-to-SMA

TCA-IMEG High-impedance buffer amplifier (Includes P6139A passive probe)
TCA-75 Adapter, 4 GHz: 75 Q to 50 Q 75 Q BNC input
TCA-292MM TekConnect to 2.92 mm connectors
TekProbe

TekProbe component

Description

ADA400A Differential preamplifier

P5050 10X passive probe, 500 MHz
P5100 High-voltage probe

P5200 High-voltage differential probe
P5205 High-voltage differential probe
P5210 High-voltage differential probe
P6015A High-voltage probe

P6101B 1X passive probe, 15 MHz
P6139A Passive probe

P6158 20X low-capacitance probe, 3 GHz
P6243 Active probe, 1 GHz

P6245 Active probe, 1.5 GHz

P6246 Differential probe, 400 MHz

P6247 Differential probe, 1 GHz

P6248 Differential probe, 1.5 GHz
P6701B Converter, optical-to-electrical (multimode)

MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series
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TekProbe component Description
P6703B Converter, optical-electrical (single-mode)
TCP202A Current probe
TCP300, TCP400 Series Current measurement system (Requires TCPA300/TCPA400
amplifiers)
Options

The following options are available for your instrument.

DPO5000B, MSO5000B:

MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series 1
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m  Software:

Opt.
Opt.

BRR - BroadR-Reach Compliance Testing
DDRA - DDR Memory Bus Analysis; Available, only on 1 GHz and 2 GHz models

(requires DJA)

Opt.
Opt.
Opt.

DJA - Jitter And Eye Analysis Tools - Advanced (DPOJET)
ET3 - Ethernet Compliance Testing
HSIC - USB HSIC protocol decode and electrical validation (Available on 2 GHz

models only.) (requires DJA)

Opt.

MOST — MOST Essentials — Electrical Compliance and Debug Test Solution for

MOSTS50 and MOST150

Opt.
Opt.
Opt.

MSOE - 16-channel MSO'!
MTM - Mask Testing for Serial Communication Standards (up to 1.5 Gb/s)
PS2 - Power Solution Bundle: DPOPWR, THDP0200, TCP0030A, 067-1686-XX

(Deskew Fixture)

Opt.

PS3 - Power Solution Bundle: DPOPWR, TMDP0200, TCP0020, 067-1686-XX

(Deskew Fixture)

Opt.
Opt.
Opt.
Opt.
Opt.
Opt.
Opt.
Opt.
Opt.
Opt.
Opt.
Opt.

PWR - Power Measurement and Analysis

SR-AERO - MIL-STD-1553 Serial Triggering and Analysis

SR-AUTO - Automotive Serial Triggering and Analysis (CAN, LIN, FLEXRAY)
SR-COMP - Computer Serial Triggering and Analysis (RS-232/422/485/UART)
SR-CUST - Custom Serial Analysis Kit for Developers

SR-DPHY - MIPI-D-PHY (DSI1/CSI2) Serial Analysis

SR-EMBD - Embedded Serial Triggering and Analysis (I12C, SPI)

SR-ENET - Ethernet Serial Triggering and Analysis (10BASE-T and 100BASE-TX)
SR-USB - USB Serial Triggering and Analysis (LS, FS, HS)

SVE - SignalVu Essentials - Vector Signal Analysis Software

USB - USB 2.0 Compliance Testing

USBHSIC - USB2.0 and HSIC Bundle, includes options Opt. DJA, HSIC, SR-USB,

and USB

Opt.
Opt.

USBPWR - USB Power Adapter/ EPS Compliance Automated Test Solution
VNM - CAN/LIN Protocol Analysis Software

1 Available for DPO5000B Series. Enabling/disabling this key does not change the model number

12
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B Record Length:

DPO7000C

Opt. SRL - 50 MSamples/ch, 125M maximum for 1 ch and 2 ch
Opt. 10RL - 125 MSamples/ch, 250M maximum for 1 ch and 2 ch

®  Hardware:

Opt. 2SR (available only on DPO7104C instruments) - Double maximum real time sample
rate

B Record Length:

®  Service:

Opt. 5SRL - 250 MSamples max, 50 MSamples/ch

Opt. 10RL - 500 MSamples max, 125 MSamples/ch (Only available on
DPO7254C/DPO7354C instruments)

Opt. R3 - Repair service 3 years, including warranty

Opt. RS - Repair service 5 years, including warranty

m  Software:

Opt. BRR - BroadR-Reach Compliance Testing

Opt. DDRA - DDR Memory Bus Analysis (requires DJA)

Opt. DJA - Jitter And Eye Analysis Tools - Advanced (DPOJET)

Opt. ET3 - Ethernet Compliance Test

Opt. D-PHY - MIPI® D-PHY Characterization and Compliance Testing

Opt. HSIC - USB HSIC protocol decode and electrical validation (For models of bandwidth
>2.5 GHz only.) (requires DJA)

Opt. LSA - Low Speed Serial Analysis (CAN/LIN trigger)

Opt. MOST — MOST Essentials — Electrical Compliance and Debug Test Solution for
MOSTS50 and MOST150

Opt. MTM - Serial Communications Mask Testing
Opt. PWR - DPOPWR Power Measurement and Analysis

Opt. PS2 - Power Solution Bundle: DPOPWR, THDP0200, TCP0030A, 067-1686-XX
(Deskew Fixture)

Opt. PS3 - Power Solution Bundle: DPOPWR, TMDP0200, TCP0020, 067-1686-XX
(Deskew Fixture)

Opt. SR-AERO - MIL-STD-1553 Serial Triggering and Analysis
Opt. SR-AUTO - Automotive Serial Triggering and Analysis (CAN, LIN, FLEXRAY)

MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series 13
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Opt.
Opt.
Opt.
Opt.
Opt.
Opt.

SR-COMP - Computer Serial Triggering and Analysis (RS-232/422/485/UART)
SR-CUST - Custom Serial Analysis Kit for Developers

SR-DPHY - MIPI-D-PHY (DSI1/CSI2) Serial Analysis

SR-EMBD - Embedded Serial Triggering and Analysis (I2C, SPI)

SR-ENET - Ethernet Serial Analysis (I0BASE-T and 100BASE-TX)

SR-PCIE - PCI Express Compliance Module for RT-Eye Serial Data Compliance and

Analysis
Opt. SR-USB - USB Serial Triggering and Analysis (LS, FS, HS)

Opt. SR-810B - 8b/10b Serial Triggering and Analysis

Opt. ST1G — 64-bit NRZ Serial Trigger and 8b/10b Serial Protocol Decode (includes Opt.
SR-810B) (only available on DPO7254C/DPO7354C instruments)

Opt. SV23 - WLAN 802.11a/b/g measurement application (Requires Opt. SVE) (For models
of bandwidth >2.5 GHz only)

Opt
(For

Opt.
Opt.
Opt.
Opt.
Opt.
Opt.
Opt.

Opt

. SV24 - WLAN 802.11n measurement application (Requires Opt. SVE and SV23)
models of bandwidth >2.5 GHz only)

SVA - SignalVu AM/FM/Direct Audio Measurements (requires SVE)

SVE - SignalVu™ Essentials for Vector Signal Analysis

SVM - General Purpose Modulation Analysis (requires SVE)

SVO - Flexible OFDM Analysis (requires SVE)

SVP - SignalVu Pulse — Advance Signal Analysis Software (requires SVE)

SVT - Settling Time Measurements such as Frequency and Phase (requires SVE)
USB - Universal Serial Bus USB2.0 Compliance Test

. USBHSIC - USB2.0 and HSIC Bundle, includes options Opt. DJA, HSIC, SR-USB,

and USB

Opt

. USBPWR - USB Power Adapter/ EPS Compliance Automated Test Solution

MSO/DPO70000C/DX:

m  (Calibration:

14

Opt
Opt
Opt
Opt

Opt.

. C3 - Calibration service 3 years

. C5 - Calibration service 5 years

. D1 - Calibration data report

. D3 - Calibration data report 3 years (with Opt C3)
D5 - Calibration data report 5 years (with Opt C5)
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m  Hardware:

Opt. 1R - Rackmount kit

B Record Length:
MSO070000C/DX, and DPO70000C/DX Series:

®  Service:

Opt. 2XL - 31 MSamples/ch (standard on DPO instruments)
Opt. SXL - 62 MSamples/ch (standard on MSO instruments)
Opt. 10XL - 125 MSamples/ch
Opt. 20XL - 250 MSamples/ch
Opt. 50XL - 500 MSamples/ch

Opt. CA1 - Provides single calibration event for the designated interval
Opt. R3 - Repair service 3 years (including warranty)

Opt. RS - Repair service 5 years (including warranty)

B Software:

MSO70000C/DX, and DPO70000C/DX Series:

Opt. BRR - BroadR-Reach Compliance Testing
Opt. DDRA - DDR Memory Bus Analysis
Opt. DJA - Advanced Jitter and Eye Analysis (standard on MSO instruments)

Opt. D - PHY MIPI D-PHY Transmitter Debug, Characterization, and Compliance Test
Solution (requires DJA)

Opt. DP12 - DisplayPort 1.2 Source Test Automation (requires Opt. DJA and Opt.5XL
or higher)

Opt. ERRDT - Frame and Bit Error Rate Detector in high speed serial standards (requires
option ST6G).

Opt. ET3 - Ethernet Compliance Test

Opt. HSIC — HSIC Essentials - Electrical Validation and Protocol Decode Solution (Requires
Opt. DJA)

Opt. HT3 - HDMI Compliance Test
Opt. HT3DS - HDMI Direct Synthesis for HDMI 1.4 Compliance Test

Opt. M - PHY - MIPI M-PHY Essentials — Characterization and Analysis Solution (Requires
Opt. DJA)

Opt. M - PHYTX - M-PHY Automated Transmitter Solution (requires DJA)

MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series 15
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Opt. M - PHYRX - M-PHY Automated Receiver Solution (Requires Opt. ST6G) (Requires
Opt. ERRDT)

Opt. MTH - Mask Testing for serial standards, 4.25 GB/s (standard on MSO instruments)

Opt. MOST - Electrical Compliance and Debug Test Solution for MOSTS50 and MOST150
(Requires Opt. DJA)

Opt. PCE3 - PCI Express® Transmitter Compliance and Debug (Requires Opt. DJA) (For
models of bandwidth >6 GHz only)

Opt. PWR - DPOPWR Power Measurements and Analysis
Opt. QPI - Intel® Quick Path Interconnect Test Automation Software (Requires Opt. DJA)

Opt. SAS3 - SAS3 12 GB/s Essentials (Requires Opt. DJA and 2XL or higher) (For models
of bandwidth >20 GHz only)

Opt. SFP-TX - SFP+ Compliance and Debug Solution (Requires Opt. DJA)

Opt. SFP-WDP - SFP+ Compliance and Debug Solution — WDP Measurement (Requires
Opt. DJA)

Opt. SDLA64 - Serial Data Link Analysis Visualizer

Opt. SR-AERO - MIL-STD-1553 Serial Triggering and Analysis

Opt. SR-AUTO - Automotive Serial Triggering and Analysis (CAN, LIN, FLEXRAY)
Opt. SR-COMP - Computer Serial Triggering and Analysis (RS-232/422/485/UART)
Opt. SR-DPHY - MIPI-D-PHY (DSI1/CSI2) Serial Analysis

Opt. SR-EMBD - Embedded Serial Triggering and Analysis (12C, SPI) (standard on MSO
instruments)

Opt. SR-ENET - Ethernet Serial Analysis (10BASE-T and 100BASE-TX)

Opt. SR-PCIE - PCI Express Compliance Module for RT-Eye Serial Data Compliance and
Analysis

Opt. SR-USB - USB Serial Triggering and Analysis (LS, FS, HS)
Opt. SR-810B - 8b/10b Serial Triggering and Analysis

Opt. ST6G - Serial Protocol Trigger Software to trigger and decode 8 B/10 B data on
high-speed serial or data protocols. Protocol triggering up to 6.25 GS/s. (standard on MSO
instruments)

Opt. SVA - AM/FM/PM Audio Signal Analysis (Requires Opt. SVE)
Opt. SVE - SignalVu Essentials for Vector Signal Analysis

Opt. SVM - SignalVu Essentials for General Purpose Modulation Analysis (requires option
SVE)

Opt. SVO - Flexible OFDM Analysis (requires SVE)
Opt. SVP - SignalVu Pulse — Advance Signal Analysis Software (requires SVE)

MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series
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Opt. SVT - Settling Time Measurements such as Frequency and Phase (requires SVE)

Opt. TBT-TX - Thunderbolt Transmitter Characterization, Debug, and Compliance Testing
(Requires Opt. DJA and Opt. 2XL or higher) (For models of bandwidth >16 GHz only)

= Opt. UHS2 - UHS-II-Host-Tx and UHS-ii-Device-Tx Measurements (For models of
bandwidth >6 GHz only)

= Opt. USB - Universal Serial Bus USB 2.0 Compliance Test

= Opt. USBHSIC - USB2.0 and HSIC Bundle, includes options Opt. DJA, HSIC, SR-USB,
and USB

= Opt. USBPWR - USB Power Adapter/ EPS Compliance Automated Test Solution (Not
supported on 70000DX models)

Opt. USB3 - Universal Serial Bus USB 3.0 Compliance and Analysis

Opt. VET - Visual Trigger and Search

Opt. 10G-KR - 10GBASE-KR/KR4 Compliance and Debug Solution (Requires Opt. DJA)
(For models of bandwidth >16 GHz only)

Documentation

In addition to the instrument online help, the following documents are available:

u  Digital Phosphor Oscilloscopes User Manual (071-2980-XX). The Quick Start User Manual has
information about installing and operating your instrument. The Quick Start User Manual is available
in several languages, in addition to English.

= Digital Phosphor Oscilloscopes Programmer Online Guide. The Programmer Guide is provided as
online help and as a printable PDF file. See the product software DVD for installation information.

m  Digital Phosphor Oscilloscopes Specifications and Performance Verification Technical Reference
Manual (077-0063-XX). This is a PDF only manual that includes both the specifications and the
performance verification procedure.

= Digital Phosphor Oscilloscopes Service Manual (077-0076-XX). A service manual is available as a
PDF file; it includes procedures to service the instrument to the module level.

Other documentation

Your instrument includes PDF files of relevant information on the product software DVD, Tektronix
part number 020-3079-XX.

For quick access to PDF files of the user manual, probe manuals, programmer guide, primers and
applications, specifications and performance verification manual, service and installation manuals, and a
printable version of the online help, click the Documentation icon on your instrument desktop.

What do you want to do next?

®  Find out about using online help. (see page 38)
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m Learn how to access Tektronix Support. (see page 18)

B Provide feedback on this Tektronix product. (see page 21)

Support information

Tektronix offers the following services in support of our products:

m  Technical Support. For application-related questions about a Tektronix product, contact us by
telephone or e-mail ).

B Service Support. For service-related questions about a Tektronix product, contact us by telephone or
e-mail ).

Tektronix also offers extended warranty and calibration programs as options on many products.
Contact your local Tektronix distributor or sales office.

B Write to Tektronix:
Tektronix, Inc.
Department or name (if known)
14200 SW Karl Braun Drive
P.O. Box 500
Beaverton, OR 97077 USA
What do you want to do next?

B Find out what other documents are available. (see page 17)

® Find out about using online help. (see page 38)

B Provide feedback on this Tektronix product. (see page 21)

TekScope Recovery Report Utility

The TekScope Recovery Report Utility is designed to gather logs and other files that may contain data
useful to Tektronix in the diagnosis of TekScope Errors, and it creates a .zip file on the desktop to hold all
of the gathered data. This compressed file is easily copied from the desktop to a removable flash drive, or
the file can be sent to Tektronix as an email attachment.

If you contact Tektronix for help in diagnosing TekScope Errors, you may be asked to run this utility
and supply Tektronix with the .zip file.

NOTE. The utility will erase temporary data created under the account of the user that runs the utility.
This allows TekScope to generate fresh files the next time it starts.
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Finding the utility
A link to the utility can be found under the Start\All Programs\Tektronix\TekScope\ directory.

p i [ )
| Acronis ‘

. Games
. Maintenance Tek_Local_Admin
. Microsoft Silverlight

. Microsoft Silverlight 3 SDK Documents

. Microsoft Silverlight 4 SDK

| Microsoft SQL Server 2008 Pictures

. Microsoft Sync Framewaork

. Microsoft Visual Studio 2010
. Mational Instruments

| Startup

. TekApplications

Music
Games
Computer

. Tektronix
. TekScope

|E§5) Online Help
.| Readme

|E§5) TekScope VI Driver Documentat

Control Panel

Devices and Printers

| TekScope IVI Driver Readme Default Programs
E TekScope Recovery Report Utility
E TekScope Help and Support

Back

Search programs and files e created: 9/20,

Running the utility
Click on the utility link.

If TekScope is running when the utility is invoked, the utility will warn the user that TekScope must be
stopped. This is necessary to allow the utility to access some of the files. The utility will automatically
stop TekScope after it queries the serial number of the instrument. Click Yes to allow the utility to stop
TekScope and collect files for the report.

The TekScope Recovery Report Utility requires that TekScope be shut down. u

—
@ Do you want to Continue?
L * 4

Yes No Cancel

If TekScope is not running, the recovery utility will still run and will collect files for the report.
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Finding the report
When the utility is finished running, the zipped report file is on the desktop.

B a) In the case where TekScope was running when the utility was invoked, the name of the .zip report
file created on the desktop will contain the type of instrument and the serial number. For example:
TekScope_Recovery_Report_mMS071254C_123456789.zip.

B b) However, if TekScope was not running when the utility was invoked, the name of the .zip report file
will not contain the serial number. For example: TekScope_Recovery_Report_MS071254C.zip

Data contained in the report

When the utility is finished running, if these files exist on the instrument, the report will contain copies
of these specific files:

:\Windows\Sysnative\winevt\logs\Application.evtx
:\programdata\tektronix\ISD.XML
:\programdata\Tektronix\TekScope\Calibration\console.log
:\programdata\Tektronix\TekScope\Calibration\console.logold
:\programdata\Tektronix\TekScope\Calibration\calSPCConst.dat
:\programdata\Tektronix\TekScope\Calibration\caldiag.Tog
:\programdata\Tektronix\TekScope\Calibration\caldiag.logold
:\programdata\Tektronix\TekScope\Calibration\error.log

NoOon0nNnNnnN

@]

When the utility is finished running, the zipped report file will also contain copies of all files found in the
following directories:

C:\programdata\Tektronix\TekScope\Internal\*.*
C:\programdata\Tektronix\TekScope\Calibration\CalbDrambump\¥*.*
C:\programdata\Tektronix\TekScope\Calibration\CalDrambumpFact\*.*

Data deleted by the utility
Running this utility will delete the following files:
C:\users\<current_user>\AppData\LocalLow\Tektronix\tekScope\Internal\*.*

Because TekScope was having difficulties, some files may have been corrupted. Deleting these files will
allow TekScope to regenerate them on the next start-up. Deleting these files may resolve the initial problem.

The utility log file

You can see a log file of the operation performed by the recovery report utility at:
C:\Temp\TekScopeRecoveryReportUtility_log.txt
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Feedback

Tektronix values your feedback on our products. To help us serve you better, please send any suggestions,
ideas, or other comments you may have regarding your instrument.

B Direct your feedback to us via e-mail at www.tektronix.com/home/mytek/survey.

Include the following information in the subject field: "NEW and IMPROVED Scope Customer Feedback."

Please be as specific as possible.

Recommended information to include
B [nstrument hardware, for example, display, chassis, and so on
B Application software version

B Probes

Optional information
Your name, company, mailing address, phone number, and FAX number.
What do you want to do next?

B Find out what other documents are available. (see page 17)

B Find out about using online help. (see page 38)

B [earn how to access Tektronix Support. (see page 18)

B Return to the beginning of the introduction. (see page 1)

Analysis and connectivity support

This instrument includes tools you can install to support data export for use with data-analysis tools.
You can use the analysis and connectivity tools included with your instrument to do the following:

m  Gather instrument data (waveforms and measurements) and port it to familiar, off-the-shelf, analysis
tools, such as Microsoft Excel

B [nterface with a popular software development environments, such as Lab Windows and LabVIEW

Click the following tools to find out how they can help you connect to your instrument and analyze
the data that it collects:

®  VXI Plug-and-Play Instrument Driver (see page 22)
B TekVISA (see page 22)
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TekVISA ActiveX Control (TVC) (see page 23)

TekVISA Excel Toolbar (see page 23)

VXI 11.2 LAN Server (see page 23)

Report Generator (see page 23)

IVI Drivers (see page 23)

Tek LXI (see page 24)

For more information, see the Getting Started with OpenChoice Solutions Manual.

22

VXI Plug-and-Play instrument driver

The VXIplug&play instrument driver is a collection of software components, organized according
to the standard VXIplug&play model established by the VXIplug&play Systems Alliance. Use this
VXIplug&play instrument driver to simplify programming tasks when using the following software
development environments:

= LabWindows/CVI
®  LabVIEW

= MATLAB

B Visual C++ 6.0

B Visual Basic 6.0
= HP-VEE

TekVISA

TekVISA is a library of industry-standard compliant software components, organized according to the
standard VISA model established by the VXIplug&play Systems Alliance. Use TekVISA in software
to write interoperable instrument drivers to handle communicating between software applications and
your oscilloscope. TekVISA offers the following features and benefits:

B Provides end users with a consistent methodology for using instrument drivers from a variety
of vendors

B Provides programmers with language interface libraries for use with multiple application
development environments, such as Microsoft C /C++, Microsoft Visual Basic, LabVIEW
graphics software using the G language, and MATLAB analysis software.

B Provides a configuration utility for setting up additional VISA resources

m  Allows software installation and connectivity on any number of PCs
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TekVISA ActiveX Control (TVC)

The TekVISA Control (TVC) uses Microsoft Windows ActiveX control technology to simplify access
from Microsoft Office and Visual BASIC applications to TekVISA and the underlying instrument.

This is accomplished by providing support for key TekVISA features within an ActiveX control
object that is compatible with Excel’s Visual BASIC for Applications, Visual BASIC 6.0, and other
popular programming environments for Microsoft Windows.

TekVISA excel toolbar

The TekVISA Excel Toolbar allows direct, fast transfer of instrument measurements or captured
waveforms to an Excel 97 and/or Excel 2000 worksheets. Transfer is via a toolbar that is integrated
into Excel, implemented using the TekVISA ActiveX Control (TVC) and the Visual BASIC for
Applications macro editor built into Excel.

Source code for the toolbar is accessible through Excel’s built-in VBA editor for use as a learning
tool for using the TekVISA ActiveX Control, or to cut-and-paste selected components to new VB
applications.

VX1 11.2 LAN server

The VXI 11.2 LAN Server provides software connectivity between your instrument and remote PCs
over an Ethernet LAN. This tool is a client-side component built-in with TekVISA on each remote
PC, you must install another copy of TekVISA to make use of its client-side component.

The VXI-11 standard specifies a protocol for communication with devices over a network via a
network instrument server. This protocol uses the ONC/RPC (Open Network Computing/Remote
Procedure Call) standard that, in turn, is based on TCP/IP.

Report generator

Report Generator, a Microsoft Windows application, lets you create custom reports for displaying
your oscilloscope data.

Report Generator enables you to generate and print reports directly from the oscilloscope, enhancing
your application capabilities by simplifying the process of creating and maintaining reports.

IVl drivers
IVI drivers conform to specifications produced by the VI Foundation.

Unlike VXI-plug&play drivers, IVI drivers provide a standard interface to different classes of
instruments, including oscilloscopes and spectrum analyzers.

IVI drivers have the ability to simulate instruments, automatically check ranges, and multithread
safety features.
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Tek LXI

Tek LXI conforms to the LAN eXtensions for Instrumentation (LXI) standard. The LXI standard
defines the communications protocols that allow communication with the instrument over a local
area network (LAN).

About Tekscope

From the Help menu, select About TekScope.

Overview

Provides the details of the instrument such as the model name, identification number, serial number, and
version of the software that is installed. The options name and the key details of the applications that are
installed in the instrument are also listed.

MTM: Seral Mask Testing
PTM1: 1.25Gb/s Seral Pattem Trigger
ASM: Advanced Search & Mark
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Windows interface guidelines

Because the instrument uses the Microsoft Windows interface, you have open access to the Windows
operating system. You can access the Windows desktop to load and run other Windows-based applications
such as Microsoft Excel, WordPad, and Paint.

Although you have access to the Windows interface, you should avoid making operating system changes
that may cause problems or annoyances while trying to use the instrument. Here are some guidelines:

The instrument has been tested with the version of Microsoft Windows provided and is not intended
to operate with any other versions.

If the instrument powers on in Windows Safe Mode, the touch screen is inoperative. You may need to
use a mouse or keyboard to restore normal operation.

To keep the start-up time to a minimum, keep the network support to a minimum.

Be careful when making changes in the Control Panel. Avoid making changes to any controls with
which you are unfamiliar.

Do not change the LCD color quality (Highest 32 bit) and screen resolution settings (1024 by 768
pixels) or the video port may not work properly.

Some third-party applications may not work properly with the instrument. If your instrument stops
working after you install third-party software, try reloading the instrument software from the product
software DVD.

If you do not have an external monitor attached to the instrument, avoid changing the taskbar
properties to "Always on top" and "Auto hide." The Windows taskbar may obscure buttons or readouts
on the screen. However, if you do have an external monitor attached and the instrument is set to dual
monitor mode, you can drag the taskbar from the instrument display to the external monitor display
and use these settings.

Disable the Windows screen saver to prevent it from turning on while you are taking measurements or
viewing the display. If the screen saver comes on while taking measurements, touch the screen (if the
touch screen is installed and enabled), move the mouse, or press any key on the attached keyboard.

Do not delete or change any system fonts. Changing, removing, or resizing fonts may affect the
quality of the display and corrupt the TekScope buttons and menus.

Avoid personalizing or changing the system Display Properties, such as the theme, Background,
Appearance, Effects, or Settings. Making such changes can affect the usability of the instrument
and the touch screen.

Avoid making changes to the contents of the Windows folder or to the contents of the TekScope folder.

Avoid making changes to the BIOS settings. Changing the BIOS settings can affect the overall
operation of the instrument.

Avoid changing the Windows power management system.
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If you think that your Windows interface may cause problems with the instrument, contact your local
Tektronix support center (see page 18) for assistance.

Connecting to a network

The instrument is built on a PC-based platform that runs Microsoft Windows as its operating system. Like
any other Windows computer, you can connect the instrument to a network to enable printing, file sharing,
Internet access, and other communications functions.

Use the Windows Remote Desktop feature to remotely access the instrument.

Enabling a network connection

Use the following steps to enable network access to the instrument. You must begin this procedure
with the instrument powered off.

TIP. Consult your network administrator for further assistance.

You may want to print these instructions before you proceed.

1. Attach a keyboard and mouse to the instrument.
2. Power on the instrument.

3. Use the Windows Network Connection Wizard to define the instrument as a network client and
configure it for your network. You can find the network setup program in the Windows Start
menu if you select Settings > Control Panel, and then double-click Network Connections.

4. Consult with your network administrator for specific instructions for these settings.

Using Tek LXI

Tek LXI conforms to the LAN eXtensions for Instrumentation (LXI) standard. The LXI standard defines
the communications protocols that allow communication with the instrument over a local area network
(LAN). After the TekScope application is running, the LXI application starts. The LXI system tray icon
appears when LXI is running.
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Using Tek LXI

Right click on the icon and select Show LAN Status Indicator. LAN status is indicated in red or green
with an appropriate message.

NOTE. Pushing the LAN Reset button does a LAN configuration initialization: enables DHCP, enables
Auto-1P, enables ICMP ping responder, sets the Web password to default (No password), and updates the

LXI XML identification. Refer to the LXI specification for more information.

Enter the IP Address in the Address Bar of your Web browser and click return. The browser finds
and displays the instrument home page. Instrument information, instrument network information, and
instrument LXI information is displayed on the home page. Click on the SUPPORT Help link to see help

on the Welcome Web page.
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2 LXI-TEKTRONIX MS05034(TekScope-739500.local. 134.62.86.53) - Microsoft Internet Explorer
File Edit View Favorites Tools Help

Qe O 8 8 G P e @3- B-JEL S

address @] http//134.62.86.53/

v Beo ik ? @

Tektronix:
7

B = Home

! = Network Configuration

SUPPORT

= Datasheets

= Manuals

= Driver DownLoad
= Help

LXi

Instrument Information
Instrument Model
Manufacturer

Serial Number
Manufacturer Description

Description
Firmware Version

Network Information
Host Name

Mac Address

TCP/P Address
Instrument Address String
LXI Information

LXI Class

LXI Version

MS05034
TEKTRONIX
CQ000002

Digital Phosphor
Oscilloscope

MS05054-CQ000001

CF91.1CT FV:6.0.97
devBuild 32

TekScope-739500.local.
00-04-5F-8C-97-7C
134.62.86.53
TCPIP:134.62.86.53:INSTR

ITektronix.com JProducts

B - I
Welcome: MS05034 Web-enabled User

s
g )

LXI Identification on Instrument
OOn ®Of

&] Done

% Local intranet

Using Tek LXI

To display network configuration information, click on Network Configuration. The Web page displays the
network configuration, and allows you to submit changes to some of the instrument configuration. Click
on the Help SUPPORT link to see help on the configuration information.
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2 LXI-TEKTRONIX MS05034(MS05034QUAL002 134.62.86.53) - Microsoft Internet Explorer
! Fle Edit Vew Favorits Tools Help

Qe - ) - [x] [B] @h | O sewr lormones € (- L) S

: Address @ http://134.62.86.53/wirmLanConfiguration . aspx

vBe ks ? @

Tektronix’
g

le TCPIP Address
Subnet mask
Default Gateway

DNS Server(s)

Change Password

- Home Network Configuration
BN - Network Configuration Host Seffings
Host Name MSO5034QUAL002
SUPPORT Domain [GLOBAL |
= Datasheets Description MS05034-CQ000002
= Manuals §
» Driver DownlLoad Address Seftings
= Help TCPIP Mode ® Auto(DHCP/AutolP) © Manual

[124].[62 |.[e6 |.[1 |
2 ].[i73]

OYes ®@No

T T

Irektronix com  JProducts

-

» -
gty 1.1-1.1-4

LXIIdentification on Instrument
O On@O0fF

% Local intranet

Using Tek LXI

Click on Datasheets, Manuals, or Driver Download to go to the Tektronix Oscilloscopes Web page to

access the information.
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NIST USGCB compliance

30

Tektronix oscilloscopes are compatible with the security configuration for Information Technology
products specified in the United States Government Configuration Baseline (USGCB) settings for
Windows 7 and Internet Explorer.

The National Institute of Standards and Technology (NIST) USGCB baseline operating system security
requirements (Version 1.1.x) were implemented and tested on our oscilloscopes. The oscilloscopes passed
the Security Content Automation Protocol (SCAP) tests. Our oscilloscopes operate with the USGCB
security settings implemented.

NOTE. Since the USGCB turns off the ISS server, LXI Class C compliance does not work with this data
security standard.

As shipped from the factory, your oscilloscope has none of the USGCB security settings implemented.

Making your oscilloscope compliant

To put their oscilloscope in a USGCB compliant state, follow instructions from the NIST Web site. Click
on the Content and then Microsoft Content links. Implement the settings in the GPO files found on the site.
After implementing all of the settings, run the SCAP tool to verify compliance.

Restoring your oscilloscope to its factory state

To back out of the USGCB compliant state and restore the oscilloscope to its factory condition, follow the
Operating System Restore procedures for your instrument. See you user manual.
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Hard copy printing

To make hard copies, use a printer attached to one of the rear-panel ports or connect to a network printer, if
your instrument is on a network.

You can print the full screen or just the graticule area.

The instrument uses Windows print drivers, so the process to install printers is the same as it is on any
other PC.

The Page Setup dialog box contains some useful options to optimize your printing:

B Choose a print palette that is independent from the display palette. For example, you can print
gray-scale images to a black and white laser printer while you choose to view the display in color.
The color and gray scale palettes both render the intensity-graded waveform information generated
by the DPO display.

B Choose the Ink Saver feature to print a hard copy with a white background. This function saves
printer ink while it preserves the color coding of the waveforms and readouts. Ink Saver also works
with the monochrome print palettes.

Other PC applications

Transferring images and data from the oscilloscope to other PC applications is as simple as a copy/paste
operation. With a word processing, spreadsheet, or analysis application running on the built-in PC, you can
easily transfer the following items using the familiar Windows clipboard system:

®  Copy a full screen or graticule-only image, and paste it into your document in either .bmp, .png,
tif, or .jpg format.

B Copy a waveform, and paste the waveform data into a spreadsheet in a comma-delimited (.csv) format.
B Copy a waveform, and paste the waveform data into an analysis program in Mathcad (.dat) format.
m  Copy the displayed values of all measurements, and paste them into a document in text (.txt) format.

B Copy the displayed values of all measurements, and paste them into a spreadsheet in a
comma-delimited (.csv) format.
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Second monitor use

To optimize your access to the PC that is built into the oscilloscope, connect a keyboard, mouse, and
monitor to the instrument, and then configure Windows for dual-display mode.

In this configuration, the oscilloscope retains full dynamic oscilloscope performance while Windows and
other applications such as publishing, analysis, or Web browsing tools reside on the external monitor. You
can copy/paste bitmap and waveform data from the oscilloscope to the locally running application or view
Web-based reference information while using the oscilloscope for design work.

Dockable windows

You can drag up to five dockable half-screen control windows from the TekScope application onto the
display of a second monitor. For example, this feature allows you to have the Horizontal/Acquisition,
the Horizontal Zoom, and the Display Setup Control Windows (half screen) open on the second monitor
at the same time.

In addition to the five dockable windows on the second monitor, you can have one dockable window open
on the main display. If you open a seventh dockable window, the window that has not been used for the
longest amount of time will automatically close.

To drag a half-screen control window, click and drag on the left edge of the window.

Connect to other instruments

®  Use the rear-panel vertical signal output (Signal Out) to connect to a buffered version of the signal
that is attached to the Channel 3 input (DPO7000C models only).

B Use the rear-panel auxiliary output (Aux Out) to obtain a TTL-compatible, negative polarity pulse
when the oscilloscope triggers, or when certain other events occur, such as a mask test failure or
completion.

m  Use the rear-panel external reference input (Ext Ref) to synchronize the oscilloscope time base to an
external 9.8 MHz to 10.2 MHz reference frequency source.

Instrument interface

32

You can use the familiar knobs and buttons on the oscilloscope front panel to perform most vertical,
horizontal, and triggering functions. It allows you to make quick adjustments to your displayed signals
with the dedicated vertical controls for each channel.

The screen interface gives you access to the complete functionality of the instrument. This user interface is
built on the Windows operating system and has a similar look and feel. It is also fully compatible with a
wide range of PC hardware and software accessories, such as networked instrumentation and printers.
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The toolbar at the top of the screen is optimized for touch screen operation. Touching (or clicking) a button
on the toolbar opens a control window that you can use to select the instrument settings.

Horizontal

62.5MS/s

Position

50.0%

With a mouse, you may prefer to use the PC-style menu bar to open control windows or directly select

many instrument settings. Click the &l button, in the upper-right corner of the screen, to switch between
Menu Bar Mode (see page 33) and Toolbar Mode (see page 34).

Menu bar mode

The menu bar menus provide access to commands that control all of the instrument features and functions.

File | Edit | “ertical | Digital | Horiziteg | Trig | Dizplay | Cursors | Measure | Mask | Msth | MyScope | Anslyze | Utilties | Help -

When you select a feature setup command, the instrument displays the associated control window on the
lower half of the screen. Each control window provides access to the individual instrument controls.

The display graticule is redrawn to fit in the upper half of the screen.
What do you want to do next?

®  Display help on the File menu. (see page 823)

® Display help on the Edit menu. (see page 818)

® Display help on the Vertical menu. (see page 936)

® Display help on the Digital menu. (see page 812)

®  Display help on the Horizontal/Acquisition (Horiz /Acq) menu. (see page 833)

B Display help on the Trigger (Trig) menu. (see page 928)

®  Display help on the Display menu. (see page 815)

® Display help on the Cursors menu. (see page 804)

® Display help on the Measurement (Measure) menu. (see page 873)

B Display help on the Math menu. (see page 868)
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m Display help on the Mask menu. (see page 859)

B Display help on the Analyze menu. (see page 936)

B Display help on the Utilities menu. (see page 936)

® Display help on the Help menu. (see page 38)

Toolbar mode

34

The toolbar buttons give you instant access to most instrument features without having to navigate
through several menus.

Click a toolbar button to display an associated control window on the lower half of the screen. Each
control window provides access to the individual instrument controls. The display graticule is redrawn
to fit in the upper half of the screen.

Not all features of the instrument are accessible from the toolbar. To access some of the less common
controls, you can change to Menu Bar Mode (see page 33). To do this, click the Menu button (with
the arrow) in the upper-right corner of the screen.

You can also customize the toolbar to add menus you use more frequently. Click the Menu button (with the
arrow) to see the list of menus you can add and to access the Customize Toolbar dialog box.

Show Menu

™
i
k)

TR
* (Clear Data)

Customize...
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What do you want to do next?

Display help on the Vertical Setup control window. (see page 485)

Display help on the Digital Setup control menu. (see page 89)

Display help on the Horizontal/Acquisition Setup control window. (see page 181)

Display help on the Trigger Setup control window. (see page 393)

Display help on the Display Setup control window. (see page 167)

Display help on the Cursors Setup control window. (see page 75)

Display help on the Measurement Setup control window. (see page 274)

Display help on the Math Setup control window. (see page 247)

Display help on the Mask Setup control window. (see page 215)

Display help on the Save As dialog box. (see page 535)

Display help on the Recall dialog box. (see page 528)

Learn to Customize the Toolbar. (see page 36)
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Toolbar customizing

The Customize option of toolbar mode gives you access to add or remove menu buttons, configure the
order of the menu buttons, and set the toolbar back to its default configuration. You can customize the
toolbar to view the menu buttons that you use more frequently.

[}

—Customize Toolbar

Spectral (Basic)
Spectral (Advanced)
Clear (Clear Data)
Save A=

To access some of the less common controls, click the Menu Bar Mode (see page 33). To do this, click the
Menu button (with the arrow) in the upper-right corner of the screen and select Customize to display the
Customize Toolbar dialog box.

Use the Up and Down buttons to move buttons within or between the Always Visible and Overflow panes.

Click the Default button to restore the default configuration on the toolbar.
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User interface map

See the next figure for a description of the elements of the user interface. These elements provide complete
control of the instrument.

—

[ 100us  -1.0MSIs - -t.0psipt
f .

43943 acqs
September 14, 2005 13:55:25

1. Menu bar: Access to data I/O, printing, online help, and instrument functions.
2. Buttons or Menu bar: Click to toggle between toolbar and menu bar modes.
3. Multipurpose knob readouts: Adjust and display parameters controlled by the multipurpose knobs.

4. Display: Waveforms from live, reference, math, and digital channels display here, along with buses
and cursors.

5. Waveform handle: Click and drag to change the waveform vertical position.
6. Controls status: Quick reference to vertical selections, scale, and parameters.

7. Readouts: Display of cursor and measurement readouts in this area. You can select measurements
from the menu bar or toolbar.

8. Status: Display of acquisition status, mode, and number of acquisitions; trigger status; date; time;
quick reference to horizontal parameters.
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Online help

The online help is designed to assist you with all the features of the instrument.

Context-Sensitive help

Use the instrument online help to quickly get information about a function or assistance in performing

a task:

B In Toolbar mode, click Help to display online help for the active window.

B From the menu bar, click Help to display a list of help options.

B [f you are using the touch screen, you can touch the Help button in either mode.

B The keyboard F1 function key displays help for the active window in either mode.

Microsoft Windows Help

Help is also available as part of Windows. For information about Windows features, refer to the Windows
online help by clicking Start in the Windows toolbar, and then selecting Help and Support.

What do you want to do next?

Learn how to navigate the online help. (see page 38)

Find out what other documents are available. (see page 17)

Learn how to contact Tektronix Support. (see page 18)

Provide feedback on this Tektronix product. (see page 21)

Provide information about Tekscope (see page 24)

Navigating the online help

38

To open the online help select Help, and then select Contents and Index. From the online help finder,
select one of the following tabs:

Contents Tab. Click any entry to display information on the subject.

Index Tab. Double-click an entry to display information on the subject. Or, enter a keyword you are
looking for (the list scrolls to that topic). Click Display to open the topic.

Search Tab. Type in the keyword you are looking for; then click List Topics. Every topic that contains
the keyword will be displayed. Select a topic, and then click Display to open the topic.

Favorites Tab. To save the current topic to the Favorites list, click the Favorites tab; then right-click
and select Add. Double-click to return to a topic at any time.
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What do you want to do next?

®m  Find out what other documents are available. (see page 17)

ESD precautions

To avoid damage to the instrument, observe the following ESD (electrostatic discharge) precautions:

B Before you apply power, connect the instrument to an electrically-neutral reference point, such as
earth ground. To do this, plug the three-pronged power cord into an outlet grounded to earth ground.

m  [fyou are working with static sensitive components, ground yourself. Static electricity that builds
up on your body can damage static-sensitive components. Wear a wrist strap to safely send static
charges on your body to earth ground.

1785-002

Grounding the oscilloscope is necessary to ensure safety and to take accurate measurements. The
oscilloscope must share the same ground as any circuits that you plan to test.

Changing control settings

As you configure the instrument, you may need to set a numerical parameter such as a reference level or
delay time.

There are several different ways to set these parameters in a control window:

B Touch or click the parameter to select it. Once selected, one of the multipurpose knobs (see page 40)
is assigned to the parameter.

= To adjust a setting, turn a front panel upper knob (a) or lower knob (b) as indicated by the knob
graphic indicator (see page 41) next to the control window parameter.

B Push the front panel Fine button to use the knob to make small changes, for example to add another
decimal place for greater accuracy.

This online help usually refers to using the multipurpose knobs to change control settings, although the
following methods are generally available:
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B Some parameters with discrete values have increment/decrement buttons (see page 41). Touch or
click them to change to the next available value.

B Some parameters supply a pop-up keypad (see page 42) or keyboard that you can use to enter a new
value. Some features provide other pop-up keypads (see page 43).

B [fyou have an external keyboard attached, you can also use it to type in a new value.

B You can also adjust parameter values using the mouse wheel. Press the mouse wheel to access fine
mode. Press it again to return to normal mode.

Multipurpose knobs

O

The multipurpose knobs on MSO/DPOS5000B Series instruments are as follows:
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Graphic indicator

Position
[ 0.0div @
Scale
TR
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Increment/Decrement buttons

Position
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Pop-up keypad

1. Double click in a data entry box, or:

= Click on the keypad icon.

2. Use the pop-up keypad to enter data.

Sample Rate Keypad.

3. Click the Enter Button.
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Other keypads

" 8b/10b Charact X

K28.5

1. 8b10b Character Keypad.

" 8b/10b Symbol X

1100000101

8b10b Symbol Keypad.

Moving and docking control windows

Control windows that open on the lower half of the screen can be moved to any location. To do this, move
the cursor to the upper left-most corner of the window until the hand appears. Left-click the mouse button
to grab the handle (see page 44). Hold the button and drag with the mouse to another position on the screen.

You can move freely to any position on the screen or to a second monitor (if you have set up a dual display)
by dragging the window. All controls on the window can be accessed and function as usual.
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NOTE. The window cannot be resized.

Control window handle
|~

Vertical Setup

0020007

Controlling from within the graticule area

44

Use the mouse or your finger in the graticule area to click and drag (or touch and drag) the following:
B An on-screen cursor to another position on the waveform.

m A waveform handle (see page 45) to change the vertical position of a waveform.

m A waveform label (see page 45) or other screen text that you have entered to reposition it.

®  The horizontal reference marker (see page 45) to set the horizontal position.

B The trigger level marker (see page 45) to set the trigger level.

You can also click and drag (or touch and drag) across part of a waveform to select it and investigate it
further. Once the selection is made, choose one of the following actions:

B Create a Zoom waveform that covers just the selected area

B Create a histogram to analyze the selected area

B Turn on measurement gates that take measurements only in the selected area
B Create a visual trigger area.

B Cancel the selection
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Accessing shortcut menus by right-clicking

Accessing shortcut menus by right-clicking

Waveform handle

1!

Waveform label

Horizontal reference marker

Trigger level marker

You can right-click to gain quick access to most common commands.

Right-click on a graticule, an object, or a readout to access their shortcut menus. The menus are dynamic;
their contents will vary, depending on the area or the object you right click.

You can right-click on any of the following to open a dynamic shortcut menu:

Waveform handle
Cursors

Labels

Histogram display
Masks

Templates
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m  Trigger level marker

B Visual trigger area

B Readouts (the menu varies with the type of readout)
®E  Graticule

= Control window

B Entry boxes

B Regions (Menu bar, Toolbar, Multipurpose Knobs)

Creating your own control windows

For quick access to the controls that you use most often, you can create your own MyScope control
window (see page 387). Choose from a list of controls to include, and make each control window
unique to your needs.

MyScope allows you to have up to eight tabs in a control window, increasing the flexibility and ease of use
for your unique MyScope control windows. You can create and save any number of control windows for
future use.

Initialize the instrument

46

After you complete a task, you may want to initialize the instrument settings before using the instrument
with your next task. This may be especially important if you share the instrument with others; previous
settings may make it difficult for you to perform the required task.

To quickly restore the instrument to its default settings, push the front-panel Default Setup button.

If data security is important to you, use the TekSecure Erase feature to overwrite all internal waveform and
setup memory with null values.
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Choosing and connecting probes

CAUTION. To avoid damage to the instrument, observe ESD (electrostatic discharge) precautions (see

page 39).

Choose from a wide variety of passive, active, and specialty probes to use with your instrument. The
instrument automatically configures the input impedance when you attach a probe that is compatible
with the TekProbe or TekVPI interface.

Remember the following when connecting a probe:

®m  For most passive probes, adjust the low-frequency compensation after you connect them to a channel
input.

®  To compensate for gain (and offset) error in many probes, connect the probe tip to the probe
compensation connectors; then execute the built-in compensation procedure to optimize system
accuracy.

®  To compensate for propagation delay differences between voltage probes using the probe deskew
feature, attach up to two probe tips at a time to the probe compensation terminals; then execute the
deskew procedure to time align the display for each channel. The deskew adjustment range is 75 ns.

Triggering, timebase, and horizontal delay

The architecture of an analog oscilloscope requires its time bases and triggering to be linked. The main
trigger triggers the main time base, and then you can use a delayed trigger to trigger a delayed time base.
Many digital oscilloscopes have also been designed using this traditional, but complex, paradigm.

This instrument uses a simpler paradigm that cleanly separates the concepts of triggering and time bases.
You can still do everything that you could with an analog oscilloscope and more. Now these features
are easier to set up and use.

The trigger event can be simple or complex. Examples of a simple trigger are the rising edge of the
Channel 1 signal or a glitch narrower than 10 ns on Channel 2. You can set up a complex trigger where the
trigger system is armed by a condition on one channel and then is triggered by a condition on another
channel. In either case, simple or complex, there is just one trigger event.

The time base can be either delayed or not delayed. If it is not delayed, acquisition occurs surrounding the
trigger event depending on the amount of pretrigger (see page 48) and posttrigger (see page 456) data that
you have selected. If you turn on horizontal delay, you can delay the acquisition to a point well beyond the
trigger event (similar in effect to a delayed time base). By alternately turning horizontal delay on and off,
you can make quick, detailed comparisons between two segments of a signal that are separated from each
other by a fixed amount of time. In any case, the time base is always triggered by one trigger event.
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Pretrigger data

The data points of the waveform acquired and displayed before the trigger event. You can set the
amount of pretrigger data with the Horizontal Position control.

Looking at waveform details

Use the instrument Zoom function to magnify an acquisition vertically, horizontally, or in both dimensions
to let you see the fine detail in your signals. The MultiView Zoom function affects only the display,
not the actual waveform that is being acquired.

Set up Zoom

The fastest way to set up a MultiView Zoom display is to click (or touch) and drag across the segment of
the waveform that you want to see in greater detail. Then, when you touch or click the on-screen Zoom
menu item (see page 49), that waveform appears in the Zoom (lower) graticule, while the entire waveform
appears in the Acquisition (upper) graticule. Markers in the main graticule give you position context

for what you are seeing in the Zoom graticule.

Another way to set up the MultiView Zoom function is to push the front-panel Multiview Zoom button
(see page 49). Then you can set parameters in a control window to focus your Zoom waveform on the
signal segment of interest.

NOTE. If zoom is on but the readouts are not attached to the zoom controls, press the MultiView Zoom
button to attach the readouts to the zoom controls. Press the MultiView Zoom button again to turn zoom off.

To see more waveform detail you can also use horizontal delay (as described in the previous topic) (see
page 49) to focus the acquisition on a segment of a waveform separated from the trigger event by a
significant interval of time. This technique lets you increase the horizontal resolution (sample faster) on a
segment of a signal, even when you cannot trigger on that particular segment.

Zoom function

The Zoom function also allows you to zoom on multiple areas of a waveform or on multiple waveforms
simultaneously. You can lock the zoomed areas and scroll through them together or unlock the zoomed
areas and scroll through them independently.
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On-screen MultiView Zoom menu item

Zoom 1 On

Zoom 2 0n

Zoom 30N

Zoom 4 0n
Histogram “ertical
Histogram Horizontal

Measurement Gating r

Front-panel MultiView Zoom button

Multiview
Zoom™

Y

Triggering, timebase, and horizontal delay

The architecture of an analog oscilloscope requires its time bases and triggering to be linked. The
main trigger triggers the main time base, and then you can use a delayed trigger to trigger a delayed
time base. Many digital oscilloscopes have also been designed using this traditional, but complex,
paradigm.

This instrument uses a simpler paradigm that cleanly separates the concepts of triggering and time
bases. You can still do everything that you could with an analog oscilloscope and more. Now these
features are easier to set up and use.

The trigger event can be simple or complex. Examples of a simple trigger are the rising edge of the
Channel 1 signal or a glitch narrower than 10 ns on Channel 2. You can set up a complex trigger
where the trigger system is armed by a condition on one channel and then is triggered by a condition
on another channel. In either case, simple or complex, there is just one trigger event.

The time base can be either delayed or not delayed. If it is not delayed, acquisition occurs surrounding
the trigger event depending on the amount of pretrigger (see page 48) and posttrigger (see page 456)
data that you have selected. If you turn on horizontal delay, you can delay the acquisition to a point
well beyond the trigger event (similar in effect to a delayed time base). By alternately turning
horizontal delay on and off, you can make quick, detailed comparisons between two segments of a
signal that are separated from each other by a fixed amount of time. In any case, the time base is
always triggered by one trigger event.
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Using fast acquisition and DPO

When you turn on FastAcq (see page 50), you can acquire up to 250,000 waveforms per second. In fast
acquisition mode, the dead time (see page 51) between acquisitions can be very short, approaching that of
the finest analog oscilloscopes. Reduced dead time means that your chances of capturing an infrequent
event are greatly improved. More time is spent acquiring and displaying your signal. And with the digital
phosphor (DPO) technology, you can easily differentiate between the normal shape of your signal and
that infrequent anomaly that you want to capture.

As a comparison, high quality analog real-time oscilloscopes (see page 50) can sweep at high repetition
rates with little dead time between sweeps, which makes it possible to capture an infrequent event.
Typical digital oscilloscopes (DSOs) (see page 51) have relatively long dead times between acquisitions;
infrequent events are much more difficult to capture. With fast acquisition and digital phosphor technology,
the oscilloscope acquires at a high repetition rate and then overlays the acquired information into a
three-dimensional database that is updated on the display 30 times per second.

The digital phosphor oscilloscope shows you not only the displayed waveform, but also the sample
density. You can choose to see sample density represented in a color palette or as shades of gray or shades
of green. The DPO display in monochrome green bears a strong resemblance to the CRT of a high-quality
analog oscilloscope. When you increase waveform brightness with the front-panel Intensity knob, areas of
lower sample density appear more clearly.

DPO provides display benefits, whether fast acquisition is on or off. When it is on, DPO helps you
identify an infrequent anomaly in a repetitive signal, especially when either the spectral or temporal color
palettes are used. The repetitive signal appears in one color and the anomalies appear in another. When
fast acquisition is off, DPO improves the waveform display quality when long records are compressed
for display with the 1000 horizontal pixels in the graticule. The compression algorithm works with the
intensity-graded display to show brighter pixels where many points have been compressed and dimmer
pixels where fewer points have been compressed.

Fast acquisition

il

Analog oscilloscope sweeps
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“Dead time” between acquisitions
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Using logic waveforms

52

NOTE. This online help supports many oscilloscope models from Tektronix. This feature is only available
on some models.

The instrument can display logic waveforms of analog or digital signals in bus views with bus decoding.
You can use digital, analog, and math waveforms to define up to 16 buses (serial or parallel) in the Bus
Setup window.

You can use a logic probe to connect the D15-D0 channels to signals in your system under test. If you
need more than 16 digital channels in a bus, you can designate Ch1-Ch4 and Math1-Math4 to be logic
waveforms in the Bus Setup window.

The instrument acquires and displays data from digital signals as follows:

Stores a high or low state of the logic waveform for each sample. You can set the voltage threshold
level on individual channels.

Depicts data as a waveform, a busform, or both.
Decodes data as numeric or symbolic values.
Displays a logic high level as green and a logic low level as blue.

Color codes the channel labels and on-screen indicators for the D15-D8 and the D7-DO0 channels that
follow the color code used on the logic probes.

Adds custom labels for easier channel-to-signal identification.

Uses iCapture to display the analog view of up to four signals connected to the logic probe. If you
want to see the analog characteristics of signals connected to the logic probe, you can assign up to four
of the D15-DO0 channels to the Ch1-Ch4 function with iCapture.

NOTE. iCapture is available on MSO70000C/DX Series instruments.

What do you want to do next?

B Learn about iCapture. (see page 809)

m Learn about bus setups. (see page 97)

B Learn about digital setups. (see page 89)
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Using waveform math

Waveform math in the instrument can be as simple as basic arithmetic or as powerful as building a
complicated math expression.

Equation editor

You can build a complicated math waveform expression using multiple waveform sources, constants,
variables, operators, and functions. The waveform sources can be any channel, reference, or math
waveform.

You can enter constants with a keypad. Live results from the measurement system can be used as variables,
and there is a full assortment of arithmetic operators and math functions to use. As you enter the waveform
expression, you will see it appear as an equation in the control window.

You can define up to four separate math waveforms.

Using spectral analysis

When you are displaying an FFT (spectral) math waveform, you can use either of these two ways to
operate the instrument:

®  Use the conventional time-domain instrument controls, such as vertical and horizontal position and
scale.

m  Use the spectrum analyzer controls, such as center frequency, span, resolution bandwidth, and
reference level.

When you use the Basic Spectrum Analyzer controls, the instrument automatically sets its time domain
parameters, including record length and sample rate, as necessary to give you the view of the spectral
waveform that you want to see. You can switch back to using the conventional time-domain controls
at any time.

Spectral waveforms can be simple magnitude or phase waveforms calculated from the data acquired on
a single channel. Or you can combine spectral operations with other math operations to do complex
analysis of your signals.
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Characterizing a signal

54

Signal characterization begins with taking measurements. To gain even more insight into your
measurements, you can add measurement statistics to calculate the average measurement value, the
standard deviation, and the maximum range of the measurement value.

Another way to characterize a signal is to compile a histogram from the acquired waveform. You can set
up either a vertical histogram to analyze amplitude values or a horizontal histogram to analyze timing.
For example, the vertical histogram is useful for characterizing noise and the horizontal histogram is
useful for characterizing jitter.

While the histogram is being compiled from the acquired waveform, you can take continuous
measurements on the histogram data to determine its mean value and other useful statistics.
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Application-Specific measurements

You can load optional measurement extensions as needed to enhance the capabilities of the instrument
for specific applications. These applications build on the precision signal acquisition performance of the
instrument to address your specific design requirements.

Here are some examples of the application packages:

Jitter and Timing Analysis. Use the DPOJET software to characterize the timing performance

of semiconductor systems. Analyze clock jitter, setup and hold times, and many other timing
measurements on a cycle-by-cycle basis over long, single-shot acquisitions. Measurement statistics are
presented as numerical statistics, or graphically in a histogram, cycle trend, time trend, or spectral plot.

Ethernet Compliance Testing. Use the ET3 software to perform 10/100/1000 Base T Ethernet
compliance testing.

USB Signals. Use the USB or USB3 software to characterize USB 2.0 or USB 3.0 universal serial bus
signals, including mask testing and parametric testing.

Power Measurements. Use the DPOPWR software to quickly measure and analyze power dissipation
in power supply switching devices and magnetic components.

DDR Memory Bus Analysis. Automatically identify DDR1, LP-DDR1 DDR2, DDR3, and GDDR3
Reads and Writes and make JEDEC conformance measurements with pass/fail results on all edges in
every Read and Write burst.

MIPI® D-PHY Characterization and Compliance Testing. Verify to the D-PHY specification,
rapidly characterize and discover sources of jitter and signal integrity concerns.

SignalVu™ Vector Signal Analysis. Easily validate wideband designs and characterize wideband
spectral events.

CAN and LIN Timing and Protocol Decode Software. When you need to ensure seamless and
reliable operation of a CAN or LIN network, this option enables CAN bus triggering and provides
the solution to measure oscillator tolerance, propagation delay, and simultaneously decode CAN and
LIN messages, with the protocol leveraging the trigger capabilities.

8b10b Serial Triggering and Analysis. Use the 8b10b software to trigger on and analyze 8b10b
serial bus signals.

Additional packages may be available. Contact your Tektronix representative for more information.
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Front panel overview

The instrument features the following front-panel controls and connectors.

For all DPO7000C, MSO/DPO70000C, and MSO/DPO70000DX models:
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11. Fast Edge output used for probe
compensation (see page 58)

12. DC Probe Cal output

13. Logic probe input (see page 59),
inactive on DPO models. MSO
capabilities are available as
a user upgradeable option on
DPO70000DX instruments.

On / Standby switch (see
page 59)

14, Clear button

15. Save/Recall buttons

16. Digital Channel setup menu
17. Menu Off button

18. Print screen image button

Front panel overview
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Probe Compensation output

Use the Probe Compensation output to compensate or deskew passive probes or active voltage probes.
On some models, this is the Fast Edge output.
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Probe Calibration output

Use the Probe Calibration output to calibrate or deskew passive or active voltage probes.

Channel 1-4 inputs

You can connect up to four probes to the inputs of the instrument. Each vertical input channel has its
own vertical control settings. Each probe input channel has its own TekProbe/TekVPI interface.

D15-D0 inputs

You can connect one logic probe to the logic port on the front of the instrument. Each digital channel
has its own control settings.

Auxiliary trigger input

The trigger level range for the Auxiliary Input is adjustable.

On/Standby switch

Use this button to power on the instrument or to set the instrument to standby.

=

g — I

Before shutting down, it is recommended that you first exit the instrument application and any other
active Windows applications to avoid error messages on shutdown or the next power up.

TIP. To exit the instrument application and shut down in one step, select Shutdown in the File menu.
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Ground terminals

Use these terminals to connect the instrument to the same ground as the unit under test, and if you are
working with static sensitive components, ground yourself. Static electricity that builds up on your
body can damage static-sensitive components. Wear a wrist strap to safely send static charges on
your body to earth ground.

Touch screen

You can use touch to control the instrument in addition to the front-panel controls, toolbar buttons, and
menu options. Generally, touch can be used anywhere that click is mentioned in this online help.

Touch Screen To disable the touch screen, push the front-panel Touch
@ Screen button. When the touch screen is off, the button
is lighted. You can still access the on-screen menus with
a mouse or keyboard.

To adjust the touch screen operation to your personal preferences, select Touch Screen > Calibrate from
the Utilities menu.

NOTE. If the instrument is powered on in Windows Safe Mode, the touch screen is inoperative. You may
need to use a mouse or keyboard to restore normal operation.

60 MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series



Controls and connectors Wave Inspector controls

Wave Inspector controls

NOTE. Wave Inspector Controls are available only on MSO/DPO5000B Series instruments.

The Wave Inspector controls (zoom/pan, play/pause, mark, and search) help you to efficiently work with
long record length waveforms.

Use Measure to perform automated measurements,
Search to search through an acquisition for user-defined
events/criteria, or DPX/FastAcq to start or stop fast

Wave Inspector acquisitions.

FastAcq

Push to turn on MultiView Zoom and add a

magnified graticule to the display.

Zooming a waveform: Enable or disable the zoom mode
by pushing the zoom button. Rotate the inner knob on the
Pan-Zoom control clockwise to zoom in on a selected part
of the waveform. Rotate the knob counterclockwise to zoom
back out.

Use the Pan knob to scroll through a zoomed waveform.

Panning a waveform: Rotate the pan (outer) knob of the
pan-zoom controls to pan the waveform. Turn the knob
clockwise to pan forward. Turn it counterclockwise to pan
backwards. The further you turn the knob, the faster the
zoom window pans.

Use the play-pause knob ’/" to automatically pan
through a waveform record.

Playing and Pausing a Waveform: Enable the play-pause
mode by pushing the play-pause button. Adjust the play
speed by turning the pan (outer) knob further. The further
you turn it, the faster it goes.

Use to search and mark waveforms, to establish or delete a
waveform mark, or to jump to the previous or next waveform
mark.
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Vertical controls

Use the Vertical controls to adjust the vertical display parameters of live data channels connected to the
vertical inputs. Each input channel has identical controls.

Use the dedicated channel (Ch <1-4>) buttons to turn
channel displays on and off. The channel button is lighted
when the selected channel is on.

Pasition Use the dedicated push-to-toggle Position/Offset and
Dffset Scale knobs to adjust the vertical position and scale of the
waveform.

O

NOTE. The Offset button is not available on
MSO/DPO5000B Series instruments.

3
i
m

For channel waveforms (waveforms connected to the
vertical inputs), the scale setting controls the vertical size of
the acquisition window (see page 62) as well as the display
scale. The range and resolution of the scale value depends
on the attached probes and on any other external factors
you have specified.

For reference or math waveforms, the scale setting controls
the display only. Scaling these waveforms has no effect
on the acquisition hardware.

Use the front panel controls to display the math (M),
Math reference (R), bus (B), or vertical (V) setup menus.

NOTE. The M, R, B, V buttons are available only on
MSO/DPO5000B Series instruments.

w A

Vertical

9

Acquisition window
This window defines what data is removed from the input signal to form a waveform record.

The vertical scale and offset set the vertical size and the vertical center of this window independently
for each channel. The horizontal scale and position set the horizontal size and positions for all
channels in parallel.
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Horizontal controls

Use the Horizontal controls to adjust the horizontal parameters of waveforms. The horizontal controls
globally affect all displayed waveforms.

- Use the dedicated Position knob to adjust the horizontal
O position of all waveforms. Use this knob to adjust the trigger
- point so that you can select the amount of pretrigger data

— or posttrigger data. In Delay Mode, this knob can be used

O.' to set the delay time.
- Use the dedicated Scale knob to adjust the horizontal scale

el (time base) of all channel waveforms.
it Use the Resolution knob to change the number of acquired
O } points (record length, in the Automatic and Constant Sample
o Rate horizontal modes. The actual resolution cannot be
set directly but is derived and displayed on the horizontal
readouts.

NOTE. The Resolution knob is not available on
MSO/DP0O5000B Series instruments.

Push the Delay button to turn on horizontal delay, and
Delay then use the Position knob to set the delay time. Delay is
useful when you want to acquire waveform details that are
separated from the trigger event by a significant interval
of time.

NOTE. The Delay button is not available on
MSO/DPO5000B Series instruments.

Trigger controls

Use the Trigger controls to set basic trigger parameters.

By default, the instrument uses the Edge trigger. To return to the Edge trigger from any other
A (main) event trigger, push the Edge button. Pushing this button does not open the Edge

Trigger control window unless another A event trigger is already displayed.
Edge
2 NOTE. The Edge button is not available on MSO/DPO5000B Series instruments.
To select other trigger types, push the Advanced button. In the Trigger control window, click
o the Select button to choose one of the other trigger types.
T Select the trigger source (see page 64) for the Edge trigger by pushing the left or right
arrow buttons until the desired Source is lighted. These buttons are only valid for the A

event Edge trigger.
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Select Trig in the menu bar to open the Trigger control window. Use the Coupling drop-down
menu to select trigger coupling (see page 64) for an A event or B event Edge trigger.

To open the Trigger control window, push the Menu button (Available only on MSO/DPO5000B
Series instruments only).

Force Trig Push the Force Trig button for the running trigger (Available only on MSO/DPO5000B Series
instruments only).

Push the button in the Slope column to toggle between positive, negative, or both trigger

slopes (see page 65) for the Edge trigger. The selected trigger slope(s) are lighted. These
buttons are only valid for the A event Edge trigger.

NOTE. The trigger slope selection button is not available on MSO/DPO50008B Series

I=
(=3

g
3

instruments.
andeﬂ Push the button in the Mode column to toggle between Normal (see page 65) (Norm) and
| Norm Auto (see page 65) (Automatic) modes; the selected trigger mode is lighted.
Sl NOTE. The trigger mode selection button is not available on MSO/DPO5000B Series
instruments.

Push the Level knob to set the trigger level to 50%. To set a different trigger level (see
page 65), rotate the Level knob. The trigger level appears on the screen. The trigger level
knob affects Edge, Width, Glitch, Timeout, Serial, Video and some Communications trigger
types.

o U

Trigger source

The trigger source determines the source of the trigger signal. The input channels are the most
commonly used trigger sources and are available for all trigger types.

Trigger coupling

The trigger coupling determines what part of the signal is passed to the trigger circuitry. All trigger
types except edge triggering use DC coupling only. Edge triggering can use all available coupling
choices.

DC. This coupling passes all input signals to the trigger circuitry.
AC. This coupling passes the input signals above 60 Hz to the trigger circuitry.

HF Reject. This coupling attenuates signals above 50 kHz before passing the signal to the trigger
circuitry.

LF Rej. This coupling attenuates signals below 80 kHz before passing the signal to the trigger
circuitry.

Noise Rej. This coupling provides stable triggering by increasing the trigger hysteresis. Increased
hysteresis reduces the trigger sensitivity to noise but may require greater signal amplitude.
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Trigger slope

The trigger slope determines whether the instrument finds the trigger point on the rising edge, falling
edge, or both edges of the signal.

Normal trigger mode

Normal trigger mode causes the instrument to wait for a valid trigger event before displaying
waveform data. Normal trigger mode is most useful during single-shot acquisitions.

Trigger level
The trigger level determines the voltage level where the trigger point occurs.
Adjust the trigger level with the front-panel Level knob.

Click in the Level entry box in a Trigger control window and use the multipurpose knob to adjust
the level.

Auto trigger mode

Auto trigger mode causes the instrument to trigger if a valid trigger event does not occur within
a set amount of time.

Auto trigger mode is useful when probing DC signal levels such as power supplies or logic levels that
are stuck high or low. It is also useful when looking for activities on signal nodes such as oscillations
when you first set up the instrument. The length of time it waits for a trigger event depends on

the time base setting.
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Run controls

Use the Run controls to start, stop, and to monitor the status of acquisitions.

(B| |singe] [tioar )

R S S—

Push the Run/Stop button to start and stop acquisitions.

Push the Run/Stop button once to stop the acquisition.

Push the Run/Stop button a second time to begin acquisitions again.

Push the Single button to exit Run mode and start a single sequence of acquisitions.
Push Clear to remove any acquired data.

In Sample, Peak Detect, or High Res mode, the instrument acquires a waveform record with
the first trigger event and then stops.

In Envelope, Average, or WfmDB mode, the instrument makes the specified number of
acquisitions to complete the averaging or enveloping task, and then stops.

The Acquisition Status readouts, and lights on some instruments, indicate the state of the acquisition.

Arm Arm indicates the instrument is filling the pretrigger portion of the waveform record.
Ready indicates the instrument can accept a valid trigger event and is waiting for the trigger
event to occur.
Trig'd or Triggered indicate that instrument has recognized a valid trigger and is filling the

posttrigger portion of the waveform.
When Arm, Ready, and Trig'd are not on, the acquisitions have stopped.

When Ready and Trig'd are both on, the instrument has recognized a valid trigger and is
waiting for a delayed trigger. When the instrument recognizes a delayed trigger, it will fill
in the posttrigger portion of the waveform.
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General purpose controls

Use the following front-panel controls to perform general-purpose tasks such as to Autoset the instrument,
to send items to the printer, or to enable cursors.

Autoset Push the Autoset button to automatically set up the instrument to obtain and display a stable
waveform of usable size. For information on the Autoset default settings click Autoset (see
O page 189).
Default Push the Default Setup button to reset the instrument to the factory default settings.

Push the Menu Off button to turn off a displayed menu.
NOTE. Menu Off is available only on MSO/DPO5000B Series instruments.

Push the Print button to make a hard copy of the screen. The printed image is sent directly to
the selected (internal or attached) printer. To change the print settings, click the File menu
Print command, and change the settings in the Print dialog box.

Push the Cursors button to enable cursors on the screen. The Cursor Type control window
(see page 75) opens so that you can specify the cursor parameters.

OE @ O

NOTE. If cursors are on but the multipurpose knob readouts are not attached to the Position
controls, press the Cursors button to attach the controls to the readouts. Press the Cursors
button again to turn cursors off.

Push the Search and Mark buttons to find and place a mark on a waveform at a point of

Search interest, or to edit marks. You can return to a mark and analyze the waveform at a later time.
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Clear

Push the FastAcq DPX button to turn Fast Acquisition On or Off. The FastAcq button is
lighted when Fast Acquisition is turned on.

Use the Intensity knob to adjust the brightness of the waveform. High intensity settings show
less frequently acquired points more clearly.

=]

g e
o @

= =
-
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MultiView Zoom controls

Push the front panel MultiView Zoom button to do the following:

Multiview Open a magnified window or windows in the upper half of the screen.
il Open the Zoom control window (see page 487) to set the position and factor of the selected
@ waveform in the Zoom window, select the Zoom Area and Source, and lock and scroll the

zoomed areas.

Assign the multipurpose knobs to the horizontal or vertical position and scale controls in the
Zoom graticule.

NOTE. Ifzoom is on but the multipurpose knob readouts are not attached to the zoom Position and Factory
controls, press the MultiView Zoom button to attach the controls to the readouts. Press the MultiView
Zoom button again to turn zoom off-.

The MultiView Zoom button is lighted when the Zoom mode is on.

Rear and side panel connectors

The instrument features the following rear and/or side panel connectors:

Use the PS-2 connectors to connect a PS-2 keyboard or a mouse to the
instrument.

Use the USB connectors to connect a USB mouse, a keyboard, or other
USB devices to the instrument.

NOTE. Plug USB devices directly into the USB connectors on the
instrument to improve reliability rather than connecting the devices
serially. If the USB mouse locks up, disconnect and reconnect the USB
connector to restore normal operation. If the instrument front panel and/or
touch screen do not respond, press the On/Standby switch for 5 seconds
to cycle power.

(Jvea Use this VGA port to connect a monitor for extended desktop operation.
For example, use the front panel to display the contents of the instrument,
and use an additional monitor for Windows operation.

NOTE. This port is available on all instruments except MSO70000C and
DPO70000C Series instruments.

0020030
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Rear and side panel connectors

Use the COM 1 serial port to connect to other devices through the serial
port.

NOTE. The COM1 port is available on all instruments except
MSO/DPO5000B Series instruments.

Use the COM 2 serial port to connect to other devices through the serial
port.

NOTE. The COM2 port is not available on some instruments.

Use the RJ-45 connector to connect the instrument to a network.

Use the Audio ports for stereo microphone input and stereo line output.
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Rear and side panel connectors

For MSO/DP0O5000B and DPO7000C instruments:

Use the AUX TRIG OUT / REF OUT connector to obtain a TTL-compatible,
negative polarity pulse when the instrument triggers.

Use the CH 3 OUT connector to connect to a buffered version of the signal
that is attached to the Channel 3 input. The amplitude is 50 mV/div £20%
into a 1 MQ load, or 25 mV/div £20% into a 50 Q load.

Use the EXT REF IN connector to synchronize the instrument time base
to an external 9.8 — 10.2 MHz reference frequency source. When not
using the external reference, disconnect signals from the EXT REF IN
BNC connector.

For MSO/DPO70000C and MSO/DPO70000DX instruments:

Use the AUX OUT connector to obtain a TTL-compatible, negative polarity
pulse when the instrument triggers or when certain other events occur,
such as a mask test failure or completion.

Use the REF OUT connector to obtain a copy of the internal reference.

Use the EXT REF IN connector to synchronize the instrument time base
to an external 9.8 — 10.2 MHz reference frequency source. When not
using the external reference, disconnect signals from the EXT REF IN
BNC connector.

For MSO/DPO5000B instruments:
Use the Probe Power to input the probe power.

Use the REF IN to input the external reference. When not using the
external reference, disconnect signals from the REF IN BNC connector.

Use the AUX OUT connector to obtain a TTL-compatible, negative polarity
pulse when the instrument triggers or when certain other events occur,
such as a mask test failure or completion. You may also set the AUX OUT
connector to obtain a copy of the internal reference.

Use the GPIB connector to connect the instrument to a GPIB controller
for GPIB operation.

NOTE. The GPIB connector is available on all instruments except
MSO/DP0O5000B Series instruments.

This connector is not used.



Controls and connectors Rear and side panel connectors

DVl Video port Use the DVI-I Video port (some instruments have a DVI-D Video port) to
send the instrument display to a projector or to a flat-panel LCD monitor.
]|
© l 0 DJ © NOTE. This port is available only on MSO70000C/DX, DPO70000C/DX,
20008 and DPO7000C Series instruments.

Use the eSATA port as an external interface for SATA support devices.

1 - NOTE. This port is available only on MSO70000C/DX, DPO70000C/DX,
and DPQO7000C Series instruments.

MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series
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Controls and connectors Rear and side panel connectors
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Cursor setups Cursor setup control window (YT display format)

Cursor setup control window (YT display format)

From the Cursor menu, select Cursor Setup.

Overview

Use the Cursor Setup controls to configure cursor parameters. The available controls vary depending on
the Display Format (see page 174) and the rest of the cursor window settings.

NOTE. Cursor measurements on digital channels require that at least one analog channel be displayed.
Alternatively, to take a measurement of a digital channel, you can first send the waveform acquired on the
digital channel to an analog channel using iCapture.

This online help supports many oscilloscope models from Tektronix. This feature is only available
on some models.

For information on the controls, click the buttons.
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To use

1. Click the Cursor button to turn cursors on and off.

NOTE. If cursors are on but the readouts are not attached to the cursor controls, press the Cursors button
to attach the readouts to the cursor controls. Press the Cursors button again to turn the cursors off.

2. To select the cursor Track Mode, click either the Indep (independent) or Tracking button.
3. Select a cursor type by clicking one of the Cursor Type buttons.

4. Select the waveform you want to measure from the Source drop-down lists. Cursor 1 and Cursor 2
each have their own source.
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Cursor setups Cursor setup control window (YT display format)

TIP. If are using H Bar or V Bar Cursors and want the cursor source to be the same for both cursors, set
the source for Cursor 1. Cursor 2 will have the same value as Cursor 1, unless you change it.

5. Click in the Position entry boxes to map the cursors to the multipurpose knobs, and then use the
knobs to move the cursors.

6. Select a Line style from the drop-down list. Line styles are available for all cursor types.

7. Select a Symbol style from the drop-down list. Symbol styles are only available on Waveform and
Screen cursors.

NOTE. If you are using XY or XYZ display format, you can also select the type of readout from the XY
Readout Type drop-down list. Only Waveform and Screen cursors are available in the XY or XYZ display
format.

TIP. The Cursors menu Cursors On command can also be used to toggle the cursors on and off. The
cursors are on when a check mark appears next to this command.

Behavior

When cursors are turned on, the front panel Cursors button illuminates.

Track mode

Style

74

B [ndep (Independent) moves the cursors independent of each other.

®  Tracking moves Cursor 1 and Cursor 2 in tandem. However, moving Cursor 2 does not move Cursor 1.

Applies only to Waveform and Screen cursors. The Line & X symbol style displays only an X when used
with waveform cursors in XY display mode such that the vertical line is not drawn, only the X.

If you change the display format to XY when H Bar cursors are enabled, the cursor type will change to
Screen. In normal acquisition mode, changing the display format to XY when V Bar cursors are enabled,
changes the cursor type to Waveform.

TIP. To turn the cursors off, push the front-panel Cursors button.

What do you want to do next?

m Go to a step-by-step procedure for taking cursor measurements. (see page 605)

B earn about the cursor types. (see page 80)

MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series



Cursor setups Cursor type control window

®m  Learn about Cursor Readouts in XY display format. (see page 77)

Cursor type control window

From the Cursor menu, select Cursor Controls, or press the front panel Cursors button.

Overview

Use the Cursor Type control window to select the source for each cursor and the type of cursors used
for waveform measurements.

For information on the controls, click the buttons.
Cursor Controls | B

To use

1. Click the Source drop-down list to select the source for the cursor.

2. Click one of the Cursor Type buttons to select a cursor type.

TIP. Select a cursor type directly from the Cursors menu Cursor Type submenu.

Behavior

If you are using H-Bar or V-Bar Cursors, and want to measure the same waveform with both cursors,
select the waveform for Cursor 1. Cursor 2 will have the same value as Cursor 1, unless you change it.

Click Setup to open the Cursor control window where you can specify other cursor parameters.
What do you want to do next?

B Learn about the Cursor Position controls. (see page 79)

®  Learn about the Cursor Setup controls. (see page 73)
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Cursor sources (YT display)

76

From the Cursor menu, select Cursor Setup.

Overview

Use these controls to define the source for both Cursor 1 and Cursor 2 for any cursor type.

Cursor 1 Cursor 2
Source Source
Ch L h v
¥ Pasition ¥ Pasition
| 2ygs @ | 20ps
¥ Pasition ¥ Pasitinn
| 428mv B | ATZmV
To use

1. Click the Source drop-down list to select the measurement source for the cursor.

2. Click in an X Position entry box and use a multipurpose knob to adjust the position of the cursor.

Behavior

If the cursor type is V Bars or H Bars, setting the Cursor 1 source sets the Cursor 2 source to the same
value. To have different sources for Cursor 1 and Cursor 2, set the Cursor 1 source first, and then set the
Cursor 2 source.

NOTE. Only Screen Cursors have both an X and Y Position controls.

The Multipurpose Knobs Adj buttons appear only with Screen cursors. Click the Adj buttons to assign the
multipurpose knobs to the X-axis and the Y-axis controls.

What do you want to do next?

B Learn about cursor types. (see page 75)

B Learn about cursor styles. (see page 77)

m Learn about Cursor Readouts in XY display format. (see page 77)
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Cursor style

From the Cursor menu, select Cursor Setup.

Overview

Use these controls to change the appearance of the cursors.

To use
1. Select a Line style from the drop-down list: Solid, Dashed, or Solid and Dashed.
2. Select a Symbol style from the drop-down list: Lines, Line & X, or X.

NOTE. Symbol styles are only available for Waveform (see page 82) and Screen (see page 83) cursors.

If you are in XY display format, you can also select the XY Cursor Readout from the drop-down list.

Behavior

Cursor positions are displayed according to line style, symbol style, cursor type, and waveform display
format. See the following table. The Line & X symbol style displays only the X when used with waveform
cursors in XY display mode. (The vertical line is not drawn.)

Symbol style Cursor type Display format Cursor position

Lines Waveform and Screen YT Intersection of horizontal
and vertical lines. Default
style for Screen cursors.

Line & X Waveform and Screen YT Horizontal position is
shown by a vertical line, the
Y-axis is shown by an X.
Default style for Waveform
cursors in YT mode.

X Waveform and Screen XY Single X indicates the
horizontal and vertical
position. Default style for
Waveform Cursors in XY
mode.

Cursor readouts are displayed based on the selection in the XY cursor Readout drop-down list. This list is
only available for Waveform and Screen cursors when you are using XY display format.
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XY cursor readout Cursor type Display format Cursor position

Rectangular Waveform and Screen XY Shown as rectangular
coordinate positions. There
are nine readouts for
Waveform cursors and six
for Screen cursors.

Polar Waveform and Screen XY Shown as polar coordinate
positions. There are nine
readouts for Waveform
cursors and six for Screen
cursors.

Product Waveform and Screen XY Shown as rectangular
coordinates and the X
vertical value is multiplied
by the Y vertical value.
There are six readouts
for Waveform cursors and
three for Screen cursors.

Ratio Waveform and Screen XY Shown as rectangular
coordinates and the Y
vertical value is divided by
X vertical value.
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Cursor position control window

From the Cursor menu, select Cursor Position.

Overview

Use the Cursor Position control window to position the cursors with the multipurpose knobs.

Cursor Position g
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To use
1. Click the Source drop-down list to select the measurement source for the cursor.

2. Click in one of the cursor Position entry boxes, and use a multipurpose knob to enter the cursor position.

Behavior

The cursor units depend on the cursor type. The cursor position readouts appear on the display graticule.
When using the IRE graticule style, amplitude cursor readouts are shown in IRE units.

Cursor position does not change if the cursor source changes or if the waveform is repositioned.

TIP. Use the pop-up keypad or your external keyboard to specify exact numerical cursor coordinates.

What do you want to do next?

®  Learn about the Cursor Setup controls. (see page 73)

B [earn about the cursor types. (see page 80)
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Horizontal bar cursors

From the Cursor menu, select Cursor Controls, or press the front panel Cursors button.

To use

1. To use the horizontal bar cursors, click H Bars in one of the cursor control windows, or from the
Cursors menu, highlight Cursor Type, and then select H-bars from the submenu.

2. Use the multipurpose knobs to move the cursors.

3. Use the cursor Source drop-down list boxes to select the waveform you want to measure.

Behavior

Horizontal bar cursors measure vertical parameters (amplitude). Typically the vertical parameters are in
volts, but depend on the Vertical Units selected for the measurement window.

The cursor readouts appear near the bottom of the graticule when a control window is open. When the
control windows are closed, the readouts appear at the bottom of the screen. Each cursor has its own
readout with respect to the zero-reference. The A (delta) value shows the difference between the cursor
values.

What do you want to do next?

B [ earn more about the Cursor controls. (see page 81)

B (o to a step-by-step procedure for taking cursor measurements. (see page 605)
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Vertical bar cursors

From the Cursor menu, select Cursor Controls, or press the front panel Cursors button.

To use

1. To use the vertical bar cursors, click V Bars in one of the cursor control windows or highlight Cursor
Type from the Cursors menu, and then select V-bars from the submenu.

2. Use the multipurpose knobs to move the cursors.

3. Use the cursor Source drop-down list boxes to select the waveform you want to measure.

Behavior

Vertical bar cursors measure horizontal parameters. Typically horizontal parameters are in time or
frequency.

The cursor readouts appear near the bottom of the graticule when a control window is open. When the
control windows are closed, the readouts appear at the bottom of the screen.

For time domain waveforms, each cursor has its own readout relative to the trigger point. The A (delta)
value shows the time difference between the cursor values, or the frequency associated with the period
between the cursors (Hz = 1/time).

For frequency domain signals, each cursor has its own readout relative to 0 Hz. The A value shows the
difference in the frequencies between the cursors.

You can also use vertical bar cursors with measurement gating. Measurement gating enables you to
limit automatic measurements to within the boundaries of the vertical bar cursors rather than use the
entire display width.

What do you want to do next?

B [earn more about the Cursor controls. (see page 82)

®  Go to a step-by-step procedure for taking cursor measurements. (see page 605)

®  Learn more about measurement gating. (see page 295)
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Waveform cursors

82

From the Cursor menu, select Cursor Controls, or press the front panel Cursors button.

To use

1. To use the waveform cursors, click Waveform in one of the cursor control windows or from the
Cursors menu, highlight Cursor Type, and then select Waveform from the submenu.

2. Use the multipurpose knobs to move the cursors.

3. Use the cursor Source drop-down list boxes to select the waveform you want to measure.

Behavior

Waveform cursors can measure parameters on the same waveform or on different waveforms. The cursors
measure vertical parameters (typically volts) and horizontal parameters (typically time or frequency)
simultaneously. An X identifies the cursor location at the point where the cursors intersect the waveform.

The cursor readouts appear near the bottom of the graticule when a control window is open. When the
control windows are closed, the readouts appear at the bottom of the screen.

One A (delta) value shows the voltage difference between the two cursors while the other A value shows
the time (or frequency) difference between the cursor values.

What do you want to do next?

B [earn more about the Cursor controls. (see page 83)

® (o to a step-by-step procedure for taking cursor measurements (see page 605)
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Screen cursors

From the Cursor menu, select Cursor Controls, or press the front panel Cursors button.

To use

1. To use the screen cursors, click Screen in one of the cursor control windows or from the Cursors menu
highlight Cursor Type, and then select Screen from the submenu.

2. Use the multipurpose knobs to move the cursors.

3. Use the cursor Source drop-down list boxes to select the waveform you want to measure.

Behavior

Use screen cursors to indicate an arbitrary X and Y position in the waveform display area represented by
the intersection of a vertical and horizontal cursor line. Screen cursors measure both vertical parameters
(typically volts) and horizontal parameters (typically time or frequency).

Readouts display measurement parameters for both cursors. Vertical readouts display voltage values for
each cursor with respect to the zero reference point and with respect to each other. Horizontal readouts
display time or frequency values for each cursor with respect to the trigger point and with respect to
each other.

The cursor readouts appear near the bottom of the graticule when a control window is open. When the
control windows are closed, the readouts appear at the bottom of the screen.

What do you want to do next?

B [earn more about the Cursor controls. (see page 84)

B Go to a step-by-step procedure for taking cursor measurements. (see page 605)
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Cursor track mode

From the Cursor Setup control window, click the Indep or Tracking button. From the Cursor menu
highlight Cursor Mode; then select Indep or Tracking in the submenu.

Overview

Use this control to define the tracking relationship between cursors.

Track Moda

bF 3

To use

To select a cursor tracking mode, click either the Indep or Track button.

Behavior
B (Click Indep (Independent) to move one cursor at a time using the multipurpose knobs.

B Click Tracking to move Cursor 1 and Cursor 2 in tandem so that Cursor 2 will always remain a fixed
distance (time or voltage) from the Cursor 1. However, moving Cursor 2 does not move Cursor 1.

Cursor measurements

84

Because cursor measurements give immediate feedback on the amplitude or time values they measure,
they are usually quick to take and are more accurate than graticule measurements. Also, since you can
position cursors wherever you want them on the waveform, they are easier to localize to a waveform
segment or feature than automatic measurements.

Cursors can measure channel, reference, and math waveforms. You must set the source of each cursor
explicitly in the Cursor Control window.

Any cursor type can be used for YT display format. XY display format can only use Screen or Waveform
CUISOTS.

To use cursors, simply move the cursors on screen and read the results in the cursor readouts. The
following key points will help you use the cursors effectively.
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NOTE. Cursor measurements on digital channels require that at least one analog channel be displayed.
Alternatively, to take a measurement of a digital channel, you can first send the waveform acquired on the
digital channel to an analog channel using iCapture.

This online help supports many oscilloscope models from Tektronix. This feature is only available
on some models.

Cursor types overview

There are two cursors types (see page 746) available for the displays, Cursor 1 and Cursor 2. You can
move cursors with the multipurpose knobs or the cursor position controls in the Cursor Control window, or
click and drag them to a new location.

Cursors are limited by the display

You cannot move a cursor off the graticule unless you are in Zoom mode. Also, if you resize waveforms,
the cursors do not track. That is, a cursor stays at its screen position, ignoring changes to horizontal

and vertical scale and position and vertical offset (Waveform and Screen cursors will track a waveform
vertically).

Cursors ignore the selected waveform

Each cursor measures its source, defined in the Cursor Control window. Selecting a waveform for
scaling on screen (by pushing the Ch 3 front-panel button, for example) does not change the source that
each cursor measures.

After you have selected the source from the Cursor Control window, you can operate the cursor from the
front-panel knobs and buttons.

NOTE. If a cursor readout does not seem correct, check the source of each cursor in the Cursor Setup
dialog box. Each cursor readout relates to the amplitude and time base settings of its source.

Vertical cursors measure from the trigger point

Remember that each vertical cursor measures the time from the trigger point to itself. This relationship
is shown in the next figure.
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A vertical cursor readout includes and varies directly with the Delay time, which varies directly with
the horizontal position set for the time base. To see the amount of time to the first point, set horizontal
delay to 0.0 and set the horizontal reference point to 0%. Now the horizontal position readout shows the
time following the first point, and adding this value to the cursor readout yields the cursor position on
screen relative to first point. (You can find the horizontal readout both in the control window and in the
readout at the bottom of the screen.)

The following relationships hold:
Time from First Point = Horiz Position (when Horiz Delay and Ref Position are zero)

T1 readout = Time to First Point + Additional Time to Cursor

Cursor units depend on sources

A cursor that measures amplitude or time will read out in the units of its source as indicated in the table
below. Mixed sources require delta cursor readouts to use the units of the Cursor 1 source.

Cursors Standard units ! Readout names
Horizontal volts, watts, IRE V1, V2, AV

Vertical seconds, bits, Hertz T1, T2, AT, AF
Waveform, Screen volts, watts, seconds, bits, Hertz V1, V2, AV, T1, T2, AT

1 Ifthe V1 and V2 units do not match, the AV readout defaults to the units used by the V1 readout.

Changing cursor positions

86

Change cursor positions by using the position controls in the Cursor Position window, dragging the cursor
into position using the touch screen or mouse, or by turning the front-panel multipurpose knobs.

NOTE. To make small changes with the multipurpose knobs, push the Fine button before turning the knobs.
When a Fine button is lighted, its multipurpose knob makes smaller adjustments.
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What do you want to do next?

®m Learn about cursor types. (see page 746)

B Go to a step-by-step procedure for taking automatic measurements. (see page 606)

Cursor setup control window (XY display format)

From the Cursors menu, select Cursor Setup.

Overview

Use these controls to set the cursor parameters when you are using XY display format (see page 174). The
available controls vary depending on the rest of the cursor window settings.

For information on the controls, click the buttons.

Chi/Ch2 |® Ch1/Ch2 b

| somv @R 1esv

ETE | ST

To use

1. Use the same Cursor Control Window (YT format) (see page 73) guidelines to setup up the cursor
controls.

2. Select the readout format from the XY Readout drop-down list.

Behavior

When you are using XY display format, only Waveform and Screen cursors are available. If you change
the display format to XY when H Bar cursors are enabled, the cursor type will change to Screen. In normal
acquisition mode, changing the display format to XY when V Bar cursors are enabled, changes the cursor
type to Waveform. In FastAcq acquisition mode, changing the display format to XY when V Bar cursors
are enabled, changes the cursor type to Screen.

If you change the display format from XY to YT when Screen cursors are enabled, the cursor type
is changed to H Bars.
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XY

These cursor Readouts only appear when you are using XY display format. Rectangular XY readouts are
the default.

Rectangular

Polar

Shows the cursor readouts as rectangular coordinate positions. Waveform cursors display nine rectangular
readouts (AX, AY, At, X1, X2, Y1, Y2, t1, and t2). Screen cursors display six readouts (AX, AY, X1,
X2,Y1,and Y2).

Shows the cursor position as polar coordinate positions. Waveform cursors display nine polar readouts (Ar,
A0, At, r1, 12, 01, 02, t1, and t2). Screen cursors display six polar readouts (Ar, A0, r1, 12, 01, and 02).

Product

Ratio

88

Shows the cursor position as rectangular coordinates and the X vertical value is multiplied by the Y
vertical value. Waveform cursors display seven product readouts (AXXAY, X1xY1, X2xY1, X2x2, At, t1,
and t2). Screen cursors display three product readouts (AXxAY, X1xY1, and X2xY?2).

Shows the cursor position as rectangular coordinates and the Y vertical value is divided by the X vertical
value. Waveform cursors display six ratio readouts (AY+AX, Y1+X1, Y2+Y1, At, tl, and t2). Screen
cursors display three ratio readouts (AY+AX, Y1+X1, and Y2+Y1).
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Digital setup control window

From the Digital menu, select Digital Setup.

NOTE. The Digital Setup is available only on MSO5000B and MSO70000C/DX Series instruments and
DPO5000B Series instruments with option MSOE installed, and DPO70000DX instruments with option
MSOU installed.

Overview

Use the Digital Setup control windows to set parameters for the D15-D0 digital channels. Use the D15-D8
tab to set up the upper eight bits and the D7-DO tab to set up the lower eight bits.

For information on the controls, click the buttons.

Digital Setup

To use

®  Click the digital channels buttons to turn the waveforms on and off.

m  Set the voltage level thresholds for individual channels or set the same threshold level for all channels.
m  Adjust the vertical position of each channel.

B Set the vertical height of the channel in the display.

TIP. Click the Bus Setup button to quickly access the Bus Setup control window.

What do you want to do next?

® Learn how to connect a logic probe to signals in your system under test. (see page 90)

B Learn how to turn on or turn off the digital channels. (see page 93)

MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series 89



Digital setups Setting up digital signal inputs

® Learn how to set up the digital channels. (see page 96)

B Learn about bus sctups. (see page 97)

®  Learn about bus configuration. (see page 151)

m Learn how to set up a bus. (see page 584)

B Learn how to set up digital waveforms. (see page 583)

B Learn how to view analog characteristics of a digital waveform. (see page 583)

B Learn how to trigger on a bus. (see page 662)

B Learn how to track down serial bus anomalies. (see page 594)

B Learn how to troubleshoot circuits using a parallel bus. (see page 596)

m Learn how to troubleshoot a serial bus. (see page 599)

Setting up digital signal inputs

Use the Digital setup menu to set up the digital channels to acquire signals.

NOTE. Digital Setup is available only on MSO5000B and MSO70000C/DX Series instruments and
DPO5000B Series instruments with option MSOE installed, and DPO70000DX instruments with option
MSOU installed.

To use
1. Connect the logic probe to the instrument.

2. Connect the probe to the input signal sources.
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CAUTION. To prevent damage to the instrument always wear an antistatic wrist strap when making
connections to the instrument and observe the maximum input voltage ratings for input connectors.

3. Set up digital channels and buses using the Digital Setup and Bus Setup control windows through the
Digital menu. The Bus Setup window is also accessible through the Vertical menu.

What do you want to do next?

B [earn about setting up the digital channels. (see page 89)

B Learn about bus setups. (see page 97)

B Learn about bus configuration. (see page 151)

Digital channel threshold and position

NOTE. The Digital Channel Threshold and Position option is available only on MSO5000B and
MSO70000C/DX Series instruments and DPO5000B Series instruments with option MSOE installed, and
DPO70000DX instruments with option MSOU installed.

From the Digital menu, select Digital Setup.

Overview

Use these controls to define the voltage threshold level of digital channels and their vertical position in
the display.

To use
1. Use the Channel Selectors to select a channel.

2. Use the Threshold and Position controls to set the voltage threshold level and the vertical position of
the selected channel.

Set digital channel threshold

NOTE. The Digital Channel Threshold option is available only on MSO5000B and MSO70000C/DX
Series instruments and DPOS5000B Series instruments with option MSOE installed, and DPO70000DX
instruments with option MSOU installed.

From the Digital menu, select Digital Setup and use the Threshold entry box to set the voltage threshold
level of the digital channel.
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NOTE. The instrument displays the Threshold entry box when you turn on the digital channel.

To use

m  Click in the Threshold entry box and use the keypad to enter a value or use the multipurpose knobs to
select a voltage level.

Behavior

The voltage threshold level determines when a voltage level on a digital channel is considered to be
a logic high and a logic low.

Set digital channel position

NOTE. The Digital Channel Position option is available only on MSO5000B and MSO70000C/DX
Series instruments and DPO5000B Series instruments with option MSOE installed, and DPO70000DX
instruments with option MSOU installed.

From the Digital menu, select Digital Setup and use the Position entry box to move the digital channel
vertically in the display.

NOTE. The instrument displays the Position entry box when you turn on the digital channel.

To use

B Double-click in the Position entry box, and use the keypad or the multipurpose knobs to adjust the
position of the digital channel.

What do you want to do next?

B earn about setting up digital signals. (see page 96)

B [earn more about digital setups. (see page 89)

®m Learn about bus setups. (see page 97)

B Learn about bus configuration. (see page 151)
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Turn on or off the digital channels D15-D8 and D7-D0

NOTE. The Turn On or Off the Digital Channels D15-D8 and D7-D0 option is available only on
MSO5000B and MSO70000C/DX Series instruments and DPO5000B Series instruments with option
MSOE installed, and DPO70000DX instruments with option MSOU installed.

From the Digital Setup menu, select the D15-D8 or D7-DO tab.

To use

B Click Turn D7-DO0 or Turn D15-D8 On button to turn on the digital channels DO to D7 or DS to
D15 respectively.

B Click the Threshold entry box and use the keypad to enter a value for the voltage level or use the
multipurpose knobs to select a voltage level.

B Click the Position entry box and move the channel using the multipurpose knob.

Digital Setup

[aadiv [ 23adiv | 2.84div

Behavior

As you turn on the digital channels, the corresponding channel indicator along the bottom of the menu
changes to match the color on the digital channel button.

What do you want to do next?

B [earn about bus setups. (see page 97)

B Jearn about bus configuration. (see page 151)

m  earn more about digital setups. (see page 89)
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Set the display size of logic channels

NOTE. The Display Size of Logic Channels option is available only on MSO5000B and MSO70000C/DX
Series instruments and DPOS5000B Series instruments with option MSOE installed, and DPO70000DX
instruments with option MSOU installed.

From the Digital menu, select Digital Setup and use the Size selection box to define the height of the
digital channel in the display.

To use

B (Click Size and select from the drop-down list: Large, Medium, Small, and Extra Small.

Behavior

m  Large displays the channel as a division.

B Medium displays the channel as half a division.

B Small displays the channel as a quarter of a division.

m  Extra Small displays the channel as a fifth of a division.
What do you want to do next?

®m [ earn about setting up digital signals. (see page 96)

® Learn more about digital setups. (see page 89)

B ] earn about bus setups. (see page 97)

B Learn about bus configuration. (see page 151)
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Set the global threshold for digital channels

NOTE. The Global Threshold for Digital Channels option is available only on MSO5000B and
MSO70000C/DX Series instruments and DPO5000B Series instruments with option MSOE installed, and
DPO70000DX instruments with option MSOU installed.

From the Digital menu, select Digital Setup and use the Global Threshold entry box to define the same
voltage threshold level for all digital channels.

To use
B Click the Global Threshold entry box and enter a value for the voltage threshold level with the keypad.
®  Click the Apply button.

Behavior

The instrument sets the thresholds for all digital channels to the same voltage level.
What do you want to do next?

B Learn how to set the threshold for Ch1-Ch4 (live) and Math1-Math4 channels to use as logic
waveforms. (see page 811)

B [earn more about digital setups. (see page 89)

B Learn about bus setups. (see page 97)

B Learn about bus configuration. (see page 151)
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Set up digital channels

NOTE. The Digital Channels D15-D8 and D7-D0 Tabs option is available only on MSO5000B and
MSO70000C/DX Series instruments and DPO5000B Series instruments with option MSOE installed, and
DPO70000DX instruments with option MSOU installed.

From the Digital Setup menu, select the D15-D§ or the D7-DO tab to set up digital channels.

To use

®m  Click a digital channel to turn on or turn off the display of the channel.

®  (Click the Threshold entry box and use the keypad to enter a value for the voltage level or use the
multipurpose knobs to select a voltage level.

®  Click the Position entry box and move the channel using the multipurpose knob.

u

Select the size of the waveform in the display.
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Behavior

As you turn on digital channels, the corresponding channel indicator along the bottom of the menu changes
to match the color on the digital channel button.

What do you want to do next?

B earn about bus setups. (see page 97)

B Learn about bus configuration. (see page 151)

® [earn more about digital setups. (see page 89)

B Learn how to turn on or turn off the digital channels. (see page 93)
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Bus setup control window (Config tab)

From the Digital menu (or the Vertical menu), select Bus Setup.

The instrument supports serial data standards: SPI, I2C, USB, RS232, 8b10b, and MIPI. When you select
a serial bus, the instrument assigns specific bus signals (called components) to default digital channels,
sets the threshold to an appropriate voltage level.

Overview

Use the Bus Setup Control windows to define up to 16 buses from which to acquire, decode, and display
data. You can set up serial buses for the SPI, 12C, USB, RS232, 8b10b, and MIPI serial data standards.
You can also set up clocked or unclocked parallel buses.

NOTE. The instrument displays I12C as the I2C (Inter-IC Bus) serial bus selection.

For information on the controls, click the buttons.

To use

B Click and drag the scroll bar until the desired Bus number <B1-B16> or name is visible
®  Click on a Bus number or name

m  Click the corresponding Bus number Off/On button

B To name the bus, click the Label entry box and enter a name with the keyboard

B To change the vertical position of the bus on the display, click the Bus Position entry box and use the
keypad or the multipurpose knob to move the bus

B Click a Bus Type: Serial or Parallel
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Bus selection list

For Parallel buses, click the Add Sources button and build your bus with any combination of D15-D0,
Ch1-Ch4, and M1-M4 channels

B For Serial buses, select one of the available options from the drop-down list; the instrument provides
additional parameters to set up for each standard
Behavior

Click the Clear Bus button to clear all the channels from the selected bus and remove the bus from the
display.

TIP. Click the Digital Setup button to quickly access the Digital Setup control window for the parallel
bus type.

What do you want to do next?

Learn about bus configuration. (see page 151)

Learn about digital setups. (see page 89)

Learn how to set up digital waveforms. (see page 583)

Learn how to view analog characteristics of a digital waveform. (see page 583)

Learn how to set up a bus. (see page 584)

Learn how to trigger on a bus. (see page 662)

Learn how to track down serial bus anomalies. (see page 594)

Learn how to troubleshoot circuits using a parallel bus. (see page 596)

Learn how to troubleshoot a serial bus. (see page 599)

Bus selection list

From the Bus Setup window, select a bus to set up from the list of Bus selections <B1-B16>.

To

98

use
Click and drag the scroll bar until the desired Bus number or name is visible.

Click the Bus number <B1-B16> or name to be set up.
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Bus

B1
B2
B3
B4
BS
B6
B7
B8
BY

Bk

Behavior

Click the Bus button to display the bus (On) or to remove it from the display (Off).

What do you want to do next?

® Learn more about bus setups. (see page 97)

B Learn about bus configuration. (see page 151)

B Learn about digital setups. (see page 89)
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Bus search selection list

From the Search Configure window, select a bus source to set up from the list of Source selections
<BI1-B16>.

To use
®  Select the Search Slot from the drop-down list.

B Click and turn (drag) the scroll wheel or click the up/down arrows until the desired Bus number or
name is visible.

®  Click the Bus number <B1-B16> or name to be set up.

B Click OK.

—Soume Selection X
Soarch 1(8us) v

Behavior
Click the OK to return to the Search Configure .
What do you want to do next?

® Learn more about bus setups. (see page 97)

® Learn about bus configuration. (see page 151)

B Learn about digital setups. (see page 89)
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Display or clear a bus

From the Bus Setup window, select the Bus number <B1-B16> or name that you want to display or
clear from the display.

To use
B Select the bus number or name from the list.
B Click the Bus button to select On and display the bus.

m  To clear and remove a bus, click the Clear Bus button.

Bus 1

s

Clear Bus

Behavior
A parallel bus must be defined before it can be displayed.

When you click the Clear Bus button, the instrument removes the bus with the channels used to build the
bus, and the Bus button changes to Off.

What do you want to do next?

B Learn more about bus setups. (see page 97)

m  Learn about bus configuration. (see page 151)

B [earn about digital setups. (see page 89)

Label a bus

From the Bus Setup window, select a Bus number <B1-B16> to label from the Bus list.

To use

Double-click the Label entry box and enter a name up to 7 characters long with the keyboard.

Label

S
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Here is an example of a setup for an SPI bus with a label.

|_ B 100mV/idiv 500 By:8.0G | 400ns/div 25.0GS/s 40.0ps/pt
Rur Sample
1491 acqgs RL:100k

Man March 19, 2013

Bus Setup
Bus

Greent
B2

B3 Rising v
B4 [ 1.4v | Active Low | ¥
B5 14y | Active High | ¥
B6 Label

B7 Green1

B8 Bus1 Position

B9 0.0div (@)

MS First

Behavior

The bus label appears in the list of bus setups in the Config and Display tabs. The instrument also displays
the label adjacent to the bus number on the screen for easy identification.

What do you want to do next?

B ] earn more about bus setups. (see page 97)

®  Learn about bus configuration. (see page 151)

B Learn about digital setups. (see page 89)
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Change the bus position

From the Bus Setup window, select the Bus number <B1-B16> or name to position on the display from
the Bus list.

To use

To change the vertical position of the bus on the display, click the Bus Position entry box and use the
keypad or the multipurpose knob to enter a new position.

Bus1 Position

| 0.0div

Behavior
The instrument moves the bus on the screen to the new position.
What do you want to do next?

®  Learn more about bus setups. (see page 97)

B [earn about bus configuration. (see page 151)

B Learn about digital setups. (see page 89)

Set up an I2C serial bus

NOTE. 12C serial bus setup is available only on instruments with the SR-EMBD option.

From the Bus Setup window, select Serial from the Bus Type list and then select the 12C Serial bus type.

NOTE. The Components for the I>C bus standard are set by the instrument.

For information on the controls, click the buttons.
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To use

B To change the input for a component, click the Input arrow and select a channel from the cascading list.

B To change the voltage threshold level, click the Threshold entry box and use the keypad to enter a
value or use the multipurpose knobs to select a voltage level.

Behavior

The instrument changes the components and voltage threshold levels, and uses those to decode the
selected 12C bus.

What do you want to do next?

® Learn more about bus setups. (see page 97)

B Learn about bus configuration. (see page 151)

B Learn about digital setups. (see page 89)

B Learn how to set up an I2C serial bus. (see page 586)

B Learn how to set up an SPI serial bus. (see page 586)

B Learn how to set up a USB serial bus. (see page 588)

B Learn how to set up an RS-232 serial bus. (see page 587)

B Learn how to set up a MIPI DSI1 Serial Bus (see page 588)

® Learn how to set up a MIPI CSI2 Serial Bus (see page 589)

® Learn how to set up an 8B10B Serial Bus (see page 113)

® Learn how to set up a CAN Bus (see page 117)

® Learn how to set up a MIL-1553 Bus (see page 122)

B earn how to set up an Ethernet Bus (see page 123)

B Learn how to set up an Custom serial bus. (see page 590)

B Learn how to track down serial bus anomalies. (see page 594)
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Bus setups Set up an SPI serial bus

B Learn how to view analog characteristics of a digital waveform. (see page 583)

B Learn how to trigger on a bus. (see page 662)

Set up an SPI serial bus

NOTE. SPI serial bus setup is available only on instruments with the SR-EMBD option.

From the Bus Setup window, select a bus from the Bus list and then select the SPI Serial bus type.

NOTE. The Components for the SPI bus standard are set by the instrument.

For information on the controls, click the buttons.

Rising
Active Low
Aclive High

s P sre v

To use
B To change the input for a component, click the Input and select a channel from the cascading lists.

B To change the voltage threshold level, click the Threshold entry box and use the keypad to enter a
value or use the multipurpose knobs to select a voltage level.

B To set the polarity, click the Polarity entry box and select from the drop-down list. The selections vary
by component.

= To set the word size, click the Word Size entry box and use the keypad to enter a value.

B To set the bit order, click the Bit Order entry box and select from the drop-down list.

Behavior

The instrument changes the components, voltage threshold levels, polarity, word size, and bit order, and
uses those to decode the selected SPI bus.
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Bus setups

Set up an RS-232 serial bus

What do you want to do next?

Learn more about bus setups. (see page 97)

Learn about bus configuration. (see page 151)

Learn about digital setups. (see page 89)

Learn how to set up an I12C serial bus. (see page 586)

Learn how to set up an SPI serial bus. (see page 586)

Learn how to set up a USB serial bus. (see page 588)

Learn how to set up an RS-232 serial bus. (see page 587)

Learn how to set up a MIPI DSI1 Serial Bus (see page 588)

Learn how to set up a MIPI CSI2 Serial Bus (see page 589)

Learn how to set up an 8B10B Serial Bus (see page 113)

Learn how to set up a CAN Bus (see page 117)

Learn how to set up a MIL-1553 Bus (see page 122)

Learn how to set up an Ethernet Bus (see page 123)

Learn how to set up an Custom serial bus. (see page 590)

Learn how to troubleshoot a serial bus. (see page 599)

Learn how to view analog characteristics of a digital waveform. (see page 583)

Learn how to trigger on a bus. (see page 662)

Set up an RS-232 serial bus

106

NOTE. RS-232 serial bus setup is available on instruments with the SR-COMP option.

From the Bus Setup window in the Config tab, select a bus from the Bus list and then select the RS-232
Serial bus type.

NOTE. The Components for the RS-232 bus standard are set by the instrument.

For information on the controls, click the buttons.
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Bus setups

Set up an RS-232 serial bus
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To

use

To change the input for a component, click the Input and select a channel from the cascading lists.

B To change the voltage threshold level, click the Threshold entry box and use the keypad to enter a
value or use the multipurpose knobs to select a voltage level.

B To set the polarity, click the Polarity entry box and select from the drop-down list.

m  To set the data bits, click the Data Bits entry box and select from the drop-down list.

m  To set the parity, click the Parity entry box and select from the drop-down list.

B To set the bit rate, click the Bit Rate entry box and select from the drop-down list.

Behavior

The instrument changes the components, voltage threshold levels, polarity, data bits, parity, and bit rate,
and uses those to decode the selected RS-232 bus.

What do you want to do next?

Learn more about bus setups. (see page 97)

Learn about bus configuration. (see page 151)

Learn about digital setups. (see page 89)

Learn how to set up an I2C serial bus. (see page 586)

Learn how to set up an SPI serial bus. (see page 586)

Learn how to set up a USB serial bus. (see page 588)

Learn how to set up an RS-232 serial bus. (see page 587)

Learn how to set up a MIPI DSI1 Serial Bus (see page 588)

Learn how to set up a MIPI CSI2 Serial Bus (see page 589)

Learn how to set up an 8B10B Serial Bus (see page 113)

Learn how to set up a MIL-1553 Bus (see page 122)
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Bus setups Set up a USB serial bus

B Learn how to set up an Ethernet Bus (see page 123)

B Learn how to set up a CAN Bus (see page 117)

®  Learn how to set up an Custom serial bus. (see page 590)

® Learn how to troubleshoot a serial bus. (see page 599)

B Learn how to view analog characteristics of a digital waveform. (see page 583)

B Learn how to trigger on a bus. (see page 662)

B Learn to view the bus packets. (see page 157)

Set up a USB serial bus

108

NOTE. USB serial bus setup is available only on instruments with the SR-USB option.

From the Bus Setup window in the Config tab, select a bus from the Bus list and then select the USB
Serial bus type.

NOTE. The Components for the USB bus standard are set by the instrument.

For information on the controls, click the buttons.

o
use  |v INFu(12Mbps) [V
.

USB bus setup.
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Bus setups Set up a USB serial bus

L)
n SuperSpeed (5 Gbps) n
L]

USB bus setup with SuperSpeed selected.

To use
B To change the input for a component, click the Input and select a channel from the cascading lists.

B To change the voltage threshold level, click the Threshold (H) or Threshold (L) entry box and use the
keypad to enter a value or use the multipurpose knobs to select a voltage level.

B To set the speed, click the Speed entry box and select from the drop-down list.

B To set the signal type, click the Signal Type (not available with SuperSpeed) entry box and select
from the drop-down list.

Behavior

The instrument changes the components, voltage threshold levels, speed, and signal type, and uses those to
decode the selected USB bus.

What do you want to do next?

®  Learn more about bus setups. (see page 97)

B Learn about bus configuration. (see page 151)

®  Learn about digital setups. (see page 89)

®  Learn how to set up an I12C serial bus. (see page 586)

B Learn how to set up an SPI serial bus. (see page 586)

m  Learn how to set up a USB serial bus. (see page 588)

B Learn how to set up an RS-232 serial bus. (see page 587)

B Learn how to set up a MIPI DSI1 Serial Bus (see page 588)

m  Learn how to set up a MIPI CSI2 Serial Bus (see page 589)

®  Learn how to set up an 8B10B Serial Bus (see page 113)

B Learn how to set up a CAN Bus (see page 117)
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Bus setups Set up a MIPI DSI-1 serial bus

B Learn how to set up a MIL-1553 Bus (see page 122)

B Learn how to set up an Ethernet Bus (see page 123)

®  Learn how to set up an Custom serial bus. (see page 590)

® Learn how to troubleshoot a serial bus. (see page 599)

Learn how to view analog characteristics of a digital waveform. (see page 583)

B Learn how to trigger on a bus. (see page 662)

Set up a MIPI DSI-1 serial bus

10

NOTE. MIPI DSI-1 serial bus setup is available only on instruments with the SR-DPHY option.

From the Bus Setup window in the Config tab, select a bus from the Bus list and then select the MIPI
DSI-1 Serial bus type.

NOTE. The Components for the MIPI DSI-1 bus standard are set by the instrument.

For information on the controls, click the buttons.

N

Clock Analog | ¥
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To use
m  To set the channel type, click the Channel Type entry box and select from the drop-down list.
®  To change the input for a component, click the Input and select a channel from the cascading lists.

B To change the voltage threshold level, click the Threshold entry box and use the keypad to enter a
value or use the multipurpose knobs to select a voltage level. Set the threshold on the low power
portion of the waveform.
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Bus setups Set up a MIPI CSI-2 serial bus

Behavior

The instrument changes the components, voltage threshold levels, polarity, data bits, parity, and bit rate,
and uses those to decode the selected MIPI DSI-1 bus.

What do you want to do next?

B [earn more about bus setups. (see page 97)

®  Learn about bus configuration. (see page 151)

B Learn about digital setups. (see page 89)

B Learn how to set up an I12C serial bus. (see page 586)

B Learn how to set up an SPI serial bus. (see page 586)

B Learn how to set up a USB serial bus. (see page 588)

B Learn how to set up an RS-232 serial bus. (see page 587)

B Learn how to set up a MIPI DSI1 Serial Bus (see page 588)

m  Learn how to set up a MIPI CSI2 Serial Bus (see page 589)

B Learn how to set up an 8B10B Serial Bus (see page 113)

®  Learn how to set up a CAN Bus (see page 117)

m Learn how to set up a MIL-1553 Bus (see page 122)

B Learn how to set up an Ethernet Bus (see page 123)

®  Learn how to set up an Custom serial bus. (see page 590)

B [earn how to troubleshoot a serial bus. (see page 599)

®  Learn how to view analog characteristics of a digital waveform. (see page 583)

B Learn how to trigger on a bus. (see page 662)

B [earn to view the bus packets. (see page 157)

Set up a MIPI CSI-2 serial bus

NOTE. MIPI CSI-2 serial bus setup is available only on instruments with the SR-DPHY option.

From the Bus Setup window in the Config tab, select a bus from the Bus list and then select the MIPI
CSI-2 Serial bus type.

NOTE. The Components for the MIPI CSI-2 bus standard are set by the instrument.
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Bus setups Set up a MIPI CSI-2 serial bus

For information on the controls, click the buttons.

v

Clock Analog | ¥
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To use
= To set the channel type, click the Channel Type entry box and select from the drop-down list.
B To change the input for a component, click the Input and select a channel from the cascading lists.

B To change the voltage threshold level, click the Threshold entry box and use the keypad to enter a
value or use the multipurpose knobs to select a voltage level. Set the threshold on the low power
portion of the waveform.

Behavior

The instrument changes the components, voltage threshold levels, polarity, data bits, parity, and bit rate,
and uses those to decode the selected MIPI CSI-2 bus.

What do you want to do next?

B Learn more about bus setups. (see page 97)

B Learn about bus configuration. (see page 151)

®  Learn about digital setups. (see page 89)

® Learn how to set up an I2C serial bus. (see page 586)

® Learn how to set up an SPI serial bus. (see page 586)

B Learn how to set up a USB serial bus. (see page 588)

B Learn how to set up an RS-232 serial bus. (see page 587)

m Learn how to set up a MIPI DSI1 Serial Bus (see page 588)

® Learn how to set up a MIPI CSI2 Serial Bus (see page 589)

® Learn how to set up an 8B10B Serial Bus (see page 113)

B Learn how to set up a CAN Bus (see page 117)

B Learn how to set up a MIL-1553 Bus (see page 122)
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Bus setups Set up an 8B10B serial bus

B Learn how to set up an Ethernet Bus (see page 123)

B Learn how to set up a Custom serial bus. (see page 590)

®  Learn how to troubleshoot a serial bus. (see page 599)

B Learn how to view analog characteristics of a digital waveform. (see page 583)

Learn how to trigger on a bus. (see page 662)

B Learn to view the bus packets. (see page 157)

Set up an 8B10B serial bus

NOTE. 8BI10B serial bus setup is available only on instruments with the SR-810B or ST6G options.

From the Bus Setup window in the Config tab, select a bus from the Bus list and then select the 8B10B
Serial bus type.

NOTE. The Components for the 8B10B bus standard are set by the instrument.

For information on the controls, click the buttons.

125 G| v
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To use
®  To change the input for a component, click the Input and select a channel from the cascading lists.

B To change the voltage threshold level, click the Threshold entry box and use the keypad to enter a
value or use the multipurpose knobs to select a voltage level.

®  To change the voltage hysteresis level, click the Hysteresis entry box and use the keypad to enter a
value or use the multipurpose knobs to select a voltage level.
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Bus setups Set up a Custom serial bus

m  To set the data rate, click the Data Rate entry box and select from the drop-down list.

m  To set the serial bus type, click the Serial Bus Type entry box and select from the drop-down list.

Behavior

The instrument changes the components, voltage threshold levels, speed, and signal type, and uses those to
decode the selected 8B10B bus.

What do you want to do next?

B Learn more about bus setups. (see page 97)

B [earn about bus configuration. (see page 151)

®  Learn about digital setups. (see page 89)

®m Learn how to set up an I12C serial bus. (see page 586)

m Learn how to set up an SPI serial bus. (see page 586)

m Learn how to set up a USB serial bus. (see page 588)

® Learn how to set up an RS-232 serial bus. (see page 587)

® Learn how to set up a MIPI DSI1 Serial Bus (see page 588)

® Learn how to set up a MIPI CSI2 Serial Bus (see page 589)

B Learn how to set up an 8B10B Serial Bus (see page 113)

® Learn how to set up a CAN Bus (see page 117)

B Learn how to set up a MIL-1553 Bus (see page 122)

B Learn how to set up an Ethernet Bus (see page 123)

® Learn how to set up an Custom serial bus. (see page 590)

B Learn how to troubleshoot a serial bus. (see page 599)

B earn how to view analog characteristics of a digital waveform. (see page 583)

B Learn how to trigger on a bus. (see page 662)

Set up a Custom serial bus

NOTE. Custom serial bus setup is available only on instruments with the SR-CUST option.

From the Bus Setup window, select Serial from the Bus Type list and then select the Custom Serial bus type.

NOTE. The Components for the Custom bus standard are set by the installed custom decoder.
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Bus setups

For information on the controls, click the buttons.

My8biObDecoder | ¥ |

Set up a Custom serial bus

T T

To

use

To change the custom decoder, click the Custom Decoder arrow and select the decoder from the

cascading list.

m  To change the input for a component, click the Input arrow and select a channel from the cascading list.

m  To change the voltage threshold level, click the Threshold entry box and use the keypad to enter a
value or use the multipurpose knobs to select a voltage level.

Behavior

The instrument changes the components and voltage threshold levels, and uses those to decode the
selected Custom bus.

What do you want to do next?

Learn more about bus setups. (see page 97)

Learn about bus configuration. (see page 151)

Learn about digital setups. (see page 89)

Learn how to set up an I2C serial bus. (see page 586)

Learn how to set up an SPI serial bus. (see page 586)

Learn how to set up a USB serial bus. (see page 588)

Learn how to set up an RS-232 serial bus. (see page 587)

Learn how to set up a MIPI DSI1 Serial Bus (see page 588)

Learn how to set up a MIPI CSI2 Serial Bus (see page 589)

Learn how to set up an 8B10B Serial Bus (see page 113)

Learn how to set up a CAN Bus (see page 117)

Learn how to set up a MIL-1553 Bus (see page 122)
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Bus setups

Set up a PCle serial bus

Learn how to set up an Ethernet Bus (see page 123)

Learn how to set up a Custom serial bus. (see page 590)

Learn how to track down serial bus anomalies. (see page 594)

Learn how to view analog characteristics of a digital waveform. (see page 583)

Learn how to trigger on a bus. (see page 662)

Set up a PCle serial bus

116

NOTE. PCle serial bus setup is available only on instruments with the SR-PCIE option.

From the Bus Setup window, select Serial from the Bus Type list and then select the PCle Serial bus type.

For information on the controls, click the buttons.

owa | om [ sumy
50.0mV

25G0s v

To use

To change the input for a component, click the Input and select a channel from the cascading lists.
To set the serial bus type, click the Serial Bus Type entry box and select from the drop-down list.

To change the voltage threshold level, click the Threshold entry box and use the keypad to enter a
value or use the multipurpose knobs to select a voltage level.

To change the voltage hysteresis level, click the Hysteresis entry box and use the keypad to enter a
value or use the multipurpose knobs to select a voltage level.

To set the data rate, click the Data Rate entry box and select from the drop-down list.

Behavior

The instrument changes the components and voltage threshold levels, and uses those to decode the
selected bus.
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Bus setups

What do you want to do next?

Learn more about bus setups. (see page 97)

Learn about bus configuration. (see page 151)

Learn about digital setups. (see page 89)

Learn how to set up an I12C serial bus. (see page 586)

Learn how to set up an SPI serial bus. (see page 586)

Learn how to set up a USB serial bus. (see page 588)

Learn how to set up an RS-232 serial bus. (see page 587)

Learn how to set up a MIPI DSI1 Serial Bus (see page 588)

Learn how to set up a MIPI CSI2 Serial Bus (see page 589)

Learn how to set up an 8B10B Serial Bus (see page 113)

Learn how to set up an Custom serial bus. (see page 590)

Learn how to set up a CAN Serial Bus (see page 117)

Learn how to set up a LIN Serial Bus (see page 591)

Learn how to set up a FLEXRAY Serial Bus (see page 592)

Learn how to set up a MIL-1553 Bus (see page 122)

Learn how to set up an Ethernet Bus (see page 123)

Learn how to track down serial bus anomalies. (see page 594)

Learn how to view analog characteristics of a digital waveform. (see page 583)

Set up a CAN serial bus

Learn how to trigger on a bus. (see page 662)

Set up a CAN serial bus

NOTE. CAN serial bus setup is available only on instruments with the SR-AUTO option.

From the Bus Setup window, select Serial from the Bus Type list and then select the CAN Serial bus type.

For information on the controls, click the buttons.
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Bus setups

18
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To use

Set up a CAN serial bus

To change the input for a component, click the Input and select a channel from the cascading lists.

m  To set the serial bus type, click the Serial Bus Type entry box and select from the drop-down list.

B To change the voltage threshold level, click the Threshold entry box and use the keypad to enter a
value or use the multipurpose knobs to select a voltage level.

®  To change the bit rate, click the Bit Rate and select the rate from the cascading list.

Behavior

The instrument changes the components and voltage threshold levels, and uses those to decode the
selected bus.

What do you want to do next?

Learn more about bus setups. (see page 97)

Learn about bus configuration. (see page 151)

Learn about digital setups. (see page 89)

Learn how to set up an 12C serial bus. (see page 586)

Learn how to set up an SPI serial bus. (see page 586)

Learn how to set up a USB serial bus. (see page 588)

Learn how to set up an RS-232 serial bus. (see page 587)

Learn how to set up a MIPI DSI1 Serial Bus (see page 588)

Learn how to set up a MIPI CSI2 Serial Bus (see page 589)

Learn how to set up an 8B10B Serial Bus (see page 113)

Learn how to set up an Custom serial bus. (see page 590)

Learn how to set up a PCle Serial Bus (see page 590)

Learn how to set up a LIN Serial Bus (see page 591)
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Bus setups Set up a LIN serial bus

®  Learn how to set up a FLEXRAY Serial Bus (see page 592)

B Learn how to set up a MIL-1553 Bus (see page 122)

B [earn how to set up an Ethernet Bus (see page 123)

®m  Learn how to track down serial bus anomalies. (see page 594)

B Learn how to view analog characteristics of a digital waveform. (see page 583)

B Learn how to trigger on a bus. (see page 662)

Set up a LIN serial bus

NOTE. LIN serial bus setup is available only on instruments with the SR-AUTO option.

From the Bus Setup window, select Serial from the Bus Type list and then select the LIN Serial bus type.

For information on the controls, click the buttons.
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To use
B To change the input for a component, click the Input and select a channel from the cascading lists.
B To set the serial bus type, click the Serial Bus Type entry box and select from the drop-down list.

m  To change the voltage threshold level, click the Threshold entry box and use the keypad to enter a
value or use the multipurpose knobs to select a voltage level.

B To set the polarity, click the Polarity entry box and select from the drop-down list.
m  To set the LIN standard, click the LIN Standard entry box and select from the drop-down list.

B To set the bit rate, click the Bit Rate entry box and select from the drop-down list.
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Bus setups Set up a FLEXRAY serial bus

Behavior

The instrument changes the components and voltage threshold levels, and uses those to decode the
selected bus.

What do you want to do next?

B Learn more about bus setups. (see page 97)

®  Learn about bus configuration. (see page 151)

B Learn about digital setups. (see page 89)

B Learn how to set up an I2C serial bus. (see page 586)

® Learn how to set up an SPI serial bus. (see page 586)

B Learn how to set up a USB serial bus. (see page 588)

B Learn how to set up an RS-232 serial bus. (see page 587)

B Learn how to set up a MIPI DSI1 Serial Bus (see page 588)

m Learn how to set up a MIPI CSI2 Serial Bus (see page 589)

B Learn how to set up an 8B10B Serial Bus (see page 113)

® [earn how to set up an Ethernet Bus (see page 123)

m Learn how to set up an Custom serial bus. (see page 590)

B Learn how to set up a PCle Serial Bus (see page 590)

® Learn how to set up a CAN Bus (see page 117)

B earn how to set up a FLEXRAY Serial Bus (see page 592)

®  Learn how to track down serial bus anomalies. (see page 594)

® Learn how to view analog characteristics of a digital waveform. (see page 583)

® Learn how to trigger on a bus. (see page 662)

Set up a FLEXRAY serial bus

120

NOTE. FLEXRAY serial bus setup is available only on instruments with the SR-AUTO option.

From the Bus Setup window, select Serial from the Bus Type list and then select the FLEXRAY Serial bus
type.

For information on the controls, click the buttons.
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Set up a FLEXRAY serial bus
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To

use

To change the input for a component, click the Input and select a channel from the cascading lists.

B To set the signal type, click the Signal Type entry box and select from the drop-down list.

®  To change a voltage threshold level, click the Threshold entry box and use the keypad to enter a value
or use the multipurpose knobs to select a voltage level.

®  To set the channel type, click the Channel Type entry box and select from the drop-down list.

®  To set the bit rate, click the Bit Rate entry box and select from the drop-down list.

Behavior

The instrument changes the components and voltage threshold levels, and uses those to decode the
selected bus.

What do you want to do next?

Learn more about bus setups. (see page 97)

Learn about bus configuration. (see page 151)

Learn about digital setups. (see page 89)

Learn how to set up an 12C serial bus. (see page 586)

Learn how to set up an SPI serial bus. (see page 586)

Learn how to set up a USB serial bus. (see page 588)

Learn how to set up an RS-232 serial bus. (see page 587)

Learn how to set up a MIPI DSI1 Serial Bus (see page 588)

Learn how to set up a MIPI CSI2 Serial Bus (see page 589)

Learn how to set up an 8B10B Serial Bus (see page 113)

Learn how to set up an Custom serial bus. (see page 590)

Learn how to set up a PCle Serial Bus (see page 590)
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Set up a MIL-1553 serial bus

Learn how to set up a CAN Bus (see page 117)

Learn how to set up a LIN Serial Bus (see page 591)

Learn how to set up a MIL-1553 Bus (see page 122)

Learn how to set up an Ethernet Bus (see page 123)

Learn how to track down serial bus anomalies. (see page 594)

Learn how to view analog characteristics of a digital waveform. (see page 583)

Learn how to trigger on a bus. (see page 662)

Set up a MIL-1553 serial bus

122

NOTE. MIL-STD-1553 serial bus setup is available only on instruments with the SR-AERO option.

From the Bus Setup window, select Serial from the Bus Type list and then select the MIL-1553 Serial bus
type.

For information on the controls, click the buttons.

Normal n

To use

B To change the input for a component, click the Input and select a channel from the cascading lists.

m  To set the serial bus type, click the Serial Bus Type entry box and select from the drop-down list.

®  To change a voltage threshold level, click the Threshold entry box and use the keypad to enter a value
or use the multipurpose knobs to select a voltage level.

m  To select the polarity, click the Polarity and select the polarity from the drop-down list.

®  To change the response time maximum and minimum, click a Response Time entry box and use the

keypad to enter a value or use the multipurpose knobs to select a time.
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Behavior

Set up an Ethernet serial bus

The instrument changes the components and voltage threshold levels, and uses those to decode the
selected bus.

What do you want to do next?

Learn more about bus setups. (see page 97)

Learn about bus configuration. (see page 151)

Learn about digital setups. (see page 89)

Learn how to set up an I12C serial bus. (see page 586)

Learn how to set up an SPI serial bus. (see page 586)

Learn how to set up a USB serial bus. (see page 588)

Learn how to set up an RS-232 serial bus. (see page 587)

Learn how to set up a MIPI DSI1 Serial Bus (see page 588)

Learn how to set up a MIPI CSI2 Serial Bus (see page 589)

Learn how to set up an 8B10B Serial Bus (see page 113)

Learn how to set up an Custom serial bus. (see page 590)

Learn how to set up a PCle Serial Bus (see page 590)

Learn how to set up a LIN Serial Bus (see page 591)

Learn how to set up a FLEXRAY Serial Bus (see page 592)

Learn how to set up a MIL-1553 Bus (see page 122)

Learn how to set up an Ethernet Bus (see page 123)

Learn how to set up a CAN Bus (see page 117)

Learn how to track down serial bus anomalies. (sec page 594)

Learn how to view analog characteristics of a digital waveform. (see page 583)

Learn how to trigger on a bus. (see page 662)

Set up an Ethernet serial bus

NOTE. Ethernet serial bus setup is available only on instruments with the SR-ENET option.

From the Bus Setup window, select Serial from the Bus Type list and then select the Ethernet Serial bus
type.

For information on the controls, click the buttons.
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100Base-TX | ¥ |

Set up an Ethernet serial bus

Differential ¥ |

To use

To set the serial bus type, click the Serial Bus Type entry box and select from the drop-down list.

To select the standard, click the Standard and select the standard from the drop-down list.

To select the signal type, click the Signal Type and select the signal type from the drop-down list.

To change the input for a component, click the Input and select a channel from the cascading lists.

To change a voltage threshold level, click the Threshold entry box and use the keypad to enter a value

or use the multipurpose knobs to select a voltage level.

Behavior

The instrument uses the selected components and voltage threshold levels to decode the selected bus.

What do you want to do next?

Learn more about bus setups. (see page 97)

Learn about bus configuration. (see page 151)

Learn about digital setups. (see page 89)

Learn how to set up an I2C serial bus. (see page 586)

Learn how to set up an SPI serial bus. (see page 586)

Learn how to set up a USB serial bus. (see page 588)

Learn how to set up an RS-232 serial bus. (see page 587)

Learn how to set up a MIPI DSI1 Serial Bus (see page 588)

Learn how to set up a MIPI CSI2 Serial Bus (see page 589)

Learn how to set up an 8B10B Serial Bus (see page 113)

Learn how to set up an Custom serial bus. (see page 590)

Learn how to set up a PCle Serial Bus (see page 590)
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®  Learn how to set up a LIN Serial Bus (see page 591)

B Learn how to set up a FLEXRAY Serial Bus (sec page 592)

B Learn how to set up a MIL-1553 Bus (see page 122)

®  Learn how to set up a CAN Bus (see page 117)

B Learn how to track down serial bus anomalies. (sec page 594)

B Learn how to view analog characteristics of a digital waveform. (see page 583)

B Learn how to trigger on a bus. (see page 662)

Select the number of lanes

From the Bus Setup window, select Serial from the Bus Type list and then select one of the bus types.

To use

To change the number of lanes for the bus, click the No Of Lanes and select from the cascading list.

3 snalog | ¥ |  Clock ch1 [ 500mV
4 D+ chz | 500mv
Lane u nalog | ¥

D- Ch3 || 500mV

D+ Ch2 {» 1.4V
Lane 1 Analog | ¥

D- Ch3 = 14V

D+ Ch2  {» 1.4V
Lane 2 Analog | ¥

D- Ch3 = 14V

Behavior

The instrument acquires data from the number of lanes you select. You can select a maximum of 4 lanes
on MSO instruments, other instruments only allow 1 lane.

What do you want to do next?

m  Learn more about bus setups. (see page 97)

B Learn about bus configuration. (see page 151)

®  Learn about digital setups. (see page 89)
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Select the serial bus channel type

126

NOTE. Serial bus Channel Type is only available on MSO70000C/DX models.

From the Bus Setup window, select Serial from the Bus Type list and then select one of the bus types.

To use

To change the channel type for the displayed components of the bus, click the Channel Type and select
from the cascading list.

++++++

Channel
éﬂnnalng ot
|Digital |

Behavior

The instrument acquires data from the channel you select for each component. The channel type supported
are analog or digital (MSO models only) input. The analog input consists of two analog signals (D+

and D-). The digital input consists of three digital signals (D+, D-, and D+/D- [differential probing
between D+ and D-]).

What do you want to do next?

m  Learn more about bus setups. (see page 97)

B Learn about bus configuration. (see page 151)

B Learn about digital setups. (see page 89)
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Select the serial bus channel input

From the Bus Setup window, select Serial from the Bus Type list and then select one of the bus types.

To use
To change the input for the displayed components of the bus, click the Input and select from the cascading
list.
BH | chant-cChand » | e
B |ttt - watha labels |
m . Llser;:l
BH os-ms v | User
B o
| o3
(] o4
B o
B o
B o

NOTE. You have the option to add user-defined label for the bus sources.

Behavior
The instrument acquires data from the channel you select for each component.
What do you want to do next?

B [earn more about bus setups. (see page 97)

® [ earn about bus configuration. (see page 151)

m  Learn about digital setups. (see page 89)
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Select the USB serial bus speed

128

NOTE. USB serial bus Speed selection is available only on instruments with option SR-USB.

From the Bus Setup window, select Serial from the Bus Type list and then select the USB Serial bus type.

To use

To change the speed for the displayed component of the bus, click Speed and select from the cascading list.

Low (1.5 Mbps)
Full (12 Mbps)
High (480 Mbps)

SuperSpeed (5 Gbps)

Behavior

The instrument acquires data from the channel you select for each component. SuperSpeed is only
available on instruments with a bandwidth of >8 GHz.

What do you want to do next?

B [earn more about bus setups. (see page 97)

B Learn about bus configuration. (see page 151)

m  Learn about digital setups. (see page 89)
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Select the USB bus signal type

NOTE. The USB bus Signal Type is available only on instruments with option SR-USB.

Signal Type is not available if you select SuperSpeed in the Bus Setup menu.

From the Bus Setup window, select Serial from the Bus Type list and then select the USB Serial bus type.

To use

To change the signal type for the displayed components of the bus, click Signal Type and select from
the cascading list.

Differential ¥
2ingle Ended

Behavior
The instrument acquires data from the channel you select for each component.
What do you want to do next?

B Learn more about bus setups. (see page 97)

B Learn about bus configuration. (see page 151)

m  Learn about digital setups. (see page 89)
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Select the data rate

Select the data rate

From the Bus Setup window, select Serial from the Bus Type list and then select the Serial bus type.

To use

To change the data rate for the displayed component of the bus, click Data Rate and select from the
cascading list. Items in the list depend on the serial bus type.

Behavior

Custom
1.25 Gb/s
1.5 Gbls
2.125 Gbls
2.5 Gbls
3.0Gbis
3.125 Ghis
4.25 Gbls

6.23 Gb/s
1.25 Gbls

The instrument acquires data from the channel you select for each component.

What do you want to do next?

B Learn more about bus setups. (see page 97)

B Learn about bus configuration. (see page 151)

B Learn about digital setups. (see page 89)
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Select the serial bus input

Select the serial bus input

From the Bus Setup window, select Serial from the Bus Type list and then select from the cascading list.

To change the input for the displayed components of the bus, click the Input and select from the cascading

To use
list.
Ch1 | gl | chant-chans ||| ch
B wathi-maths » || ch2
B oDo-o7 v | ch3
B8 ps-pis » O | chs
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Select the USB bus threshold

132

From the Bus Setup window, select Serial from the Bus Type list and then select USB Serial bus type.

NOTE. USB bus threshold high and low are available only on instruments with option SR-USB.

To use

To change the voltage high or low threshold level of the component Input, click | 300mV | or

| 500mv
entry box respectively and use the keypad to enter a value or use the multipurpose knobs to
select a voltage level. Setting the low threshold is only available when the signal type is differential.

Behavior
The instrument acquires data from the channel you select for each component.
What do you want to do next?

m  Learn more about bus setups. (see page 97)

B Learn about bus configuration. (see page 151)

B Learn about digital setups. (see page 89)
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Select the serial bus channel threshold

From the Bus Setup window, select Serial from the Bus Type list and then select from the cascading list.

NOTE. The serial bus channel Threshold option is available only on instruments with one or more of
the SR- options.

To use

To change the voltage threshold level of the component Input, click the Threshold entry box and use the
keypad to enter a value or use the multipurpose knobs to select a voltage level.

1.4Y

Behavior
The instrument can use different voltage thresholds levels for each component.
What do you want to do next?

m  Learn more about bus setups. (see page 97)

B Learn about bus configuration. (see page 151)

®  Learn about digital setups. (see page 89)
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Select the SPI bus channel polarity

NOTE. The SPI Bus Channel Polarity option is available only on instruments with option SR-EMBD.

From the Bus Setup window, select the Select tab and the SPI Serial bus type.

To use
m  Scroll through the Bus list and select the SPI bus to configure.

B Click the Polarity box and select the polarity from the drop-down list.

Behavior

For the SCLK component:

B Rising causes the instrument to acquire data on the rising edge of the signal.

®  Falling causes the instrument to acquire data on the falling edge of the signal.

For the SS component:

B Active Low causes the instrument to decode the bus when the Slave Select signal is at a low level.
B Active High causes the instrument to decode the bus when the Slave Select signal is at a high level.
For the Data component:

B Active Low causes the instrument to decode signals at a low level.

B Active High causes the instrument to decode signals at a high level.

What do you want to do next?

B Learn more about bus setups. (see page 97)

m  [earn about bus configuration. (see page 151)

B Learn about digital setups. (see page 89)
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Select the RS-232 bus channel polarity

NOTE. The RS-232 Bus Channel Polarity option is available on instruments with option SR-COMP.

From the Bus Setup window, select the Select tab and the RS-232 Serial bus type.

To use

Mormal “

m  Scroll through the Bus list and select the RS-232 bus to configure.

B Click the Polarity box and select the polarity from the drop-down list.

Behavior

For the Data component:

B Normal causes the instrument to decode signals at a high level as a binary 1.
B Inverted causes the instrument to decode signals at a high level as a binary 0.
What do you want to do next?

B Learn more about bus setups. (see page 97)

®  Learn about bus configuration. (see page 151)

m  Learn about digital setups. (see page 89)
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Select the RS-232 bus data bits

136

NOTE. The RS-232 Bus Data Bits option is available only on instruments with option SR-COMP.

From the Bus Setup window, select the Select tab and the RS-232 Serial bus type.

To use
Data Bits
a8 L J

m  Scroll through the Bus list and select the RS-232 bus to configure.

B Click the Data Bits box and select the data bits from the drop-down list.

Behavior

You have the option to set the number of data bits in a frame for RS-232 bus to:
= 7.

m 8, the default.

= O

What do you want to do next?

®  [earn more about bus setups. (see page 97)

m  [earn about bus configuration. (see page 151)

B [earn about digital setups. (see page 89)
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Select the RS-232 bus parity

NOTE. The RS-232 Bus Parity option is available on instruments with option SR-COMP.

From the Bus Setup window, select the Select tab and the RS-232 Serial bus type.

To use

®  Scroll through the Bus list and select the RS-232 bus to configure.

B Click the Parity box and select the parity from the drop-down list.

Behavior

Set the bus parity selection to:
®  None, the default.

= Odd.

= Even.

NOTE. There is no parity selection when the number of data bits is 9.

What do you want to do next?

®  Learn more about bus setups. (see page 97)

B Learn about bus configuration. (see page 151)

B Learn about digital setups. (see page 89)
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Select the RS-232 bus bit rate

NOTE. The RS-232 Bus Bit Rate option is available on instruments with option SR-COMP.

From the Bus Setup window, select the Select tab and the RS-232 Serial bus type.

To use

m  Scroll through the Bus list and select the RS-232 bus to configure.

B (Click the Bit Rate box and select the bit rate from the drop-down list.

Behavior
Set the bus bit rate to:

= 50,300, 1200, 2400, 9600, 19200, 38400, 115200, 921600, or 10000000. The default value is 9600.

B Custom. To change the bit rate, click the Bit Rate entry box and use the keypad to enter a value.

Custom v M toobis_[a

What do you want to do next?

B Learn more about bus setups. (see page 97)

B [earn about bus configuration. (see page 151)

®  Learn about digital setups. (see page 89)
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Select the SPI bus framing

NOTE. The SPI bus Framing option is available only on instruments with option SR-EMBD.

From the Bus Setup window, select the Select tab and the SPI Serial bus type.

To use
m  Select the framing from the drop-down list.
®m  Select SS framing for three wire SPI decode.

B Select Idle framing for two wire SPI decode.

Behavior

The instrument changes the framing and uses that to decode the selected SPI bus.
What do you want to do next?

B Learn more about bus setups. (see page 97)

®m  Learn about bus configuration. (see page 151)

B Learn about digital setups. (see page 89)
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Set the SPI bus idle time

NOTE. The SPI bus Idle Time option is available only on instruments with option SR-EMBD.

From the Bus Setup window, select the Select tab and the SPI Serial bus type.

To use
m  Select the Idle framing from the drop-down list.

®  To change the idle time, click the Idle Time entry box and use the keypad to enter a value.

5.0pS

Behavior
The instrument changes the idle time and uses that to decode the selected SPI bus.
What do you want to do next?

B Learn more about bus sctups. (see page 97)

®  Learn about bus configuration. (see page 151)

B Learn about digital setups. (see page 89)
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Set the SPI bus word size

NOTE. The SPI Bus Word Size option is available only on instruments with option SR-EMBD.

From the Bus Setup window, select the Select tab and the SPI Serial bus type.

To use
m  Scroll through the Bus list and select the SPI bus to configure.

®  Click the Word Size box and enter a size using the key pad. You can also edit the value with the
keyboard or multipurpose knob.

Behavior
The instrument changes the word size and uses that to decode the selected SPI bus.
What do you want to do next?

B earn more about bus setups. (see page 97)

B Learn about bus configuration. (see page 151)

m  Learn about digital setups. (see page 89)
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Select the SPI bus bit order

NOTE. The SPI Bus Bit Order option is available only on instruments with option SR-EMBD.

From the Bus Setup window, select the Select tab and the SPI Serial bus type.

To use
m  Scroll through the Bus list and select the SPI bus to configure.

®  Click the Bit Order box and select the direction from the drop-down list: MS First or LS First.

Behavior

B MS First causes the instrument to decode the data sequence from the MSB to the LSB.
B LS First causes the instrument to decode the data sequence from the LSB to the MSB.
What do you want to do next?

B [earn more about bus setups. (see page 97)

B Learn about bus configuration. (see page 151)

B [earn about digital setups. (see page 89)
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Set up a parallel bus

From the Bus Setup window, select a bus from the Bus list, select the Parallel bus type, and then click
the Add Sources button.

Overview

When you acquire data from a Parallel bus, you can set up the bus to be clocked or unclocked.

To use

For information on the controls, click the buttons.

Behavior

If the bus is not clocked, the instrument acquires all data from the parallel bus at the sample rate of the
instrument.

What do you want to do next?

B Learn more about bus setups. (see page 97)

B Learn about bus configuration. (see page 151)

m  Learn about digital setups. (see page 89)

B Learn how to set up a parallel bus. (see page 584)

®  Learn how to troubleshoot circuits using a parallel bus. (see page 596)

m  Learn how to view analog characteristics of a digital waveform. (see page 583)

B Learn how to trigger on a bus. (see page 662)
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Set up a clocked parallel bus

144

From the Bus Setup window, select a bus from the Bus list and then select the Parallel bus type.

Overview

The instrument can trigger parallel bus data only when the Clock Source is Channel 4.

For information on the controls, click the buttons.

To use
®  To change the Clock Source, select a channel from the cascading list.

B To change the Clock Polarity, select from Rising, Falling, or Either.

Behavior

m  Rising causes the instrument to decode data on the rising edge of the signal.

®  Falling causes the instrument to decode data on the falling edge of the signal.

®  FEither causes the instrument to decode data on the rising and the falling edges of the signal.
What do you want to do next?

m  Learn more about bus setups. (see page 97)

B Learn about bus configuration. (see page 151)

B Learn about digital setups. (see page 89)

m  Learn how to set up a parallel bus. (see page 584)

m  [earn how to troubleshoot circuits using a parallel bus. (see page 596)

B Learn how to view analog characteristics of a digital waveform. (see page 583)

B Learn how to trigger on a bus. (see page 662)
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Add sources to a parallel bus

From the Bus Setup window, click the Add Sources Select button.

To use
®  Click the button for each channel to add to the bus.
B Click the OK button.

Bus 1 Source !

NOTE. You have the option to add user-defined labels for the analog, reference, bus, and digital sources.
Digital sources are only available on MSO series instruments.

Behavior

The instrument adds the channels to the parallel bus starting with the Most Significant Bit (MSB). As you
select each subsequent channel, the instrument adds the channel to the bus as the next lower bit. The last
channel you select is the Least Significant Bit (LSB).

What do you want to do next?
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®  Learn more about bus sctups. (see page 97)

m  Learn about bus configuration. (see page 151)

B Learn about digital setups. (see page 89)

Set up bus channel thresholds

NOTE. Serial Bus Channel Type is only available on instruments with an SR-xxxx option.

From the Bus Setup window, select a bus number from the Bus list.

To use
®  Click the Thresholds Setup button.

B Double-click the Threshold entry box for the desired channel, and use the keypad to enter a value or
use the multipurpose knobs to select a voltage level.

| Threshold Setup X

TIP. 1o quickly set the thresholds for all channels to the same voltage level, use the Global Threshold (see
page 95) entry box to set the value, and click the Apply button.

What do you want to do next?
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®  Learn more about bus setups. (see page 97)

B Learn about bus configuration. (see page 151)

®  Learn about digital setups. (see page 89)
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Change the bit order of a channel in a parallel bus

NOTE. Serial Bus Channel Type is only available on instruments with an SR-xxxx option.

From the Bus Setup window, select a channel to move to a different bit order position within a parallel bus.

To use
m  Select a parallel bus from the Bus list.
B (lick the channel for which you want to change the bit order in the Bus Contains list.

®  Click the Up or Down arrows to change the bit order of the selected channel.

Behavior

B Moves the selected channel towards the MSB (most significant bit) position in the bit order when you
click the arrow that points up.

B Moves the selected channel towards the LSB (least significant bit) position in the bit order when
you click the arrow that points down.

TIP. 1o quickly remove any channel from the parallel bus, double-click the channel in the Bus List control.

What do you want to do next?

B [earn more about bus setups. (see page 97)

B Learn about bus configuration. (see page 151)

m  Learn about digital setups. (see page 89)
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Remove a channel from a parallel bus

From the Bus Setup window, select a channel to remove from a parallel bus.

To use
m  Select a parallel bus from the Bus list.
B Click the channel you want to remove from the Bus Contains list.

B Click the Remove button.

Behavior
The instrument removes the channel from the bus and shifts the bit order accordingly.
What do you want to do next?

m  [earn more about bus setups. (see page 97)

B [ earn about bus configuration. (see page 151)

B Learn about digital setups. (see page 89)
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Select the bus clock source channel

From the Bus Setup window, select a bus, select the Parallel bus type, and click Clocked.

To use
= Connect a probe between the instrument and the clock signal in your system under test.

B Click the Clock Source selection box and select the appropriate channel from the cascading list.

BH chani - chiang User defined

B | math - wstha b labels
B oo
BH | os-ois 3

zer
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D7
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NOTE. You have the option to add user-defined labels for the analog, reference, bus, and digital sources.
Digital sources are only available on MSO models.

Behavior

The instrument acquires data from the parallel bus only when the signal used as the Clock Source changes
logic levels.

What do you want to do next?

B Learn more about bus sctups. (see page 97)

m  Learn about bus configuration. (see page 151)

B Learn about digital setups. (see page 89)
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Select the Bus clock channel polarity

From the Bus Setup window, select a bus, select the Parallel bus type, and click Clocked.

To use
m  Connect a probe between the instrument and the clock signal in your system under test.

B Click the Clock Polarity selection box and select from Rising, Falling, or Either.

Clock Polarity
Rising ¥

Behavior

m  Rising causes the instrument to acquire data on the rising edge of the signal.

B Falling causes the instrument to acquire data on the falling edge of the signal.

®  Either causes the instrument to acquire data on the rising and the falling edges of the signal.
What do you want to do next?

B Learn more about bus setups. (see page 97)

B Learn about bus configuration. (see page 151)

®  Learn about digital setups. (see page 89)

Bus setup control window (Display tab)

From the Bus Setup window, select the Display tab.

Overview

Use the Bus Setup Display window to define how the instrument displays data acquired from the selected
bus.
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To use

Config

Data

@ P

=
ab10b

Behavior

The instrument displays data from the bus based on the selected Bus Components, Busform Decode
option, and the symbol file.

For the LIN, FLEXRAY, MIL1553, MIPI DSI-1, MIPI CSI-2, and Custom serial bus, you can also display
the decode of the bus in mixed, Hex, and Binary method.

Hex n

Binary
Mixed

For the CAN serial bus, you can display the decode of the bus in Hex and Binary.

For the 8B10B serial bus, you can also display the decode of the bus in Symbol, Character , Data Hex, and
Data Binary method.

Data Binary
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For the PCle serial bus, you can display the decode of the bus in Symbol, Character Symbol, Character

KCode, Data Hex, Data Binary, Descrambled Hex, and Descrambled Binary. Select the decode from

the drop down list.

Symbol

Character Symbol
Character KCode
Data Hex

Data Binary

Descrambled Hex

Descrambled Binary

For the RS232 serial bus, you can also display the decode of the bus in ASCII, Binary, and Hex.

For the USB serial bus, you can display the decode of the bus in Mixed Hex, Mixed ASCII, Hex, Binary,

Packet, and Details. The speed you select determines the available decodes. Select the decode form

the drop down list.

Mixed Hex
Mixed ASCI

Hex

Binary

For the Ethernet serial bus, you can display the decode of the bus in Mixed Hex, Mixed ASCII, Hex, and

Binary. Select the decode form the drop down list.
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Select the bus display view

Busform Decode
Mixed Hex ¥
Mixed ASCI

Hex

Binary

What do you want to do next?

m  Learn about bus setups. (see page 97)

®  Learn about digital setups. (see page 89)

B Learn how to set up digital waveforms. (see page 583)

m  [earn how to view analog characteristics of a digital waveform. (see page 583)
B Learn how to set up a bus. (see page 584)

B Learn how to trigger on a bus. (see page 662)

m  Learn how to track down serial bus anomalies. (see page 594)

B Learn how to troubleshoot circuits using a parallel bus. (see page 596)

m

Learn how to troubleshoot a serial bus. (see page 599)

Select the bus display view

154

From the Bus Setup window, select the Display tab.

To use

Scroll through the Bus list and select the bus to configure.

Click a + box to display additional views, or click a - box to remove views.

Bus

=1l B1

Data
[=] LMK
=] PHY
Bb10b
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Bus views may also be added or removed from the display by clicking on the + box or - box in the display.
Available views may include Transaction/transport, link/framing/packets, physical/bytes/symbols, and bit

level.
i i
@ L
. . . . .
M‘Wlﬂll,@
B PHY 354 bytes ) 138 bytes 'Ml
T

[ @™ 146mv 400ns

Behavior

B Clicking on a + box displays additional views of a bus.
B (Clicking on a - box removes bus views from the display.
What do you want to do next?

B Learn more about bus configuration. (see page 151)

®  Learn about bus setups. (see page 97)

®m  Learn about digital setups. (see page 89)

MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series 155



Bus setups

Select the bus decode method

Select the bus decode method

156

From the Bus Setup window, select the Display tab.

To use

Scroll through the Bus list and select the bus to configure.

Click the Busform Decode drop down list and select the method to interpret and display the data
from the bus.

Behavior

The instrument displays the busform based on the selected decode method. Available decode methods vary
with the selected bus.

Hex causes the instrument to decode and display the bus as a hexadecimal value.
Binary causes the instrument to decode and display the bus as a binary value.
ASCII causes the instrument to decode and display the bus as an ASCII value.

Mixed causes the instrument to decode and display the bus frame and address in decimal. You
have the option to display the data either as a hexadecimal or an ASCII value. Mixed displays the
data type as symbols, and it displays the virtual channel and word count in decimal. All other fields
are displayed in hexadecimal.

Mixed decoding methods like symbol for DT (Data Type MIPI element), decimal for VC (Virtual
Channel MIPI element) and WC (Word Count MIPI element), and hexadecimal for all other fields
are available for MIPI DSI-1 serial bus type.

What do you want to do next?

Learn more about bus configuration. (see page 151)

Learn about the symbol file format. (see page 158)

Learn about bus setups. (see page 97)

Learn about digital setups. (see page 89)

Learn to view the bus packets. (see page 157)
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View bus packet

NOTE. Serial Bus Channel Type is only available on instruments with option SR-COMP.

From the Bus Setup window, select Serial from the Bus Type list and then select the RS-232 in the
Config tab.

To use

B Select the Packet View check box in the Config tab. The bus display shows decoded packet level
information on the bus and displays the value in hexadecimal, binary, or ASCII in the bus waveform.

m  Select one of the available options in the End of Packet list.

'+ Packet View End Of Packet

00k (NUL)
0Ah (LF)

0Dh (CR)
20h (SPY

FFh

RS-232 decoding displays a stream of bytes. You can organize the stream into packets with an
end-of-packet character.

Select the bus symbol table

NOTE. Symbol tables are only available when a parallel bus is selected.

Symbol files are files of alphanumeric symbol names and associated data values, and are used to map a
group value to a text string. The instrument displays the symbol in place of the numeric value. For
example, a symbol file could map an address group value to a specific bus cycle. This decoding makes it
easier to recognize and locate specific numeric values on the bus.

Symbol files must follow a specific format (see page 158) to be compatible with the file reader of the
instrument.

From the Bus Setup window, select the Configure tab.
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To use

B Scroll through the Bus list <B1-B16> and select the bus to configure.
B Select the Display tab.

m  Click the Use Symbol File check box.

B (Click the Browse button to locate the file (see page 160).

Use Symbol File

ol (Browse)

NOTE. The instrument looks for decode symbol table files in the C:\Users\[Username]\Tek-
tronix\TekScope\BusDecodeTables directory.

Behavior

The instrument searches for the numeric value in the symbol table file and displays the corresponding
symbol. For example, you might define a numeric value to display as RESET. If the instrument does not
find a symbol assigned to a numeric value, the numeric value displays.

What do you want to do next?

B Learn about the symbol file format. (see page 158)

B Learn how to find and open a symbol table file. (see page 160)

m  See an example of parallel bus values displayed as symbols. (see page 596)

B Learn about digital setups. (see page 89)

B Learn about bus setups. (see page 97)

®m  [earn more about bus configuration. (see page 151)

Symbol file format

158

NOTE. Symbol tables are only available when a parallel bus is selected.

The instrument requires a specific format to be compatible with the instrument reader. The instrument uses
a format called TSF, which is the TLA Symbol Format used with Tektronix logic analyzers.

The file extension is .tsf. You can use any text editor to create the file.

The file contains a TSF header line and lines to define the symbol names and values. White space (blank
spaces or tabs) separates fields on a line. The first few lines of a file are typically comment lines to
describe the file.
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All lines in the file that begin with a number sign (#) character are treated as comments, unless the very
next character is a plus sign (+). The plus sign signifies a reader directive. The number sign character can
also initiate a comment on the end of a symbol definition. All text between the number sign and the end
of the line is treated as a comment and ignored.

A TSF header identifies the file format version to the reader in the instrument. The header also specifies
that the file contains pattern symbols and the number system radices used to specify symbol values.

The next graphic shows an example of a TSF header in a symbol file. The first few lines are comments
that describe the file and are not required as part of the file header.

After the comment lines (if any), the file must contain the TSF header line that starts with the #+ characters
and the Version number. The Version number contains three fields. The first two fields are the file format
major and minor version numbers. The instrument only reads TSF files where the major and minor version
number of the file is less than or equal to that of the instrument reader. The third field denotes minor
format changes, which do not impact the file reader.

In the header, the Version number is followed by the word PATTERN.

Next in the header are two radix fields: Display and File. The Display Radix field sets the default radix
that will be used to display the numeric symbol value. This field must be HEX, OCT, DEC, or BIN.

The File Radix field specifies the radix used by the symbol values in the file. The File Radix field must
be HEX, OCT, DEC, or BIN.

B Symbol_file.tsf - Notepad

File Edit Format Yiew Help

# Green acres ”
# Proto

#*

#+ version 2.1.0 PATTERN BIM BIM

#*

# Symbol Pattern

#*

HALT 0010

CALL 010

RESET 1000 #Resets when interrupted

You can create symbol names from ASCII with up to 220 characters. The numeric values must reflect

the base specified by the File Radix field. An X represents a “don't care” value. The number of bits
represented by each character depends on the radix. For a HEX value, each character represents 4 bits. For
an OCT value, each character represents 3 bits. For a BIN value, each character represents 1 bit.

NOTE. The order of the symbols in the file is important. The instrument scans the list of pattern symbols
starting from the top of the file and displays the first symbol that matches the bits with numeric values
(not Xs).
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To use
B Create a TSF file with symbols and numeric values.

B Copy the file to the C:\Users\[Username]\Tektronix\TekScope\BusDecodeTables directory on the
instrument.

®  From the Bus Setup window, select the Config tab and select a bus to decode.
® In the Display tab, select the Use Symbol File check box.

B (Click the Browse button to locate the file.

Use Symbol File

v (Browse)

Behavior

The instrument searches for the numeric value in the symbol table file and displays the corresponding
symbol. If the instrument does not find the numeric value, there is no symbol and the numeric value
displays.

What do you want to do next?

B See an example of parallel bus values displayed as symbols. (see page 596)

B Learn how to find and open a symbol table file. (see page 160)

®m  [earn about digital setups. (see page 89)

B Learn about bus setups. (see page 97)

B [earn more about bus configuration. (see page 151)

Opening a bus symbol table file

NOTE. Symbol tables are only available when a parallel bus is selected.

From the Bus Setup window, select the Display tab, and then select the Use Symbol File check box.

To use
1. Click the Browse button to locate the file.
2. Navigate to the file location or select a symbol table file from the dialog box.

3. Click Open.
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Open E'

Look ir: ||.i' BusDecodeT ables j £ -

File narme: || j E Open

Files of type: | Symbal table Files [* tsf] | Cancel

Help

Pl

Behavior

This dialog box opens to the default directory C:\Users\ [Username]\Tektronix\TekScope\Bus-
DecodeTables. If you saved the file in another directory, you need to copy the file to the
C:\Users\[Username]\Tektronix\TekScope\BusDecodeTables directory, where the instrument expects to
find it. When you open a symbol table file, the instrument uses the values to decode and display bus
values to be easier to recognize.

NOTE. The only available file is in TSF format.

What do you want to do next?

® Learn about bus symbol tables. (see page 157)

®  [earn about the format. (see page 158)

B See an example of parallel bus values displayed as symbols. (see page 596)
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Using MagniVu

NOTE. The MagniVu feature is available on MSO5000B models and on DPO5000B models with option
MSOE..

Select MagniVu in one of the following ways:
B Digital menu.
B Horiz/Acq menu.

®m  Horiz/Acq > Horizontal/Acquisition Setup and click Acquisition tab.

Overview

Turn on or turn off MagniVu.

To use

Select MagniVu to increase the resolution.

Behavior

MagniVu gives you higher resolution to accurately determine edge placement. This helps you make
precise timing measurements on digital edges. You can see up to 32 times more detail than with normal
digital channel sampling. The MagniVu record is acquired in parallel to the main digital acquisition and is
available at any time, running or stopped. MagniVu provides an ultra high resolution view of your data
sampled at a maximum resolution of 60.6 ps for 10,000 points centered around the trigger.
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With MagniVu option disabled:

File | Edit | Vertical | Digital | HorizlAcg | Trig | Display | Cursors | Measure | Mask | Math | MyScope | Analyze | Utilities | Help ln

J11DsI MR ARAAN QAR A0 100 i - nnnm- i
(on)11on1|| FIL AT AU LI ' [N UL

& /S o.ov 1.0ps/div  10.0GS/s 100ps/pt
|_None Auto || Preview
0 acqgs RL:100k
D15-D0 IT Time Res: 2.0ns/pt
Man October 01, 2010 03:55:29
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With MagniVu option enabled (the Sample Rate and Resolution values set):

File | Edit | Vertical | Digital | Horizldcg | Trg | Display | Cursors | Measure | Mask | Math | MyScope | Analyze | Utilities | Help 'n

e _/o.ov 50.0ns/div 10.0GS/s IT 5.0ps/pt
|_None Auto |
13 acqgs RL:100k
D15-D0 IT MagniVu: 60
Man October 01, 2010

Horizontal

Mode Sample Rate Sample Rate

ETle [ 50s | [ 165GSis |
. SN

Scale Duration solutio
[ 500ns | 500ns || 6061ps

Automatic

Constant Sample Rate

= Manual

Record Length Length i
100000 (b Foitin
- 50.0%
z_. rFy

NOTE. The MagniVu record must always contain the trigger. If the trigger point is moved prior to the
display region using Horizontal Delay, then the MagniVu record will not be available. In most of these

cases, you can find the digital record by looking for the digital signal in the upper overview and panning
accordingly.

NOTE. You should turn on MagniVu when light gray shading is displayed to indicate the uncertainty of the
edge position. If the shading is not displayed, you do not need to use MagniVu.
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Display control window (Appearance tab)

From the Display menu, select Display Setup.

Overview

Use the Display General tab controls to change the display style, persistence, intensity, format, and
interpolation.

For information on the controls, click the buttons.

Appear e

Screen Text

NOTE. The following screen appears on MSO/DPO5000B Series instruments.

Display

Appearance

Objects

What do you want to do next?

® Learn about using text with screen displays. (see page 168)

®m  [earn about changing the appearance of objects in the display. (see page 171)
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®m [earn about changing the display colors. (see page 172)

Display control window (Screen Text tab)

168

From the Display menu, select Screen Text, or open the Screen Text tab in the Display control window.

Overview

Use the controls on the Screen Text tab to define text captions that you can add to the instrument display.

To use

You can create up to eight lines of text to provide notes for screen shots, printouts, or for other instrument
users.

Click in a text field, 1 through 8.

Click the Text <1-8> button to turn the message text On or Off on the display.

Click the Font button to open the Font dialog box and change the font properties of the text.
Click the Color button to open the Color dialog box and change the color properties of the text.
Click the Clear button to delete the message text. (Text button must be On)

Click Controls button to open the Text Properties control window (see page 170), where you can define
the positioning of the message on the display.

Behavior

Click on one of the numbered lines and use the pop-up keyboard to enter up to 64 alphanumeric characters
of text per line.
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Click Clear to clear the entire text of the selected line. The screen text that you enter is not related to any
waveform labels that you may have created. The waveform labels help you identify waveforms on the
screen, while the screen text is intended to provide information or notes for screen shots or printouts.

TIP. Position the text on the screen by clicking and dragging the text to the desired location on the graticule.

What do you want to do next?

B [earn about defining screen text properties. (see page 170)

B Learn about changing the overall display appearance. (sec page 167)

®m  Learn about changing the display colors. (see page 172)

B [earn about changing the appearance of objects in the display. (see page 171)
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Text properties control window

170

From the Display menu, select Display Setup; then open the Screen Text tab and click the Controls button.

Overview

Use the Text Properties control window to position text to specific locations on the graticule.

Text Properties W o
Screen Text

To use

Select the line of text from the Screen Text drop-down list; then use the X Pos and Y Pos controls to define
the location of the text on the graticule.

Behavior

The text from the drop-down list is the text you defined under the Screen Text tab of the Display control
window.

The units for the position controls are in pixels. The minimum values are 1 for both X and Y positions.
The maximum X value is 450; the maximum Y value is 390. The origin of the X position is the left vertical
graticule boundary, while the origin of the Y position is the upper horizontal graticule boundary.

Setup opens the Display control window with the Screen Text tab selected. Click Setup to enter new
lines of text.

TIP. You can also position the text on the screen by clicking and dragging it to the desired location.

What do you want to do next?

Learn about using text with screen displays. (see page 168)

Learn about changing the overall display appearance. (see page 167)

Learn about changing the appearance of objects in the display. (see page 171)

Learn about changing the display colors. (see page 172)
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Display control window (Objects tab)

From the Display menu, select Objects, or open the Objects tab in the Display control window.

Overview
Use the Objects tab controls to change the appearance of objects on the oscilloscope display.

For information on the controls, click the buttons.

Appearance

Screen Text

Objects

Colors

To use
B  Click the Date/Time button to show the current date and time on the graticule.

B Click the Trigger T (see page 172) button to turn this display marker on and off.

What do you want to do next?

B Learn about changing the overall display appearance. (see page 167)

B [earn about changing the display colors. (see page 172)

m Learn about using text with screen displays. (see page 168)
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Trigger T marker

m
=
-

PR R R = |;'irl-h

Display control window (Colors tab)

From the Display menu, select Colors, or open the Colors tab in the Display control window.

Overview

Use the controls on the Colors tab to change waveform color palettes. You can define colors for the
live, math, and reference waveforms.

If you are using Waveform Database acquisition mode, select the FastAcq/WfmDB Palette. For all other
acquisition modes, use the Record View Palette.

For information on the controls, click the buttons.

Display
Record View Palette

[ 'f_‘ Normal Temp

What do you want to do next?

B [ ecarn about changing the overall display appearance. (see page 167)

B earn about changing the appearance of objects in the display. (see page 171)

172 MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series



Display setups Display persistence

B Learn about using text with screen displays. (see page 168)

Display persistence

From the Display menu, select Display Setup; then open the Appearance tab.

To use

Click one of the buttons to select the display persistence.

B Click Infinite (persistence) to continuously accumulate record points on the waveform until you
change one of the acquisition display settings.
B Click Variable; then click in the Time entry box and use the multipurpose knobs to set the persistence
time.
B Click Reset to clear the persistence.
m  Click the Controls to activate the Persistence Control window.
Persistence
Off Variahle
Infinite Reset
Controls
Behavior
B Use infinite persistence for displaying record points that may occur outside the normal acquisition
envelope.
®m  Use Variable to accumulate record points on the waveform for a specified time interval. Each record
point decays independently according to the time interval.
B [fyou click Off, the waveform record points appear for the current acquisition only.

TIP. Use the Display menu Display Persistence submenu or right-click in the graticule and select Display
Persistence from the shortcut menu to directly access the persistence options.

What do you want to do next?

B [earn about changing the display colors. (see page 172)
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® Learn about using text with screen displays. (see page 168)

B Learn about changing the appearance of objects in the display. (see page 171)

Select the display format

From the Display menu, select Display Setup; then open the Appearance tab.

To use

Click one of the buttons to select the display format.

Behavior

YT format is the conventional oscilloscope format:
B Amplitude appears on the vertical axis as the signal varies over time on the horizontal axis.

B When you set the vertical position to center the display in YT format, the XY display is at center
screen, and each division of display in YT mode produces a division of display in XY mode.

XY format plots the amplitude of one waveform against the amplitude of another waveform on a
point-by-point basis:

®  This format is useful for showing the relationship between two signals, such as current and voltage
waveforms that combine to form an -V characteristic.

B When using this format, waveforms appear according to their channel pairings (see page 175). XY
format is a dot-only display, although it can have persistence.

m  The Vector style selection has no affect when you using XY format.

B When using this format, the horizontal scale continues to control the time base and the horizontal
position continues to control the portion of the waveform that is shown.

B Vectors and Intensified Samples (see page 813) selections are not available when using the XY
Display Format.
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XYZ format compares the voltage levels of the X and Y channel waveform records point-by-point, as in
XY format. The displayed waveform intensity is modulated by the Z channel waveform record. Refer to
the table below for channel assignments.

X-Axis input Y-Axis input Z-Axis input
Ch1 Ch2 Ch3

A -5.0 division signal, including position and offset, on the Z channel produces a blank screen; a
+5.0 division signal produces full intensity.

NOTE. Selecting YT or XY only affects the display. The Horizontal, Vertical, and Position knobs (and
menus) control the same parameters except in the Fast. Acquisition XY format where the horizontal
scale setting is not used.

TIP. Use the Display menu Display Format submenu to directly access the format types.

What do you want to do next?

B Learn about changing the display colors. (see page 172)

®m  Learn about using text with screen displays. (see page 168)

B [earn about changing the appearance of objects in the display. (see page 171)

XY format pairs

When you use the XY display format, channel and reference waveforms are assigned to the axis
indicated in the following table.

XY Pair X Axis Y Axis
Ch1and Ch2 Ch1 Ch 2
Ch3and Ch 4 Ch3 Ch4
Ref 1 and Ref 2 Ref 1 Ref 2
Ref 3 and Ref 4 Ref 3 Ref 4

If you only display one source when you enter the XY format, the instrument automatically turns on
the other source waveform to complete the XY pair.

NOTE. You cannot display math waveforms in XY format. You cannot display logic waveforms
in XY or XYZ format.
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Set the waveform intensity

From the Display menu, select Display Setup; then open the Appearance tab.

To use

m  (Click in the Record View entry box and use a multipurpose knob to adjust the intensity of live
waveforms, except when using Fast Acquisition or Waveform Database acquisition mode.

Record View

5%

B (Click in the FastAcq/WfmDB entry box and use a multipurpose knob to adjust the intensity of live
waveforms when using Fast Acquisition or Waveform Database acquisition mode.

FastAcq /WImDB

5%

NOTE. Backlight control option is available only on MSO/DPO5000B and DPO7000C Series instruments.

®m  (Click in the Backlight list box and use the multipurpose knob to adjust the intensity of the backlight
to the required option.

Backlight
Low L
bdedium
High

What do you want to do next?

® Learn about using text with screen displays. (see page 168)

B earn about changing the appearance of objects in the display. (see page 171)

®m [earn about changing the display colors. (see page 172)

Select the waveform interpolation

From the Display menu, select Display Setup; then open the General tab.
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To use

Click one of the buttons to select the interpolation that best displays the waveforms. Interpolation globally
affects all displayed waveforms.

IETpalation

—
-—

Behavior

The instrument interpolates waveforms in Zoom mode when there is less than one sample for each pixel
column. These functions are performed on the acquired data as compared to the displayed data.

Click Sin(x)/x to compute record points along a curve between the actual acquired samples. This form
of interpolation is useful when acquiring rounded waveforms such as sine waves. It is good for
general-purpose uses but may introduce overshoot or undershoot in signals with fast rise times. This
interpolation is also useful for looking at high-frequency signals, especially where the frequency
components are just below the Nyquist frequency (see page 177).

Click Linear to compute record points between actual acquired samples using a straight-line fit. This
interpolation is useful for measuring waveforms with fast rise times, such as pulse trains.

TIP. Use the Display menu Waveform Interpolation submenu to directly access the interpolation options.
You may want to set the display style so that the real samples are intensified and interpolated samples
are dimmed.

What do you want to do next?

Learn about using text with screen displays. (see page 168)

Learn about changing the appearance of objects in the display. (see page 171)

Learn about changing the display colors. (see page 172)

Nyquist frequency

The highest frequency that any digital oscilloscope can measure without errors is one-half of the
sample rate or frequency. This frequency is called the Nyquist frequency.

The FFT waveform displays the input signal frequency components from DC (0 Hz) to the Nyquist
frequency.
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Select the graticule style

178

From the Display menu, select Objects, or open the Objects tab in the Display control window.

To use

Click one of the buttons to select the graticule (display grid) style.

Graticule Style

Full Frame

&

Cross Hair IRE

Grid mV

(m) (=)

Behavior

Full provides a grid, cross hairs, and frame on the instrument display. Use Full to make quick
estimates of waveform parameters.

Cross Hair shows cross hairs and a frame on the instrument display. This style is useful for making
quick estimates of waveforms while leaving more room on the display for automatic readouts and
other data.

Grid shows a frame and a grid on the instrument display. This style is useful for making quick,
full-screen measurements with cursors and automatic readouts when cross hairs are not needed.

Frame shows only a frame on the instrument display. This style is useful with automatic readouts
and other screen text when other display features are not needed.

Use IRE if you are working with NTSC video signals. The instrument sets the graticule to
accommodate the vertical position and scale of the signal.

Use mV if you are working with video signals other than NTSC. The instrument sets the graticule to
accommodate the vertical position and scale of the signal.

Solid is similar to Full, but the grid, cross hairs, and frame are drawn using solid lines.

TIP. Use the Display menu Graticule Style submenu to directly access the graticule style options.

What do you want to do next?

B [ earn about changing the overall display appearance. (see page 167)
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®m  Learn about changing the display colors. (see page 172)

B Learn about using text with screen displays. (see page 168)

Define the color palette

From the Display menu, select Colors, or open the Colors tab in the Display control window.

To use

Click the buttons to define the color for displayed waveforms.

Use the buttons under FastAcq/WfmDB Palette to define the color for live waveforms when using
Waveform Database acquisition mode.

For some models, click the Edit button to activate the Display Palette (see page 670), where you can
customize a waveform color.

TIP. Use the Display menu Record View Palette or the WfmDB Palette submenu to directly access the
color palettes.

Behavior

Click Normal to define hues and lightness levels for best overall viewing. The color of each channel
waveform matches the color of the corresponding front-panel vertical SCALE knob.

Click Spectral (Spectral Grading) to define areas of the waveform with the highest sample density
appear in blue shades while the areas of lowest sample density appear in red shades.

Click Temp (Temperature Grading) to define areas of the waveform with the highest sample density
appear in warmer colors (red shades) while the areas of lowest sample density appear in cooler
colors (blue shades).
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B (Click Gray (Monochrome Gray) to define waveforms in shades of gray. Areas of the waveform with
the highest sample density appear in lighter gray shades while the areas of lowest sample density
appear in darker gray shades.

B Click Green (Monochrome Green) to define waveforms in shades of green. Areas of the waveform
with the highest sample density appear in lighter green shades while the areas of lowest sample
density appear in darker green shades.

B Click User to display a color that you have previously defined with the User Palette.

TIP. The Green palette simulates the display of an analog oscilloscope.

What do you want to do next?

B [ earn about changing the overall display appearance. (see page 167)

m earn about changing the appearance of objects in the display. (see page 171)

B Learn about using text with screen displays. (see page 168)

Remote operation

Remote desktop connection

You can find the network setup program in the Windows Start menu. Either select All Programs >
Accessories > Remote Desktop Connection, or select Programs > Accessories > Communications >
Remote Desktop Connection.
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Horizontal/Acquisition control window (Horizontal tab)

From the Horiz/Acq menu, select Horizontal/Acquisition Setup; then open the Horizontal tab.

Overview

The Horizontal control window manages the horizontal parameters of waveforms. The controls in the
Horizontal tab are common to all channels.

Use the Horizontal tab to set up the horizontal mode and to adjust the horizontal scale. Normally, the
horizontal axis displays time information. However, in some cases, the horizontal axis can represent
frequency rather than time.

For information on the controls, click the buttons.

In the following two screens, Digital Sample Rate, Digital Resolution, and Digital Record Length only
appear on MSO series instrument.

Horizontal

H " t l u .. .
| 50.0GS/s L]
Acquisition | © L ;

nri_zunta]

orizonta | T
S Automatic

Position

50.0%

What do you want to do next?

B Learn more about the Horizontal Setup controls. (see page 902)
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B Learn about the Acquisition Setup controls (see page 185)

Set Record Length Limit

182

From the Horiz /Acq menu, select Horizontal/Acquisition Setup; then click Record Length Limit.

To use
B Use the Record Length Limit entry box to set the maximum record length.
m  Use the Max button to set the record length limit to its maximum value.

B Use the Min button to set the record length limit to its maximum value.

“SetRecordlengtiimt R
100000

To increase the update rate, lower the record length limit. To enable higher sample rates or digital filtering
at slower horizontal scales, increase the record length limit.

What do you want to do next?

B [earn more about the Horizontal Setup controls. (see page 902)

B earn about the Acquisition Setup controls. (see page 185)
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Horizontal digital control window

NOTE. The Horizontal Digital control window is only available when a parallel bus is selected on MSO
models and on DPO5000B models with option MSOE installed, and DPO70000DX instruments with
option MSOU installed.

From the Horiz /Acq menu, you can view the Digital Sample Rate and Digital Resolution of logic
waveforms. The values track the sample rate and resolution of the analog system.

To use
B Use the Sample Rate and Scale entry boxes to set the Digital Sample Rate and the Digital Resolution.

The following screen is captured on MSO70000C/DX Series instruments:

The following screen is captured on MSO/DPOS5000B Series instruments:

What do you want to do next?

B [earn more about the Horizontal Setup controls. (see page 902)

B Learn about the Acquisition Setup controls. (see page 185)
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Horizontal Position/Scale control window

From the Horiz /Acq menu, select Position/Scale.

Overview
Use the Horizontal control window to set the horizontal position and scale of displayed waveforms.

For information on the controls, click the buttons.

ll-lumnul

To use

m  (Click the Delay Mode button to toggle the horizontal delay on (see page 185).

Behavior

You can use this control window to turn on horizontal delay so the acquisition window can be focused on
events that occur at a fixed delay after the trigger point.

NOTE. The dedicated Horizontal controls on the front panel also perform the same functions.

What do you want to do next?

B Learn more about the Horizontal Position controls. (see page 834)

m  [earn more about the Horizontal Scale controls. (see page 835)

B Learn more about the Horizontal Delay Mode. (see page 834)

B Learn more about the Horizontal controls. (see page 198)
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Horizontal Position/Scale control window: delay mode on

From the Horiz /Acq menu, select Position/Scale.

Overview

Use the Horizontal control window to set the horizontal delay and the horizontal scale of the displayed
waveforms when the horizontal delay is on.

For information on the controls, click the buttons.

Harizental

To use

®H  Click the Delay Mode button to toggle the horizontal delay on or off.

Behavior

You can use this control window to turn on horizontal delay so the acquisition window can be focused on
events that occur at a fixed delay after the trigger point.

NOTE. The dedicated Horizontal controls on the front panel also perform the same functions.

What do you want to do next?

®  Learn more about the Horizontal Delay Mode. (see page 836)

B Learn more about the Horizontal Scale controls. (see page 837)

B [earn more about the Horizontal controls. (see page 198)

Horizontal/Acquisition control window (Acquisition tab)

From the Horiz /Acq menu, select Horizontal/Acquisition Setup; then open the Acquisition tab.
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186

Overview

Use the Acquisition tab to set the acquisition parameters for all live waveforms. The Acquisition controls
are common to all channels. This means that you cannot acquire in Sample mode on channel 1 while
channel 2 acquires in Envelope mode.

To use

For information on the controls, click the buttons.

Horizontal

Acquisition

Hompontad

A cpasition

The following screen appears on MSO/DPO5000B Series instruments:
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Behavior

Acquisition is the process of sampling the analog input signal, digitizing the signal to convert it into digital
data, and then assembling the signal information into a waveform record. The instrument creates a digital
representation of the input signal by sampling the voltage level of the signal at regular time intervals. The
sampled and digitized points are stored in memory along with the corresponding timing information. The
instrument uses the digital representation of the signal for display, measurements, or for further processing.

Use the controls on this tab to define the sampling method, the acquisition mode, turn Fast Acquisitions on
or off, and activate an external reference.

On MSO5000B models and DPO5000B models with option MSOE, you can turn on or turn off MagniVu.
What do you want to do next?

®  [earn about Acquisition modes. (see page 838)

m  Learn about MagniVu. (see page 163)

Autoset

From the Horiz/Acq menu, select Autoset or push the front panel Autoset button.

Overview

Use Autoset to automatically set up the front-panel controls based on the characteristics of the input signal.
This is much faster and easier than manually setting up the controls.

Autoset

O

Autoset may change the vertical position to place the waveform appropriately on screen. The instrument
always sets vertical offset to 0 V.

To use

If you use Autoset when one or more channels are displayed, the instrument selects the lowest numbered
channel for horizontal scaling and triggering. The instrument individually scales all displayed vertical
channels. If you use Autoset with no vertical channels displayed, the instrument turns on and scales
channel 1.

The Autoset Undo (see page 189) button opens in a control window after the instrument completes the
operation. Click this button to undo only the parameters adjusted by the last Autoset.
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188

Autoset

NOTE. The Autoset Undo control window remains on the screen until you open another control window.
After Autoset Undo closes, you can still undo the last Autoset by selecting the Undo Last Autoset command
from the Edit menu or the Horiz/Acq menu. Although the last Autoset is immediately undone, the Autoset

Undo control window does not open again.

m  Select User Preferences from the Utilities menu to display the Prompt Before Action (see page 559)

window.

B Click Autoset to toggle between Off and On. Off immediately performs an Autoset when the Autoset
button is pushed. On displays a prompt when the Autoset button is pushed.

B (Click Close to save your selection.

The following table lists the Autoset default settings.

Control

Changed by Autoset to

Selected Channel

Last channel selected

Acquisition Mode Sample

Run/Stop Run

Deskew, Channel/Probe Unchanged

Display Style Vectors

Display Intensity-Record View If less than 50%, set to 75%

Display Format YT

Horizontal Position Centered within the graticule window
Graticule Setting Unchanged

Horizontal Scale

As determined by the signal frequency, or 100 ps/div

Record Length and Sample Rate

When a new time per division is calculated, the sample rate
changes to maintain the current record length. If the sample
rate cannot be changed because of hardware limitations,
the sample rate is set to maximum while the record length is
reduced to maintain the time per division.

Trigger Position Delay Off
Trigger A >B Sequence A Only
Main Trigger Type Edge

Trigger Source

Numerically lowest displayed channel (the selected channel)

Trigger Level 50% of selected channel amplitude
Trigger Slope Positive

Trigger Coupling DC

Trigger Holdoff Minimum setting

Vertical Scale As determined by the signal level

Vertical Position

As determined by the number of active channels

Vertical Coupling

DC unless AC was previously set. AC remains unchanged.

Vertical Bandwidth

Full
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Control Changed by Autoset to
Vertical Offset 0 volts
Zoom Off

Set Autoset preferences

From the Utilities menu, select User Preferences and the Prompts tab.

Overview

You can set the instrument to display a prompt asking you to confirm the requested action before applying
the Autoset function.

To use

Select User Preferences from the Utilities menu to display the Prompt Before Action (see page 559)
window.

B Click Autoset to toggle between Off and On. Off immediately performs an Autoset when the Autoset
button is pushed. On displays a prompt when the Autoset button is pushed.

B Click Close to save your selection.

Undo an autoset

Press Autoset on the instrument front panel to undo the last autoset operation.

Overview

The Autoset Undo window opens automatically following an autoset. Use this control to undo the last
autoset operation.

o return to pres nztrument
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To use

®  Click Undo. Only the parameters set by the last autoset are undone. The settings you have changed
since the last autoset (that are not controlled by Autoset) remain unchanged.

B Click OK to close the window and proceed without an Undo.

Behavior

The Autoset Undo window remains open until you click Undo or OK. After the Autoset Undo window
closes, you can still undo the last autoset by selecting Undo Last Autoset from the Edit or Horiz/Acq
menus; the last autoset is immediately undone but the Autoset Undo control window does not open again.

To suppress the AutoSet Undo window following an autoset, do the following:

1. From the Utilities menu, select User Preferences.

2. Open the Prompts tab.

3. Under Prompt user before performing requested action, toggle the Autoset Undo button to Off.
What do you want to do next?

B Learn about Autoset. (see page 189)

Enable enhanced effective number of bits

From the Horiz /Acq menu, select Horizontal/Acquisition Setup, and then select the Acquisition tab.

Overview

Use this control to turn the Enhanced Effective Number of Bits (ENOB) on or off to optimize waveform
detail.

Enhanced Effective :.-.@/l
Number of Bits (ENOB)
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To use

1. Click the Enhanced Effective Number of Bits check box to turn ENOB On or Off. You will find this
control in the Acquisitions tab of the Horizontal/Acquisition control window (see page 185),

Behavior

Enhanced Effective Number of Bits enables interleave correction DSP that improves the effective number
of bits. This control is only available in some instrument models. This control is not available in Hi
Res mode.

When Enhanced Effective Number of Bits is enabled, EB+ is displayed in the horizontal/acquisition
readout.

Enable fast acquisitions

From the Horiz /Acq menu, select Fast Acquisitions, or press the front panel Fast/Acq button.

Overview

Use these controls to turn the Fast Acquisition feature on or off and to optimize waveform detail.

To use

1. Click the Fast Acq button to turn Fast Acquisitions On or Off. You will also find this control in the
Acquisitions tab of the Horizontal/Acquisition control window (see page 185),

2. Click the option boxes to optimize acquisitions for your measurement: Capturing Details with Higher
Sample Rate enhances waveforms detail, Capturing Rare Events with More acquisitions provides
the fastest update rate.

NOTE. The options Capturing Details with higher sample rate and Capturing rare events with more
acquisitions are not available on MSO/DPO5000B Series instruments.
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Behavior

Fast Acquisitions mode keeps the dead time (see page 192) between acquisitions very short. This improves
the chances of acquiring infrequent events. When Fast Acquisitions are turned on, the front-panel FastAcq
button is lighted.

If Fast Acquisitions mode is on and you attempt to activate a feature that conflicts with this mode, Fast
Acquisitions mode will be inhibited. When the conflicting feature is turned off, in most cases, Fast
Acquisitions will resume.

What do you want to do next?

B Learn about Roll mode. (see page 193)

Dead time

Dead time is the time that the instrument requires to process an acquisition.

JUH e ac Tt

LS 1
L

Cead timne

The instrument cannot acquire any new data until the previous data has been processed. If dead time
is long, the instrument can miss acquiring infrequent events.

Start and stop waveform acquisitions

192

From the Horiz /Acq menu, select Run/Stop.

Overview

Use the Run/Stop control window to start and stop waveform acquisition.

Runi/Stop - oo e
| = = S K

To use
m  Click Run/Stop to toggle waveform acquisition. (You can also press the front panel Run/Stop button.)
m  Click Single Sequence to complete a single acquisition sequence.

B Click Force Trigger to immediately start acquiring waveform data without a valid trigger event.
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Behavior

These controls operate identically to the front-panel controls.

Click Run/Stop once to stop waveform acquisition. The Status readout at the top of the graticule
changes from Running to Stopped and shows the number of acquisitions. Click Run/Stop again to
resume waveform acquisition.

Click Single Sequence to provide a single sequence of acquisitions each time you click the button.
When Single Sequence is enabled, the front-panel single sequence (Single) button is lighted.

In Sample, Peak Detect, or Hi Res acquisition modes, the instrument acquires waveform records with
the first valid trigger event and then stops. In Average or Envelope acquisition modes, the instrument
makes the specified number of acquisitions to complete the averaging or enveloping task.

In Waveform Database mode, the instrument acquires and displays a waveform that is the
accumulation of several acquisitions. In addition to time and amplitude, the waveform displays a count
of the number of times a specific sample point has been acquired.

When you click Single Sequence (or press the Single button) in Equivalent Time mode, the instrument
continues to recognize trigger events and acquires samples until the waveform record is filled.

Click Force Trigger once to acquire a waveform record without a trigger event. Forcing a trigger is
useful when the input signal does not contain a valid trigger. The instrument recognizes and acts
upon the forced trigger even when you click the button before the end of the pretrigger holdoff. The
button has no effect when acquisitions are stopped.

What do you want to do next?

B Go to the Horizontal/Acquisition control window. (see page 181)

B Return to the Acquisition Setup control window. (see page 185)

®  Return to the Trigger Setup control window. (see page 393)

Enable Roll mode

From the Horiz /Acq menu, select Roll Mode Auto, or click Roll Mode in the Acquisition tab of the
Horizontal/Acquisition control window (see page 185).

Overview

Use these controls to turn Roll Mode on or off.
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JIOK

Roll mode lets you see acquired data without waiting for the acquisition of a complete waveform record.
It gives you immediate feedback. For slow time base settings, Roll mode provides a rolling display
similar to a strip-chart recorder.

To use

B The resolution appears near the lower-right corner of the graticule and is controlled by the Resolution
knob.

®  Use Untriggered Roll Mode to continuously observe a slow process. Apply math and measurement
operations after you stop the acquisition.

B When Roll mode is on, the Acquisition Status Indicator Readout displays Roll.

Behavior

When using Roll mode, you do not have to wait for slow acquisitions to fill the display. When Roll mode
is enabled, the instrument displays newly acquired data points at the right edge of the display while
moving the older waveform data points to the left.

Using single sequence with roll mode causes the acquisition to automatically stop after a complete
waveform record is acquired. Roll mode is useful when observing a slow process where you always want
to see the most recent view of that process. Roll mode with single sequence is useful to save data for later
viewing. For example, at 20 seconds per division and 30 K record length, there are 12,000 seconds

of acquired data points.

The maximum record length where Roll mode is allowed is 10 M.
What do you want to do next?

®  Learn how Roll mode interacts with other instrument settings. (see page 847)

® Learn about Equivalent Time mode. (see page 194)

Select a sampling mode

From the Horiz /Acq menu, select Sampling Modes, or select a sampling Mode in the Acquisition tab of
the Horizontal/Acquisition control window (see page 185).
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To use

To enable a sampling mode, click one of the Sampling Modes button.

Samgling Modes
Haal Time

@
o)
&

®  In Real Time, the instrument acquires all the points in a waveform record after one trigger event.

®  In Interpolated time, the instrument interpolates between the samples it acquires when it cannot acquire
all the real samples it needs to fill up its waveform record after one trigger event. The instrument can
interpolate either as part of an acquisition or as part of the zoom/display behavior.

®  [n Equivalent time, the instrument uses multiple trigger events to fill all the points in its waveform
record. Equivalent time sampling begins when the time base setting (horizontal scale) is too fast for
the instrument to acquire all the points in a waveform in one trigger event.

NOTE. In real-time sampling, the instrument digitizes all of the points it acquires after one trigger event.
Always use real-time or interpolated sampling to capture single-shot or transient events.

Behavior

Equivalent Time mode lets you accurately acquire repetitive waveforms at sample rates much higher than
the base analog-to-digital converter sample rate. Equivalent time sampling is generally not useful for
acquiring time-varying, random, or single-shot events.

The instrument takes a few samples with each trigger event and eventually obtains enough samples to
construct a waveform record. The instrument takes samples independent of the trigger position and
displays them based on the time difference between the sample and the trigger. You should only use
Equivalent Time mode on repetitive signals.
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Record Points —O—I—/._._._._._._\O—Q—

1st Acquisition Cycle J-I n n

2nd Acquisition Cycle I'I |-|

Jrd Acquisition Cycle I I rL

mth Acquisition Cycle n n

The sampling speeds and the number of channels you choose affect the mode the instrument uses to
sample waveforms. The instrument always uses real-time sampling at slower time base settings; faster
time settings force the instrument to switch from real-time sampling to equivalent-time sampling.

The following tables show the time base setting(s) at which the switch from real-time sampling (RT) to
equivalent-time sampling (ET) occurs for your instrument.

Sampling mode selection DPO7354C, DPO7254C, and DPO7104C with Option 2SR

Channels on 1 2 Jord
Time base 2100 ps/pt RT RT RT

50 ps/pt RT RT ET
25 ps/pt RT ET ET
<25 ps/pt ET ET ET
Sampling mode selection DPO7104C, and DPO7054C

Channels on 1 2 dord
Time base=200 ps/pt RT RT RT
100 ps/pt RT RT ET

50 ps/pt RT ET ET
<50 ps/pt ET ET ET
Sampling mode selection DPO7054C

Channels on 1 2 Jord
Time base=400 ps/pt RT RT RT
200 ps/pt RT RT ET
100 ps/pt RT ET ET
<100 ps/pt ET ET ET
Sampling mode selection MSO70000C/DX and DPO70000C/DX

Channels on 1 2 dord
Time base=40 ps/pt RT RT RT
<20 ps/pt ETNT ET/NT ETNT
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Sampling mode selection MSO/DP05054B and MSO/DP05034B

Channels on 1 2 3ord
Time base 220 ns/div RT ET RT

10 ns/div ETNT ETIT ETNT
Sampling mode selection MSO/DP05204B and MSO/DP05104B

Channels on 1 2 3ord
Time base 220 ns/div RT RT RT

10 ns/div RT RT ET
<5 ns/div ETNT ETNT ETNT

The type of equivalent-time sampling the instrument uses is called random equivalent-time sampling.
Although it takes the samples sequentially in time, it takes them randomly with respect to the trigger.
Random sampling occurs because the instrument sample clock runs asynchronously with respect to the
input signal and the signal trigger. The instrument takes samples independently of the trigger position and
displays them based on the time difference between the sample and the trigger.

What do you want to do next?

®  Go to the Horizontal Setup control window. (see page 181)

B Return to the Acquisition Setup control window. (see page 185)
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Set the resolution

From the Horiz /Acq menu, select Resolution.

Overview

Use the Resolution control window to select the number of samples per division for all acquired waveforms.
Resalution
[Dnratinn Sample Hate Resalution Record Length

To use

Click in the Record Length control box and use the multipurpose knob or keypad to change the setting.

Behavior

The Duration, Sample Rate, and Resolution controls are readouts only. Their settings are impacted by
other controls.

B Duration specifies the time across the 10-division screen.

®  Sample Rate specifies the number of samples per second that will be acquired for each waveform. The
faster the sample rate, the more accurately the instrument can represent fine details in a fast signal.

B Resolution is similar to the acquisition interval. It can be thought of as the time between sample points.
In most cases, the acquisition interval is the same as the resolution.

B Record Length specifies the total number of samples in the waveform acquisition. The maximum
record length depends on the amount of memory in the instrument. Because the instrument can only
store a finite number of waveform data points, there is a trade-off between the waveform details and
the record length. You can acquire either a detailed picture of a waveform for a shorter period of time
or a less detailed picture for a longer period of time.

What do you want to do next?

®  Learn about the Horizontal Setup control window. (see page 181)

B Learn about the Acquisition Setup control window. (see page 185)

Select the acquisition mode

From the Horiz /Acq menu, highlight Acquisition Mode; then select Mode.
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Overview

The acquisition mode determines how the waveform data points are produced from the sampled data.

Acguisition Samgile Pk Darbect Hifes

=)

To use
Select the acquisition mode by clicking the appropriate button.

B If you use Average or Envelope mode, select the number of waveforms for that mode using the
multipurpose knob.

B Ifyou use Waveform Database mode, select the number of samples using the multipurpose knob.

Behavior

A single waveform data point can be made up of several sequentially acquired data points. The waveform
data points can also be created from a composite of sampled data taken from multiple acquisitions.

= Sample mode acquisition creates a record point by saving one or more samples during each acquisition
interval (see page 200). Sample mode is the default acquisition mode. The instrument does no post
processing of the acquired samples in this mode.

m Pk Detect (Peak Detect) acquisition alternates between saving the highest sample in one acquisition
interval and the lowest sample in the next acquisition interval. Peak Detect mode only works with
real-time, noninterpolated sampling.

®  Hi Res (High Resolution) acquisition averages all samples taken during an acquisition interval to
create a record point. This average results in a higher-resolution, lower-bandwidth waveform. This
mode only works with real-time, noninterpolated sampling.

®  Envelope acquisition acquires and displays a waveform record that shows the extremes in variations
over several acquisitions. The instrument saves the highest and lowest values in two adjacent intervals
similar to the Peak Detect mode. Unlike Peak Detect mode, the peaks are gathered over many trigger
events.

®m  Average acquisition acquires and displays a waveform record that is the average result of several
acquisitions. This mode reduces random noise. Use the multipurpose knob to specify the number of
waveforms that you want to average.

After each trigger event, the instrument acquires data and then compares the minimum and maximum
values from the current acquisition with those stored from the previous acquisition. The final display
shows the most extreme values for all the acquisitions for each point in the waveform record.

B WfmDB (Waveform Database) acquisition acquires and displays a waveform that is the accumulation
of several acquisitions. In addition to time and amplitude, the waveform displays a count of the
number of times a specific sample point has been acquired. The value at each point on the waveform is
a counter that reflects the hit intensity. The instrument acquires data after each trigger event using
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Sample mode. It then determines the location of each sample point and accumulates it with shared data
from previous acquisitions. This is the only mode that can be used when doing mask testing with a
optical standard. Fast Acq is inhibited in Waveform Database mode.

What do you want to do next?

B Learn about the Horizontal Setup control window. (see page 181)

B Learn about the Acquisition Setup control window. (see page 185)

Acquisition interval

The acquisition interval is the time between sample points. For mathematical purposes, it is the time
covered by the waveform record divided by the record length.

FastFrame control windows

200

From the Horiz /Acq menu, select FastFrame Setup.

Overview

Use the FastFrame control windows to capture and view a series of triggered acquisitions without wasting
acquisition memory on the dead time (see page 192) between the trigger events.

For information on the controls, click the buttons.

Behavior

FastFrame mode combines multiple acquisitions into one large data record. By carefully defining the
trigger conditions, you can use FastFrame to capture only multiple events (see page 201) of the waveform
that you are interested in. Each captured event is stored sequentially in its own frame (see page 881).
The frames are in the order they were captured.
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FastFrame mode lets you jump to and view the desired frame. Time Stamps can display the absolute
trigger time for a specific frame and the relative time between triggers of two specified frames. FastFrame
lets you compare different waveforms. Math is performed on each frame.

FastFrame provides the following features:

Measure time between triggered acquisitions using time stamps (see page 202) in Sample, Peak
Detect, and Hi Res mode.

Save and recall FastFrame waveforms.

Display waveforms in YT mode.

Apply math functions to FastFrame waveforms.

Confine automatic measurements only to the displayed frame.

Overlay multiple frames for easy comparison.

FastFrame is not compatible with the following features or modes:

Equivalent Time
Histograms

Fast Acquisitions
Average

Envelope

What do you want to do next?

Learn about the frame setup controls. (see page 916)

Learn more about the Selected Frame controls. (see page 883)

Learn about the reference frame and time stamps. (see page 880)

Learn how to set up the instrument for FastFrame operation. (see page 916)

Learn some tips for using FastFrame. (see page 935)

FastFrame acquisitions

i M-
\ //
rrserame I ] - -
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Time stamps

Time stamps are a convenient way of measuring the time between triggers when using FastFrame.

Set up zoom

202

From the Vertical or Horiz/Acq menu, select Zoom Setup.

Overview

Use these control windows to define the overall settings of the Zoom controls.

_ Zoom 1 Setup

Zoom 3

Lockand |

Scroll

To use

Click the Zoom <1—4> tabs to set up each zoom area. The controls under each tab apply only to that
zoom area. Click the Display On to turn on the display of that area. (MultiView Zoom must also
be turned on to display any of the zoom areas.)

Click in the Zoom Source entry box, and then use the drop-down list to select a source for the zoomed
area.

Click the Show/Hide Waveforms button to open the Show/Hide Waveforms dialog box; here you can
identify waveforms you do not want to display in the selected zoom area.

Click the Zoom button On to turn on Zoom. You can also toggle Zoom on and off with the MultiView
Zoom button on the front panel.

Click the Ch <1-4> entry box, and then use the drop-down list to select which waveform, (Ch <1— 4>,
Math <1-4>, or Ref <1- 4>), the Vertical Position and Factor controls adjust.

Click in the Position and Factor entry boxes, and then use the controls to change the position and
factor (or scale) in the Zoom area. They can be adjusted with the multipurpose knobs. To reset the
Position and Factor controls, click Reset.
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B Click the Graticule Size down arrow and select the size of the Acquisition and Zoom windows from
the drop-down list. Select 80-20 to allocate 80% of the available display for the zoomed graticule
and 20% for the acquisition window. Select 50-50 to allocate half of the available display for the
zoomed graticule and half of the available display for the acquisition window. Select Full to use the
entire display for the zoomed graticule.

B Click the Lock and Scroll tab to scroll the zoomed area(s). To scroll a single zoomed area, select the
zoom area (1-4), and then click an Auto Scroll button. You can also set the scroll speed. To scroll
multiple zoomed areas simultaneously, click Lock, and then click the zoomed areas (1—4) you want to
scroll through. This locks the zoomed areas in their relative horizontal positions.

TIP. Use the Vertical or Horiz/Acq menu Zoom Graticule Size submenu to directly access the Graticule
Split options.

Behavior

Use the Zoom Setup control window to magnify (zoom in on) a waveform without changing the main
acquisition parameters. Use Zoom when you want to temporarily look at details of a waveform.

If the zoom areas are unlocked, the Horizontal Position and Factor controls affect only the selected zoom
area. The Horizontal Position and Factor will affect all zoom areas that are locked together, such that a
change to one zoom area will change the horizontal position and factor of all the locked zoom areas.

On the Vertical Zoom tab, the Scale and Factor controls only affect the selected waveform.
What do you want to do next?

m  Return to the Vertical Setup control window overview. (see page 485)

® Return to the Horizontal Setup control window. (see page 181)
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Use the Serial Error Detector

From the Analyze menu, select Serial Error Detector.

Overview

The Serial Error Detector requires option ERRDT. The oscilloscope Error Detector conducts Bit, Frame,
Symbol, and Character tests much like a BERT. It has the advantage that it not only counts the errors and
computes the error rates, but it also shows you where the error occurs in the signal and it allows you to
connect probes to other channels to debug the source of the errors, such as crosstalk.

The Error Detector is often used in conjunction with TekExpress software applications to conduct receiver
and margin testing.

The Error Detector has built-in preset setups that cover the most common use cases. These can be modified
and saved as custom setup files for later recall. Sample arbitrary waveform generator (AWG) setup files
are included for various SATA Gen3 and USB3 signals. These files make it easy to verify correct operation
of the Error Detector, and may be used to test a device-under-test (DUT).

Serial Error Detector

Preset Setting CUSTOM_SETUP ¥ | [C:\Users\Public\Tektronix\Tek ScopelErr - B

Serial Bus: SATAGEN3  Bit Error Rate:
Bit Error Count:
Bits Tested:

Pattern Name: CJTPat Consecutive Aligns:

Data Rate: Custom

Stop Condition: Manual Stop

Elapsed Time: 0:0:7:0
dd:hh:mm:ss

ance v

To use
B Select Analyze > Serial Error Detector to display the Error Detector control window.
B Select a setup from the Preset Setting drop-down list and press Apply.

B Press the Sync button and wait for a status of Not Counting (about 6 seconds). Depending on the
signal quality, you may need to press the Sync button more than once.

Sync gets the oscilloscope synchronized to the signal.

A status of No Signal indicates that the oscilloscope cannot detect the signal. You may need to turn on
the output of the signal generator or AWG. A status of No Sync may arise for Bit tests that require a
known pattern length, sync pattern, or alignment character.

m  Press the Learn button, if visible. Learn only applies to some Bit Error Tests. Frame, Symbol, and
Character tests do not require the learn operation. Learn discovers the repeating pattern in the signal
and stores it into system memory for comparison to the signal to determine errors in the signal. Once
a signal is in memory, it remains there until the next Learn operation, so you do not have to use the
Learn button every time you start testing for errors.
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B Press the Run button to start the error detector.
If desired, you may press Stop or Reset at anytime. After a Stop, you can press Run again.
Run starts the Error Detector testing for errors.

m  Seclect the Results tab to see the results of running the error detector.

NOTE. The Serial Error Detector automatically resyncs and resets all counts to zero if you press Reset or
disconnect and then reconnect the signal.

If you are using one of the supplied AWG signal patterns, you can press the Force Event button on the
AWG to induce an error in the signal to verify the operation of the Error Detector. These AWG setup
files are located in Win7 in the directory C:\User\Public\Tektronix\Tekscope\ErrorDetector\AWG

Alternatively, you can verify operation by disconnecting and reconnecting the signal. There will be
massive errors when the signal is disconnected, but after the signal is reconnected the Error Detector
will resynchronize to the signal, clear the error counts and rates, and resume testing.

m  Press the Error Detector Off button to end the error detector session. A popup will appear saying the
trigger has changed to Edge.

What do you want to do next?

B Set up the serial error detector. (see page 206)

m Set error detector advanced settings. (see page 209)

B Specify the error detector test pattern. (see page 210)

B Set the error detector stop condition. (see page 211)

Set up the serial error detector

From the Analyze menu, select Serial Error Detector, press Setup, and then select the Source Setup tab.

Overview

If you select the Custom Setup or you select one of the presets, but want to make some changes to its
settings, then you will need to make selections in the Setup tab.

Serial Error Detector

Preset Setting [SATA3_CJTPAT_BIT 2 @ @
'

r1— Serial Bus Source
1) Souce Setip [snrncens v ont v
Data Rate Error Detection

3 | Stop Condition Character

Test Pattern
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To use

B When you select the Custom_Setup, additional controls are put on the display so you can browse
for a setup file. The usual idea is to start with a setup that is close to what you want, use the Ul
to specify the settings you desire, and then save the result. When you enter a new name for the
file in the file name text control, press Enter to have your editing changes accepted. Then select
the Save button to actually save the setup into the file. To recall a setup file, just browse to the
file you want and select Open. The default location for Error Detector setup files in Win7 is
C:\Users\Public\Tektronix\TekScope\ErrorDetector.

B From the Source Setup tab, select the Serial Bus, Data Rate and signal Source from the drop-down
lists.

B Click the Error Detection option button for the type of error you want to detect.
B Press Advanced, to open the Advanced Settings window.

Click Error Detector Data Rates (see page 207) and Error Detector Standards and Buses (see page 207) to
display the data rates, standards and buses supported by the Serial Error Detector.

What do you want to do next?

m  Use the Error Detector. (see page 205)

m_ Set error detector advanced settings. (see page 209)

m_ Specify the error detector test pattern. (see page 210)

B Set the error detector stop condition. (see page 211)

Data Rates Supported by the Error Detector

The range of data rates supported by the serial error detector matches the 8b/10b serial pattern trigger
range. The serial error detector will test 8b/10b-encoded data with following range of data rates: 1.25 to
1.65, 2.0 to 3.25, 3.5 to 5.2, and 5.3 to 6.25 GBaud.

Standards and Buses Supported by the Error Detector

The serial error detector has several presets for industry standards. In addition, there is a generic 8b/10b
preset. Each of these presets configure the error detector for the test types specified by the industry
standard or for the test type that makes sense for the current setup.

The test types (bit, frame, symbol, or character error) supported for each industry standard and for the
generic 8b/10b bus are listed in the following table.

Table 1: (Category) specifications

Test type
Standard Bit Frame Symbol Character
SATA Yes Yes No Yes
usB Yes No Yes Yes
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Table 1: (Category) specifications (cont.)

Test type
PCI Express Yes No No Yes
8b/10b Yes No No Yes
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Set error detector advanced settings

From the Analyze menu, select Serial Error Detector, press Setup, elect the Source Setup tab, and then
press the Advanced button.

Overview

Advanced Settings allow you to set the Align Primitives and enable or disable spread spectrum clock
tracking.

Advanced Settings |

D10.2 D10.2 D27.3

( ok )

To use
B Click On or Off to turn Spread Spectrum Clocking (SSC Tracking) on or off.

SSC is ON by default and Tektronix recommends that it should always be ON, even if there is
no SSC on the signal.

B Toignore align primitives, select the Ignore Align Primitives option button and specify the primitives
using the keypad or keyboard.

The Align Character informs the SerDes to align to 10-bit character boundaries when this character is
found in the signal. Alignment Primitives, also known as skip ordered sets, are inserted into the signal
by the DUT for purposes of pacing (keeping transmitter from overrunning the receiver).

B Enter the Maximum consecutive ALIGNs using the keypad or keyboard.

The maximum consecutive aligns is a design parameter of the particular DUT that indicates how
many consecutive aligns are allowed.

What do you want to do next?

®m  Use the Error Detector. (see page 205)

m_ Set up the serial error detector. (see page 206)

m  Specify the error detector test pattern. (see page 210)

B Set the error detector stop condition. (see page 211)
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Specify the error detector test pattern

210

From the Analyze menu, select Serial Error Detector, press Setup, and then select the Test Pattern tab.

Overview

The Test Pattern Setup provides control of the signal test pattern length and the Sync Pattern description.
These are often the most difficult settings, because they require knowledge of the signal. The Pattern
Length is the number of bits in the repeating signal being sent to the DUT or oscilloscope by the signal
generator or AWG. The Sync Pattern is a 10-, 20-, 30-, or 40-bit unique pattern in the signal that the error
detector uses to align the signal to the acquired comparison pattern. The Advanced check box just allows
you to set the Disparity of each of the Sync Pattern symbols individually. The ‘X’ means “don’t care.” The
Preset Setups set these parameters to make the job easier for the common cases.

Serial Error Detector

proatsatng (o425 coreat o v | (Cagm) (Caame)
Pattern Length Sync Pattern
soutn

N5 X b3 X
Sync Pattern Polarity | Advanced
RD-

To use

m  Specify the Sync Pattern, Sync Pattern Polarity, and the Pattern Length.

NOTE. Signal test patterns may be 800 to 100K bits in length, modulo 40, e.g. 800, 840, 880, 920....

What do you want to do next?

B Use the Error Detector. (see page 205)

m_ Set up the serial error detector. (see page 206)

B Set error detector advanced settings. (see page 209)

B Set the error detector stop condition. (see page 211)
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Set the error detector stop condition

From the Analyze menu, select Serial Error Detector, press Setup, and then select the Stop Condition tab.

Overview

Use this control window to specify the action performed when the error detector detects an error.

Serial Error Detector o

<
presetseung (saras_coreat st |+ | (aap) (aae) NotLockos

Stop When Actions on Detection

( Results ) % Sour=Re MANUAL [v] [ Audible Alert

Test Pattern [ save screen image

[ save waveform

("o ) @ Stop Condition [ send E-mail

To use

m  From the Stop Condition tab, select the Stop When condition. You can stop manually, after a preset
count or time that you specify, or on an error.

NOTE. Use large numbers for bit count tests: at 6 Gb/s, 60 billion tests take 10 seconds.

m  Select and setup the actions to perform when the stop condition is met. Using these actions, you can
preserve the information captured by the oscilloscope. You must setup the email address and the
SMTP server for Send E-mail to work.

What do you want to do next?

m_ Use the Error Detector. (see page 205)

m_ Set up the serial error detector. (see page 206)

m_ Set error detector advanced settings. (see page 209)

B Specify the error detector test pattern. (see page 210)

Error detector overview

The typical error detector startup sequence can be summarized as:
B Select a Preset Setup

B Press Sync
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B Press Learn (if visible)
B Press Run

The Sync operations gets the oscilloscope synchronized to the signal, the Learn operation acquires the
signal pattern into oscilloscope memory, and the Run operation starts the Error Detector testing for errors.
Note that the Learn operation only applies to some Bit error tests. Remember, Frame, Symbol, and
Character error tests do not require a Learn operation.

Then the typical sequence is to connect the DUT between the oscilloscope and the signal generator or
AWG for actual testing. After recabling, only a reSync and Run are needed, even for Bit testing, because
the signal test pattern has already been acquired into the oscilloscope memory.

There are several cable arrangements you can use with the Serial Error Detector. The first cable setup
specifically applies to SATA, PCle, and generic 8b10b bit testing, when a Learn operation is required
to acquire the signal test pattern into Error Detector memory. However, you can use this same cable
arrangement to verify Error Detector operation.

Connect the cabling as shown for the Learn operation in SATA, PCle, and generic bit testing.

Signal
Generator

DUT
not connected

Scope Error
Detector

2080049

Having done the Learn operation, you can now insert the DUT in-between the Signal Generator and
the Error Detector as shown.

Signal
Generator

Device Under
Test
(in loop back)

Scope Error
Detector

2980050

With the DUT inserted between the Signal Generator and the Serial Error Detector, all you need to do to get
the Error Detector running is to press the Sync and Run buttons, because the Learn operation was completed
in the previous step. If you do another Learn operation, you risk learning errors created by the DUT.

To avoid having to rearrange the cables after the Learn operation, you may split the output of the signal
generator, putting one branch into the Error Detector and one branch into the DUT. Here the Learn
Operation is done on Chl, but the actual error detection occurs on Ch2. You can adjust the amplitude
of the signal generator to account for the loss due to splitting the signal. This works because the Error
Detector learn operation stores the signal test pattern into error detector memory, not channel memory.

212 MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series



Error detector setups Error detector overview

Signal
Generator

DUT
in loop back

Scope Error
Detector Ch2

2080051

When the Error Detector is driven from the user interface, bus triggers are used whenever possible, so
that bus decoding is automatically enabled. The Decoding indicates the location of the error in the signal
by highlighting the decoded value in red, as shown in the screen capture below. You can use additional
oscilloscope channels to simultaneously probe other signals to debug the cause of the error.

File | Edi | Vertical | Digital | Horiz/Acq | Trig | Display | Cursors | Measure | Mask | Mat pe | Analyze | tiities | Help ()

Ol

[(kss

.u' f\m‘w“f‘\f‘ A1t 20 HW\ mﬂ (10 AaashEed

il MWWW (VR iE

@D 100mVidiv 500 §;:20.06 | ¥ B1Bus 8b10b  ERR.DET | 100ns/div 50.06S/s  20.0pspt
€13 100mV 2.0ns  -10.0ns 10.0ns Sample
RL:50.0k

Serial Error Detector

Preset Setting | SATA3_CJTPAT_BIT v @ @

Serial Bus: SATAGEN3 it Error g 2.539106e-012
i 1
Data Rate: 6.0Gbls 30383943:

Pattern Name:  CJTPat Consecutive Aligns: <=0
Stop Condition:  Manual Stop

Elapsed Time: 0:0:1:5
dd:hh:mm:ss

What do you want to do next?

Set up the serial error detector. (see page 206)

Set error detector advanced settings. (see page 209)

Specify the error detector test pattern. (see page 210)

Set the error detector stop condition. (see page 211)
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Mask testing control window (Masks tab)

From the Mask menu, select Mask Setup.

Overview

Use these controls to set up a mask test. You can set the type of mask, polarity, display, and alignment.

NOTE. The Comm Trigger is designed to work with communications mask and standard testing. Mask
testing automatically uses Communication triggers. You must install the Serial Communications Mask
Testing Option (see page 215) on some instruments before you can access the Comm triggers.

For information on the controls, click the buttons.

_Mask Testing

Sourcei
Tolerance
PassiFail
Setup
PassiFail
Results

What do you want to do next?

®  Learn more about mask setups. (see page 225)

B [earn more about mask test setups. (see page 227)

Serial mask testing option
m  Install Option MTM on DPO7000C and MSO/DPO5000B Series instruments.
B Install Option MTH on MSO70000C/DX and DPO70000C/DX Series instruments.

Select a mask type

From the Mask menu, select Mask Setup; then open the Masks tab.
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Overview

Use the Type controls to choose a mask. Use the standard drop-down list to select a standard for the mask
test. The Mask Polarity control will appear, depending on the standard selected. Use the Mask Polarity
controls to choose whether to test the positive pulse, negative pulse, or both.

NOTE. The Comm Trigger is designed to work with communications mask and standard testing. Mask
testing automatically uses Communication triggers. You must install the Serial Communications Mask
Testing Option on some instruments before you can access the Comm triggers.

Type ITU-T G.703 {(10/%0)
D53 Rate (44.736 Mbis) ks

LT SOMETSDH  Vides

-
ANSET1.102 mF:l:ai User Mask
- e i
Ethermed Elec
- W e B

To use

1. Click one of the Type controls to select the mask type.

2. Click More for additional selections.

3. Click the standard drop-down list to select the mask standard.
4

If the Mask Polarity control is displayed, click it to select positive or negative.

Behavior

The type of mask you choose will determine which standards are available from the standard drop-down
list. The standard selected will determine whether the Mask Polarity control is displayed.

NOTE. For some masks, you may see a pop-up message that reads, "Consider System Bandwidth when
testing at this bit rate." This message appears if the bandwidth of the measurement system falls below 1.5 —
1.8 times the bit rate of the data signal. Because the T1l committee has published a strict rule of 1.8 times
the bit rate for electrical standards, be aware that useful qualitative information can be gathered at the
current system bandwidth but quantitative rise-time measurements may not be reliable. A Consider System
Bandwidth message will appear for all optical standards, since optical filtering is not available.

Alternatively, you can select Edge Setup from the Trigger menu to improve the stability.
What do you want to do next?

B [earn about the Mask Display control window. (see page 219)
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B Learn more about mask alignment. (see page 223)

B Go to the Mask Setup control window. (see page 215)

Mask types and standards

Mask types and standards

The following tables list the Mask Types and Standards available with Mask Testing. The standards
available for your instrument depend on the bandwidth and configuration of your instrument.

The Comm Trigger is designed to work with communications mask and standard testing. Mask testing

automatically uses Communication triggers. You must install the Serial Communications Mask Testing
Option (see page 215) on some instruments before you can access the Comm triggers.

ITU-T masks

None 32 Mb 32.064 Mb/s 97 Mb 97.728 Mb/s DS1 Rate 1.544 Mb/s

DS2 Rate Sym 6.312 Mb/s DS2 Rate Coax 6.312 Mb/s ~ DS3 Rate 44.736 Mb/s E1 Sym Pair 2.048 Mb/s

E1 Coax Pair 2.048 Mb/s E2 8.448 Mb/s E3 34.368 Mbl/s E4 Binary 0 139.26 Mb/s

E4 Binary 1 139.26 Mb/s STM1E Binary 0 STM1E Binary 1

155.52 Mb/s 155.52 Mb/s

ANSI T1.102 masks

None DS1 1.544 Mb/s DS1A 2.048 Mb/s DS1C 3.152 Mb/s

DS2 6.312 Mb/s DS3 44.736 Mb/s DS4NA 139.26 Mb/s DS4NA Max Output
139.26 Mb/s

STS-1 Pulse 51.84 Mb/s STS-1 Eye 51.84 Mb/s STS-3 155.52 Mbl/s STS-3 Max Output
155.52 Mb/s

Ethernet masks

None

100Base-TX STP 125 Mb/s

100Base-TX UTP 125 Mb/s

Gigabit Ethernet 1.25 Gb/s

1000B-CX Norm, TP2
1.25 Gbls

1000B-CX Abs, TP2
1.25 Gb/s

1000B-CX Abs, TP3
1.25 Gbls

XAUI, Near 3.125 Gb/s

XAUL, Far 3.125 Gb/s

1000B-SX/LX 1.25 Gb/s

SONET/SDH masks

None OC1/STMO 51.84 Mb/s OC3/STM1 155.52 Mbl/s OC12/STM4 622.08 Mbl/s
0OC48/STM16 2.4883 Gb/s OC48-FEC 2.666 Gb/s

Fibre channel masks

None FC133 Optical 132.8 Mb/s FC266 Optical 265.6 Mb/s FC531 Optical 531.2 Mb/s
FC1063 Optical FC1063 Optical Draft Rev FC2125 Optical 2.125 Gb/s

1.0625 Gb/s 11

Fibre channel electrical masks

None FC133E Elec. 132.8 Mb/s FC266E Elec. 265.6 Mb/s FC531E Elec. 531.2 Mb/s
FC1063E Elec. FC1063E Norm, Beta, FC1063E Norm, Delta, FC1063E Norm, Gamma,
1.0625 Gb/s Transm Transm Transm

FC1063E Abs, Beta,
Transm

FC1063E Abs, Delta,
Transm

FC1063E Abs, Gamma,
Transm

FC1063E Abs, Beta, Recv
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Fibre channel electrical masks

Mask types and standards

FC1063E Abs, Delta, Recv

FC1063E Abs, Gamma,

FC2125E Norm, Beta,

FC2125E Norm, Delta,

Recv Transm Transm
FC2125E Norm, Gamma, FC2125E Abs, Beta, FC2125E Abs, Delta, FC2125E Abs, Gamma,
Trans Transm Transm Transm
FC2125E Abs, Beta, Recv FC2125E Abs, Delta, Recv FC2125E Abs, Gamma,

Recv
InfiniBand masks
None 2.5 Optical 2.5 Gb/s 2.5 Electrical
2.5 Gbls

Serial ATA masks
None G1Tx 1.5 Gb/s G1Rx 1.5 Gb/s
G2 Tx 3.0 Gb/s G2 Rx 3.0 Gb/s
USB 1.1/2.0 masks
None FS 12 Mb/s HS:T1 480 Mb/s HS:T2 480 Mb/s
HS:T3 480 Mb/s HS:T4 480 Mb/s HS:T5 480 Mb/s HS:T6 480 Mb/s
IEEE 1394b masks
None S400b T1 491.5 Mb/s S400b T2 491.5 Mb/s S400b Optical 491.5 Mb/s

S800b T1 983.0 Mb/s

S800b T2 983.0 Mb/s

S800bOptical 983.0 Mb/s

S1600b T1 1.966 Gbrs

S1600b T2 1.966 Gb/s

S1600b Optical 1.966 Gb/s

Rapid 10 LP-LVDS masks

None Drv 500 Mb/s Drv 750 Mb/s Drv 1.0 Gb/s

Drv 1.5 Gb/s Drv 2.0 Gb/s Ext Drv 500 Mb/s Ext Drv 750 Mb/s
Ext Drv 1.0 Gb/s Ext Drv 1.5 Gb/s Ext Drv 2.0 Gb/s Rcv 500 Mb/s
Rev 750 Mb/s Rcv 1.0 Gb/s Rev 1.5 Gb/s Rev 2.0 Gb/s

Rapid 10 Serial masks

None RIO Serial 1.25 Gb/s RIO Serial 2.5 Gb/s RIO Serial 3.125 Gb/s
Video masks
None 4FSC NTSC "D2" 4:4:2 "D1" 270Mb/s DVB ASI 270 Mb/s

143.18 Mb/s

4:2:2 SMPTE 259-M-D
360 Mb/s

SMPTE 292M 1.485 Gb/s
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Mask testing setups Use mask display controls

Use mask display controls

From the Mask menu, select Mask Setup; then open the Masks tab.

To use

m  Click the On/Off control to turn the mask display on or off.

B Click the Config control to activate the Mask Configuration Display (see page 219) control window.

<

Behavior

When the On/Off control is on, the mask is displayed on the graticule. When the On/Off control is off, the
mask is not displayed.

Click the Config button to replace the Mask Testing control window with the Mask Configuration Display
control window.

What do you want to do next?

®m  Learn about the Mask Configuration Display control window. (see page 219)

B [earn about mask types. (see page 215)

®  [earn about mask alignment. (see page 223)

B Go to the Mask Setup control window. (see page 215)

Mask configuration control window - Display

From the Mask menu, highlight Mask Configure; then select Display. From the Mask Testing control
window, click the Display Config button.

Overview

Use this control window to set whether changes in the scale will also be made in the mask. You can also
use this control window to return to the Mask Setup control window.
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Mask testing setups Configure mask autoset

‘Mask Configuration - Display

Autoset

To use
B Click the Lock Mask to Waveform button to turn it on and off.

m  Click the Masks button to go to the Mask Testing control window.

Behavior

When the Lock Mask to Waveform button is turned on, any changes you make to the scale, vertical
position or horizontal position will be reflected in the mask. Turning on Highlight Hits displays the hits in
a different color so they can be easily seen. When you click the Mask button this window closes, and

the Mask Setup control window opens.

What do you want to do next?

B Go to the Mask Setup control window. (see page 215)

B [Learn more about mask configuration. (see page 220)

Configure mask autoset

From the Mask menu, highlight Mask Configure; then select Autoset. From the Mask Testing control
window, click the Autoset Config button.

Use this control window to set the vertical, horizontal, and trigger autoset parameters, activate autofit or
autoset, choose the autoset mode, return to the default autoset configuration, or go to the Mask Testing
control window.

For information on the controls, click the buttons.
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Mask testing setups Configure mask autofit

‘Mask Configuration - Autoset

To use

B Click Autoset to align the signal within the mask. This operates the same as the Autoset button on
the front panel.

®  Click Defaults to return the instrument to the default autoset configuration.
B Click Masks to replace this control window with the Mask Testing control window.
What do you want to do next?

B Go to the Mask Setup control window. (see page 215)

B [earn about mask display configuration. (see page 219)

B [earn about mask autofit configuration. (see page 221)

Configure mask autofit

From the Mask menu, highlight Mask Configure; then select Autofit. From the Mask Testing control
window, click the Autofit Config button.

Overview

Use this control window to configure the limits for minimizing mask hits, return to default setting, or return
to the Mask Testing control window.
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Mask testing setups Configure mask autofit

222

Mask Conﬁgura‘lign - Autofit

Vertical

10% div j—

Horizontal

10% div

To use

B Set the vertical and horizontal maximum levels of adjustment by clicking in the entry boxes and use
the multipurpose knobs or double-clicking in the control and use the pop-up keypad.

B (Click Autofit to align the signal within the mask.
B Click Defaults to reset the autofit configuration to the default values.

m  (Click Masks to return to the Mask Testing control window.

Behavior

The maximum level of adjustment determines how far Autofit will search for the best fit to minimize hits.
For example, if you set the Vertical Maximum to 10% per division, Autofit searches up to and including
10 percent of the vertical divisions for the best fit. Autofit minimizes hits by aligning the signal within
the mask.

Clicking Masks replaces the Mask Configuration Autofit control window with the Mask Testing control
window.

NOTE. The interaction between Autofit and Persistence can affect the display of persistence data. Autofit
moves the waveform vertically and/or horizontally to reduce the number of hits within a given mask. If
either infinite or variable persistence is enabled these movements will clear any persistence data. If Autofit
makes frequent adjustments, there can be little or no persistence data.

What do you want to do next?

B earn about display configuration. (see page 219)

B Learn about autoset configuration. (see page 220)
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Set up mask alignment

From the Mask menu, select Mask Setup; then open the Masks tab.

To use
B Click the Autoset control to perform an autoset on the signal.
m  Click the Autofit control to turn the minimize hits function on or off.

B Click the Config control to access the Autoset (see page 220) or Autofit (see page 221) Configuration
control window.

e GO

Behavior

Clicking the Autoset control automatically aligns the mask based on the characteristics of the input signal.
This function is done once, and that setting is not changed until you run the autoset command again or
until you change any settings. This is the same as pushing the front-panel Autoset control.

When Autofit is used, the signal is aligned within the mask to minimize the number of hits on each
acquisition. Settings may change after each acquisition when autofit is used.

NOTE. The interaction between Autofit and Persistence can affect the display of persistence data. Autofit
moves the waveform vertically and/or horizontally to reduce the number of hits within a given mask. If
either infinite or variable persistence is enabled, these movements will clear any persistence data. If
Autofit makes frequent adjustments, there can be little or no persistence data.

Clicking the Autoset Config button will replace the control window with the Autoset Mask Configuration
control window. Clicking the Autofit Config control will replace this control window with the Autofit
Mask Configuration control window.

What do you want to do next?

B [earn about autoset configuration. (see page 220)

B [earn about autofit configuration. (see page 221)
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®  [earn about mask display setup. (see page 219)

B earn about mask types. (see page 215)

B Go to the Mask Setup control window. (see page 215)

Edit a mask

224

From the Mask menu, select Mask Edit Setup, or click the Edit User Mask button in the Mask Testing
control window.

Overview

Use this control window to select the Segment and Vertex for editing, set the Horizontal and Vertical
mask values, and Save or Recall masks.

Mask Edit

To use

m  (Click the Mask Segment and Vertex up and down arrows to select the segment or the vertex of the
mask to be edited.

B Click Add to add a point to the boundary in the selected segment and just after the selected vertex.
®  Click Del to delete the selected vertex from the selected segment.
m  Click Del All to remove all points in the selected segment.

B To change the horizontal or vertical mask values for the selected segment and vertex, click in the
Horizontal or Vertical entry boxes, and then use the multipurpose knobs to set the values.

m  To save a mask, click Save to activate the Save As dialog box.

B To recall a previously saved mask, click Recall to activate the Recall dialog box.
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Mask testing setups Set up mask testing source/tolerance

Behavior

The Segment up and down arrows increase or decrease the segment number by one. The Vertex up and
down arrows increase or decrease the vertex by 1. To set a specific number, click in the Vertex entry
box to activate the pop-up calculator.

Clicking the Add button adds a point to the boundary in the selected segment and just after the selected
vertex in addition to moving any points that follow the newly added point in the boundary up one. For
example, if there are 6 points in the boundary of the selected segment and you add a point when the
selected vertex is 4, then the vertex which was 4 becomes vertex number 5, number 5 becomes 6, and
vertex 6 is changed to vertex 7.

Clicking Del deletes the selected vertex from the selected segment and moves any points that follow the
deleted point down one in the boundary. Clicking Del All deletes all points in the selected segment,
effectively deleting that segment.

Clicking the Setup button will return you to the Masks Testing control window. Clicking the Controls
button will activate the User Mask Edit control window (see page 240) where you can make quick changes
to a User mask.

What do you want to do next?

E [earn about saving masks. (see page 540)

®m Learn about recalling saved masks. (see page 241)

B [earn more about mask types. (see page 215)

B Learn more about mask setups. (see page 215)

Set up mask testing source/tolerance

From the Mask menu, select Source.

Overview
Use this control window to select the source of the signal you want to test.

For information on the controls, click the buttons.

Mask Testing - Source/Tolerance

Channels
Pass/Fail oy
Setup

Pass/Fail
Results [
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Mask testing setups Set up mask margins

To use
1. Click the Ch, Math, or Ref tab to select the source for mask testing.

2. Click the number (1-4) of the channel, math expression, or reference you want to use.

Behavior

When you click the Ch tab and select a channel number, it is used as the source for mask testing. You can
select only one source at a time for mask testing.

What do you want to do next?

B [earn more about mask setups. (see page 226)

m [earn more about mask test setups. (see page 227)

B Go to the Mask Setup control window. (see page 215)

Set up mask margins

From the Mask menu, select Tolerance Setup.

Overview

Use this control to turn the margin mode on or off and to set the percentage of margin used for the mask test.

Miarsk Margin Tolerance:

[ 50%
e

To use
1. Click the On/Off button to turn the mask margin tolerance on or off.

2. Click the up and down arrows or click in the Margins entry box to activate the pop-up keyboard and
set the percentage of margin tolerance.
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Mask testing setups Set up pass/fail mask testing

Behavior
When the mask margin tolerance is on, you can control the percentage of margin used in the mask test.

Use the up and down arrow buttons to increase or decrease the percentage in 1% increments. A tolerance
that is > 0 makes passing a mask test more difficult.

A mask test that passes with a tolerance that is > 0 demonstrates that the signal passes the test with a
margin for further error. Setting the tolerance to < 0 makes a mask test easier to pass. A tolerance that is <
0 can be used to demonstrate by how much of a margin the signal fails.

What do you want to do next?

B Learn more about mask testing setup. (see page 227)

®m  Go to the Mask Setup control window. (see page 215)

Set up pass/fail mask testing

From the Mask menu, select Pass/Fail Setup.

Overview

Use this control window to set the parameters for passing or failing the mask test, to set the test notification
mode, to select the polarity for testing, and whether to repeat the test.

For information on the controls, click the buttons.

Mazk Testing - Pass/Fail Setup

What do you want to do next?

B earn more about mask testing. (see page 234)
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Mask testing setups Set up mask test fail notification

Go to the Mask Setup control window. (see page 215)

Set up mask test fail notification

228

From the Mask menu, select Pass/Fail Setup.

Overview

Use the Test Fail Notification controls to set the mode of notification when a waveform fails a mask test.

Test Fail Notification

- @ @
@w e @
- -
togtate (g

J

To use

Click a button to switch the control on or off. Use this control window to save a failed waveform, log
the date and time of a failed waveform, and specify the directory where you want to save the waveform
or send E-mail on a failed waveform.

Behavior

Beep. When Beep is turned on, the instrument beeps when a mask test fails.

E-mail. When E-mail is turned on, the instrument sends an E-mail when a mask test fails. Click the
Setup button and complete the E-mail on Event Setup (see page 555) information.

Save WFM. When Save WFM is turned on, failed waveform data is saved to a file. Click the Path
button and enter the path location for the file.

Log Date. When Log Date is turned on, the date and time for each failed mask test is recorded to a
file. Click the Path button and enter the path location for the file.

Print. When Print is turned on, the instrument sends the waveform to a printer when a mask test fails.
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Mask testing setups Set up mask test fail notification

®  SRQ. When SRQ is turned on, the instrument sends a GPIB SRQ command when a mask test fails.

B AUX Out. When AUX Out is turned on, the instrument sends a trigger to the Auxiliary Out connector
when a mask test fails. See External Signals Control Window (see page 550) for additional details

on this feature.

What do you want to do next?

B Learn about mask polarity. (see page 233)

®m  Learn about waveform parameters. (see page 230)

B Go to the Test Setup control window. (see page 227)
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Set up mask test completion notification

From the Mask menu, select Pass/Fail Setup.

Overview

Use the Test Completion Notification controls to beep, execute a command, or send an external trigger
when a waveform passes a mask test.

To use

Click a button to switch a control on or off.

Behavior

®  Beep. When Beep is turned on, the instrument beeps when the test is completed. Beep is not available
on MSO/DPO5000B Series instruments.

B SRQ. When SRQ is turned on, the instrument sends a GPIB SRQ command when a test is completed.

E  AUX Out. When AUX Out is turned on, the instrument sends a trigger to the Auxiliary Out connector
when the test is completed. See External Signals Control Window (see page 550) for additional
details on this feature.

What do you want to do next?

B [earn about mask polarity. (see page 233)

B [earn about waveform parameters. (see page 230)

®  Go to the Test Setup control window. (see page 227)

Set mask test parameters

From the Mask menu, select Pass/Fail Setup.
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Overview

Use the Number of Waveforms (Samples), Fail Threshold, and Pre-Test Delay controls to set the
parameters for the mask test.

NOTE. If you are using Waveform Database mode, the Number of Waveforms entry box changes to
a Samples entry box.

To use

1. Click in the Number of Waveforms (Samples) entry box to activate the multipurpose knobs to enter a
value.

2. Click in the Fail Threshold entry box to activate the multipurpose knobs and enter the minimum
number of waveforms that must fail for the test to fail.

3. Click in the Pre-Test Delay entry box to activate the multipurpose knobs to enter the number of
seconds to wait before starting the test.

Behavior

Entering a number in the Number of Waveforms (Samples) entry box stops the test when that number
has been reached.

If the waveforms or samples that fail are equal to or greater than the number in the Fail Threshold entry
box, the test has failed. If the failed waveforms or samples are less than the number in the Fail Threshold
entry box, the test passes.

The instrument begins sampling after the number of seconds has passed set in the Pre-Test Delay entry
box. Use the Test Delay if you need to give the signal source time to stabilize.

What do you want to do next

B [earn about test notification. (see page 228)

m  Learn about mask polarity. (see page 233)

B Learn about test results. (see page 234)
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Mask testing setups Select the sound source

®  Go to the Test Setup control window. (see page 227)

Select the sound source

232

NOTE. This feature is not available on MSO/DPO5000B Series instruments.

Your instrument is shipped with an internal speaker that some of the software features use to send an
audible alert to the user. To enable this speaker, the sound card in your instrument must be turned off. With
the sound card off, you will not have access to standard Windows audio features, such as the ability to
listen to a music CD.

If you turn the sound card on, the internal speaker is disabled. You will need to connect headphones or an
amplified speaker to the headphone jack on the instrument to hear the alerts.

NOTE. The default setting disables the sound card.

Use the following procedure to turn the sound card on or off.

1. Access the Device Manager:

a.
b.
c.
d.

€.

From the File menu, click Minimize, or press CTRL+M to minimize the instrument application.
On your Windows desktop, right-click the My Computer icon.

Click Properties.

In the System Properties dialog box, click the Hardware tab.

Click the Device Manager button.

2. Select the Source:

Double-click Sound, video, and game controllers.
Double-click SigmaTel C-Major Audio.

In the Device usage drop-down list, click either Use this device (enable) or Do not use this device
(disable).

3. Save Your Changes:

a.
b.

C.

Click OK.
Close the Device Manager dialog box.

Close the System Properties dialog box.
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Mask testing setups Set the mask polarity

Set the mask polarity

From the Mask menu, select Pass/Fail Setup.

Overview

Use the Mask Polarity control to select whether to test the positive or negative pulse or both.

Os OF OF &

To use
m  Click Positive to set the pulse polarity to positive.
®  Click Negative to set the pulse polarity to negative.

B Click Both to set the pulse polarity to both negative and positive.

Behavior

When the Positive control is selected, the mask test is performed on the positive pulse. When the Negative
control is selected, the mask test is performed on the negative pulse.

When the Both control is selected, the mask test is performed on both the positive and negative pulses.

NOTE. The mask polarity controls operate for pulse mask testing only; they have no affect on eye masks.

What do you want to do next?

®m  Learn about test notification. (see page 228)

®m  Learn about waveform parameters. (see page 230)

B [earn about test results. (see page 234)

B Go to the Test Setup control window. (see page 227)
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Set mask test repeat controls

From the Mask menu, select Pass/Fail Setup.

Overview

Use the Pass/Fail Test controls to start the test or to run the test continuously.

€ E1e

To use
B Click the On/Off button to start the test.
m  Click the Repeat button to run the test continuously.

B (Click the Controls button to open the Mask Test control window.

Behavior

When the Repeat control is on, the test runs continuously. When you click the On/Off button, the test starts
using the parameters from the Mask Test control window and the Pass/Fail Results window is displayed.

What do you want to do next?

B [earn about waveform parameters. (see page 230)

B Learn about test notification. (see page 228)

®  earn about mask polarity. (see page 233)

B Learn about the Mask Test Controls window. (see page 888)

m_ Go to the Test Setup control window. (see page 227)

Mask Testing control window (Pass/Fail Results tab)

From the Mask menu, select Pass/Fail Results.
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Mask testing setups View the mask test summary

Overview

Use this control window to view real time test results, start the test, reset the test at the beginning, activate
the waveform failure log file, and open the Mask Test Controls control window.

For information on the controls, click the buttons.

Source/ p -
Tolerance | Wavef Tested : 0 out of 20

Pass/Fail =~ ; :
Setup Source Status Total Hits Failed Wims
Ch 0 0

0 0
Pass/Fail | e

Results |

What do you want to do next?

B Learn about test summary. (see page 235)

®m  Learn about hits per segment. (see page 237)

B Learn about the Mask Test Controls window. (see page 888)

B Go to the Test Setup control window. (see page 227)

View the mask test summary

From the Mask menu, select Pass/Fail Results.

Overview

Use this window to view real time test results.

PassiFail Test Summany

Samples Tested : 20 out of 100000

Source Status Total Hits Failed Yiffms
Ch1 13326 20
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Mask testing setups View the mask test summary

236

To use

The Pass/Fail Test Summary is a read only field.

Behavior

The Pass/Fail Test Summary fields provide a real time summary of the test results. Waveforms or samples
tested shows how many waveforms or samples have been tested in relation to how many were specified
in the test setup.

Source indicates what signal source was used for the test.

Status indicates whether the test has passed, failed, or is passing.
Passing appears in yellow, passed in green, and failed in red.

Total Hits shows the total number of data points that violated the mask.

Failed Wfms shows the total number of waveforms that failed during the test sequence.

What do you want to do next?

® Learn about hits per segment. (see page 237)

B earn about the Mask Test Controls window. (see page 888)

E  Learn about test results. (see page 234)
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View the mask hits per segment

From the Mask menu, select Pass/Fail Results.

Overview

Use this window to view the hits for each mask segment of the test.

Hits per segment

Source Seq1
Ci 10126

][5

(£

To use

The Hits per segment is a read only field.

Behavior

Each mask test can have up to 16 segments. The data point violations per segment are shown in this
window. Source indicates the input signal in use for the test. The segments are identified by Seg followed
by the number of the segment. Only the number of segments used in a test is shown. A scroll bar appears
if there are more segments used than can be seen at one time.

The segments of a mask are the polygonal regions on the screen. Segment one is the left upper most
polygon. Segments are assigned from top to bottom and left to right on the screen.

What do you want to do next?

B Learn about test summary. (see page 235)

B [earn about the Mask Test Controls window. (see page 888)

B [earn about test results. (see page 234)
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Start or reset a mask test

From the Mask menu, select Pass/Fail Results.

Overview

Use these controls to start a test or reset the test to the starting point.

To use
B Click the On/Off control to start the test.

m  Click the Reset control to reset the test to the beginning.

Behavior

When the test starts, it uses the parameters in the Pass/Fail Test Setup control window. When the test is
reset, the Total Hits, Failed Wfms, Hits per segment, and Waveform Tested fields are reset to zero.

What do you want to do next?

B Learn about test summary. (see page 235)

®  Learn about hits per segment. (see page 237)

B earn about the Mask Test Controls window. (see page 888)

B earn about test results. (see page 234)

Set the user mask controls

From the Mask menu, select Mask Setup; then open the Masks tab and click the User Mask button.
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Mask testing setups Set the user mask controls

Overview

Use this control window to access the Edit User Mask control window or to copy a standard mask as a user
mask. You can also select the standard you want to copy or edit from the standard drop-down list.

NOTE. The Comm Trigger is designed to work with communications mask and standard testing. Mask
testing automatically uses Communication triggers. You must install the Serial Communications Mask
Testing Option on some instruments before you can access the Comm triggers.

For information on the controls, click the buttons.

Pass/Fail
Setup

Pass/Fail |
Results |

To use
®  Click the Edit User Mask button to access the Mask Edit control window.

B Click the Copy Current Mask button To User Mask to make the current mask a user mask.

Behavior

Clicking the User Mask button gives you access to the User Mask in the standard drop-down list. Clicking
the Edit User Mask control will replace this control window with the Mask Edit control window. Clicking
the Copy Current Mask to User Mask control will activate a dialog box where you can overwrite the

user mask.

What do you want to do next?

®  Learn about editing masks. (see page 224)

B [earn more about mask types. (see page 215)
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® [earn more about mask sctups. (see page 215)

Set user mask edit controls

From the Mask menu, select Mask Edit Controls.

Overview
Use this control window to select the segment and vertex for editing and set the Vertical and Horizontal
Mask Values.
Mask Edit Segrmant Warte Horizoital Wertical
[ 1 1 @ [ 38ns [ v P
(o) -
- B -
To use

B (Click the up and down arrows to select the segment or the vertex of the mask to be edited.

m  Click the Add button to add a point to the boundary in the selected segment and just after the selected
vertex.

B Click Del button to delete the selected vertex from the selected segment.

B To change the horizontal or vertical values for the selected segment and vertex, click in the Horizontal
or Vertical entry boxes to activate the multipurpose knobs to enter a value.

Behavior

The Segment up and down arrows increase or decrease the segment number by one. The Vertex up and
down arrows increase or decrease the vertex by 10. To set a specific number click the Vertex entry box
to activate the pop-up calculator. Clicking the Add control adds a point to the boundary in the selected
segment and just after the selected vertex in addition to moving any points that follow up one. Clicking
Del deletes the selected vertex from the selected segment and moves any points that follow down one.

What do you want to do next?

Learn about saving masks. (see page 540)

Learn about recalling saved masks. (see page 241)

Learn more about mask types. (see page 215)

B [earn more about mask setups. (see page 215)
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Recall user mask

From the File menu, select Recall, or from the Reference Waveform controls (see page 527), click the
Recall button.

Overview

Use this dialog box to recall a saved user mask.

Recall |E|
Recal “What: Laok jr IE' Masks j - | ® ch': ‘_

B I)Examples

W aveform

File narme: I jﬁ | Recall I
Files of type: [ User Mask fles [ msk) | Cancel |

Help |

To use
B Under Recall What, click User Mask.
m  [n the Look in drop-down list box, navigate to the location of the user mask.

B Click on the name of the mask file you want to recall. You can also click the keyboard icon to access
the pop-up keyboard and enter the file name.

m  Click Recall.
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Behavior

The Recall dialog box displays when you click Recall in the Mask Edit control window. Clicking Recall
replaces the current mask with the mask that you selected in the Recall dialog box.

Masks are saved in C:\Users\[Username]\Tektronix\TekScope\Masks unless you choose another
directory.

What do you want to do next?

m Learn about saving masks. (see page 540)

B [earn more about mask types. (see page 215)

® ] earn more about mask setups. (see page 215)

Set up limit testing

From the Mask menu, select Limit Test Setup; then open the Setup tab.

Overview

Limit testing allows you to compare an active signal to a template waveform.

To use

Use the following procedure to build a template from a known signal and compare it to an active signal.
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1. Create a template:
a. Select the signal Source and template Destination in the drop-down list boxes.

b. Click in the Vertical and Horizontal Tolerances entry boxes and use the multipurpose knobs to
specify the test limit tolerances. The Tolerances specify the margins allowed before a limit test
fails.

¢. Click Save to save the template as a reference waveform or save to a file. You can create and
save multiple templates.

2. Compare a source waveform to a template:
a. In the Source drop-down list box, select the source waveform to compare to a template.

b. In the Template drop-down list box, select the template to compare to the source waveform.
Normally, this is the template you created in the steps above, but you can compare multiple
waveforms to multiple templates at the same time.

3. Failure Notification:
a. Open the Failure Notification tab and set up the mode you prefer for failure notification.
b. Click the Setup tab to return to the Limit Test setup window.

4. Select Test Options:

a. Click the Lock Template to Waveform button On to lock the vertical scale or position of the
template to the source waveform.

b. Click the Highlight Hits button On to show points on the waveform that fall outside the template.
These will occur in a different color.

5. Run Limit Test:
a. Click the Limit Test button On to start the test.

b. Click the Reset button to clear all violations in preparation for another test.

TIP. Use the Average acquisition mode to create a smoother template waveform; use the Envelope
acquisition mode to create a template that allows occasional overshoots.

NOTE. Limit testing is not available on digital channels.

Save a template

From the Mask menu, select Limit Test Setup. In the Destination drop-down list, select File to open the
Save Template dialog box. From the dialog box, click the Save button.
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Overview

Use this dialog box to save the limit test template to a specified file.

ﬁ Save Template

==

-

Mo itemns match your search.

€| 1

MName: | j E

Save as type: |Wavefom files (*WFM) R

Savein: | | waveforms j I'ff‘ EH-
MName Date modified Ty

Save

Cancel

Pl

Help

To use

Save a template

B To save to a file, enter a Name or use the default file name. The file extension specified in the Save as
type list will automatically be appended to the file name.

Behavior

This dialog box opens when you select File from the Limit Test Setup control window. The default file

type is a waveform (.WFM).

The default folder is C:\Users\ [Username]\Tektronix\TekScope\waveforms.

NOTE. Any characters that you enter in the file name box become part of the file name. The instrument

does not use any user-defined file extensions.
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Set up limit test failure notification

From the Mask menu, select Limit Test Setup; then open the Failure Notification tab.

Overview

Use the Limit Test controls to set the mode of failure notification when a mask limit test fails.

To use

Click a button to switch the control on or off. Use the controls to indicate the failure notification method,
if a waveform fails a mask limit test.

Behavior

B Beep. When Beep is On, the instrument beeps if a mask test fails.

B E-mail. When E-mail is On, the instrument sends an E-mail if a mask test fails. Click the Setup button
and complete the E-mail on Event Setup (see page 555) setup information.

®  Save WFM. When Save WFM is On, failed waveform data is saved to a file. Click the Path button
and enter a location to save the file.

= Log Date. When Log Date is On, the date and time for each failed mask test is recorded to a file.
Click the Path button and enter a location to save the file.

B Print. When Print is On, the instrument sends the waveform to a printer if a mask test fails.

m  SRQ. When SRQ is On, the instrument sends a GPIB SRQ command if a mask test fails.
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From the Math menu, select Math Setup.

Overview

Use the Math Setup control window to set up and define math waveforms (see page 747).

NOTE. Math calculations are not available on digital channels.

For information on the controls, click the buttons.

(MathSetup-Mant

Custom MATLAB Functions n

You can define up to four math waveforms. The controls for each waveform are similar, but independent
of each other.

TIP. To easily change the vertical position and scale of a math waveform, click the waveform handle on the
left side of the screen. Use the multipurpose knobs to change the waveform position and scale.

TIP. To open the Math Equation Editor, double-click in the math expression field or click the Editor button.

What do you want to do next?

B [earn about the Math Waveform controls. (see page 868)

B [earn about the Equation Editor. (see page 263)

Set up math averaging

From the Math menu, select Set Math Averages.
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Overview

Use this control window to specify the number of times the selected math waveform (see page 748)
is averaged.

Math Averaging

To use
1. Click in a Math <1-4> n = entry box to map it to one of the multipurpose knobs.

2. Use the multipurpose knob to specify the number of times the selected waveform should be averaged.

Behavior

The selected math waveform is averaged over the number of acquisitions shown in the control. Each math
waveform has its own set of controls.

The following buttons allow you to change other setups after you set the averaging:
®m  Click Editor to open the Math Equation Editor control window.

m  Click Spectral to open the Spectral Setup control window.

B Click Setup to open the Math Setup control window.

What do you want to do next?

® Learn about the Spectral Setup controls. (see page 252)

B [earn more about the Math Setup controls. (see page 247)

Set math variables

From the Math menu, select Set Math Variables.

Overview

Use this control window to quickly set the math variables to use in your math expression.

|m[ Math Variables Yai= [ o %_
vaz= [ 08 Vad= |
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To use
®  Usethe 1 —4 or 5 — 8 tabs to access the variables you want.

B Click in a Var <1-4> = or Var <5-8> = entry box and use the multipurpose knobs to set the value
for the variable.

®  (Click the Editor button to access the Math Equation Editor.

Behavior

You can set or change the variable values in this control window. To add a variable to a math expression,
go to the math editor, and click the VAR <1-8> buttons.

What do you want to do next?

®m  Learn about the Edit controls. (see page 818)

Use custom analysis functions

From the Math menu, select Math Setup.

To use

1. Select a custom function from the Custom Analysis Functions drop-down list.

@

Custom MATLAB Functions n

Behavior

Custom functions are math functions that you have created and installed on the instrument. Once installed
you can select and use them just like the instrument built in functions.

Click the question mark to display information on custom analysis function plugins. Custom analysis
functions (see page 250).

What do you want to do next?

®  Learn about using Math Plugins (see page 755)

® Learn about writing Math Plugins (see page 756)

B Learn about writing MATLAB custom function plugins (see page 761)
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Custom analysis functions

This window provides information on MATLAB and .NET plugin functions you can use in math equations.

What do you want to do next?

B Learn about using Math Plugins (see page 755)

B Learn about writing Math Plugins (see page 756)

®  Learn about writing MATLAB custom function plugins (see page 761)
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MATLAB custom analysis interface

This window provides information on MATLAB plugin functions you can use in math equations.

_Cusimn Analysis Interface for use o

Behavior
Clicking on the link takes you to the MathWorks Web site.

Use the drop down list to select a MATLAB plugin to insert in your math equation. If MATLAB or the
instrument toolbox is not installed, the drop down list is replaced with a instructions to install MATLAB

and the toolbox.
What do you want to do next?

B [earn about using Math Plugins (see page 755)

®  Learn about writing Math Plugins (see page 756)

®  Learn about writing MATLAB custom function plugins (see page 761)

Set up basic spectral analysis

From the Math menu, select Basic Spectral, or click Basic in the Math Setup control window.

Overview

Use these controls to for simple spectral analysis.
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To use

For information on the controls, click the buttons.

| 400k |

[190.08H2 |

| 50.0kHz |

Changing the Horizontal Mode to Manual activates the Frequency Span and Resolution BW controls.

Use front panel spectral controls

From the Math menu, select Basic or Advanced Spectral; in the Spectral Setup window, click the ? mark.

To use

To map the spectral controls to the instrument front panel, do the following:
From the Horz/Acq menu, select Horizontal/Acquisition Setup.
Open the Horizontal tab.

Under Mode, click the Manual option box.

1

2

3

4. Return to the Spectral Setup control window.

5. Use the front panel Resolution knob to directly control Frequency Span.
6

Use the Horizontal Scale knob to directly control Resolution Bandwidth.

Set up advanced spectral analysis

From the Math menu, select Advanced Spectral, or click Advanced in the Math Setup control window.
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Overview

Use the controls in this window to set up advanced math waveforms for spectral analysis. Using the tabs,
you can create a spectral waveform, define the vertical units, and adjust the measurement parameters.
You can also lock waveforms together.

To use

For information on the controls, click the buttons.

After you create the spectral waveform, use the controls on the right side of the control window to position
and adjust the waveform so that you can view the data you are interested in.

You can operate the instrument and view spectral (FFT) waveforms using the time-domain controls, gating
controls, or frequency domain controls. Some of these controls are interactive; making changes with one
set of controls will sometimes change settings in another control set.

What do you want to do next?

m  Learn about creating spectral waveforms. (see page 918)

B Learn about the Math Setup controls. (see page 247)

Set up the frequency spectral controls

From the Math menu, select Advanced Spectral, or click Advanced in the Math Setup control window.

To use

B Click in an entry box, and then use the multipurpose knobs to set the Center Freq (see page 254), Freq
Span (see page 254), and Res BW (see page 255).

B Click Full to set the frequency span to full.
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Center Fraguency

S0.0MHz

Frespsancy Span
1MkHz
Regohition EWAS

[P I

Behavior

The maximum frequency span is equal to half of the sample rate. If you need a higher frequency span,
set the sample rate to a larger value.

The Resolution Bandwidth determines how small of a frequency difference can be resolved in the frequency
domain output data. It defines the bandwidth of filters used to perform the frequency domain analysis.
The resolution bandwidth is measured in hertz at the 3 dB points on each side of the peak spectral lobe.
Adjusting the resolution bandwidth controls the gate duration to obtain the desired resolution bandwidth.

NOTE. The frequency domain controls interact with the gating and acquisition controls,; changing one set
of controls may change the other control settings.

What do you want to do next?

B [earn about the Gating controls. (see page 255)

® Learn about the Math Setup controls. (see page 247)

Center frequency

The center frequency is the frequency at the center of the frequency span. The maximum center
frequency is equal to the sample rate divided by two (the Nyquist frequency) minus one half the span.
The minimum center frequency is equal to one half of the span.

If the frequency span is set to maximum, then the center frequency will not move. To increase the
center frequency beyond the present limits, either reduce the frequency span or increase the sample
rate. To decrease the center frequency beyond the present limits, reduce the frequency span.

Frequency span

The frequency span is the range of frequencies over which the spectral analysis is performed. The
maximum span is from DC to one half of the sample rate (the Nyquist frequency). A smaller
frequency span allows a greater range of center-frequency adjustment. If a larger frequency span
is desired, increase the sample rate.
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Resolution bandwidth

The resolution bandwidth controls the bandwidth of the spectral analyzer filters. You can adjust the
resolution bandwidth in units of hertz. The resolution bandwidth is measured at the —3 dB points on
each side of the peak spectral lobe of the filter.

Resolution bandwidth is inversely proportional to the gate duration in the time domain. Changing the
gate duration changes the resolution bandwidth. Changing the spectral analyzer window function also
changes the resolution bandwidth but will not affect the gate duration.

To decrease the resolution bandwidth beyond the present limits, increase the time domain gate
duration. If this is insufficient, increase the record length and then increase the gate duration
again. You can also try the rectangular or Hamming window to maximize the frequency resolution
(minimize resolution bandwidth).

Set up spectral gating controls

From the Math menu, select Advanced Spectral, or click Advanced in the Math Setup control window.

To use

1. Select an FFT window type from the Window Type list.

Window Type
(Gaussian T

2. Click in the Gate Position, Gate Duration, or Gate Length entry boxes and use the multipurpose
knobs to set the gating parameters.

Giatineg
Gale Positin

[ oos
Gae Duration

T aps
Garle Length

Hatle: Gating

Behavior

An FFT Window Type (see page 908) can help reduce spectral noise for many types of signals. Some
windows provide better frequency resolution at the expense of better amplitude measurements. Other
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Spectral analysis overview

windows provide better amplitude accuracy over frequency resolution. The choice of window also affects
the resolution bandwidth.

Gate Position moves the gate that selects the data for the spectral waveform. The gate position is the
center point in the gate measured in seconds with respect to the trigger point. In most cases the phase
reference point is located at the center of the gated data. However, if you use a Tek Exponential
window, the phase reference point is at the 20% point of the gated data.

Gate Duration sets the gate time duration in seconds. The default gate duration is the duration of the
entire waveform record. The resolution bandwidth is inversely proportional to the gate duration.

Gate Length displays the gate length in points. The default gate duration is the duration of the entire
waveform record.

NOTE. The gating controls interact with the acquisition and frequency domain controls,; changing one set
of controls may change the other control settings.

What do you want to do next?

B Learn about selecting an FFT window. (see page 908)

® Learn about the Math Setup controls. (see page 247)

®  Learn about the Frequency controls. (see page 253)

Spectral analysis overview

You can use math waveforms to perform FFT (Fast Fourier Transform) measurements with the instrument.
The FFT process mathematically converts the standard time-domain signal (repetitive or single-shot
acquisition) into its frequency components, providing spectral analysis capabilities.

The ability to quickly look at signal frequency components and spectrum shape is a powerful research and
analysis tool. FFT is an excellent troubleshooting aid for the following:

Testing the impulse response of filters and systems
Measuring harmonic content and distortion in systems
Identifying and locating noise and interference sources
Analyzing vibration

Analyzing harmonics in 50 and 60 Hz power lines

Spectral analysis features

256

You can display an FFT waveform on any actively acquired signal (periodic or single-shot), the last
acquired signal, or any signal stored in reference memory.
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Spectral analysis features

FFT windows

The instrument allows you to match the optimum window to the signal you are analyzing.

The Rectangular window is best for nonperiodic events such as transients, pulses, and single-sequence
acquisitions.

The Hamming, Hanning, and Blackman-Harris windows are better for periodic signals.

The Kaiser Bessel window has less spectral leakage than the Hanning, Hamming, or Rectangular
windows.

The Gaussian window provides optimal localization in both the time and frequency domain.

The Flattop2 window is good for high accuracy magnitude measurements for signals that do not
require narrow resolution bandwidth.

The Tek Exponential window is useful for impulse response testing.

Vertical scales

The FFT vertical graticule can be set to either dB or Linear RMS.

A dB scale is useful when the frequency component magnitudes cover a wide dynamic range, letting
you show both lesser and greater magnitude frequency components on the same display.

A Linear scale is useful when the frequency component magnitudes are all close in value, enabling
direct comparison of their magnitudes.

Spectral and Time-Domain displays

Time signals and FFT waveforms can be shown together on the display. The time signal highlights the
problem; the FFT waveform helps you determine the cause of the problem.
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FFT process

The FFT process mathematically converts the standard time-domain signal (repetitive or single-shot
acquisition) into its frequency components.

The FFT function processes the waveform record and displays the FFT frequency domain record, which
contains the input signal frequency components from DC (0 Hz) to 2 the sample frequency (also called
the Nyquist frequency (see page 177)).

I Wavefarm record |

B

| FFT frequency domain record |

%

FFT
| | frequency-domain
waweform

OHz — & 12 Sample
frequency

The FFT display

The following illustration shows a typical time-domain waveform and the frequency components of that
signal as part of the math FFT waveform.
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FFT windows

The FFT process assumes that the part of the waveform
record used for FFT analysis represents a repeating
waveform that starts and ends at or near the same voltage Time-doemain | aveform
of a cycle. In other words, it is an integer number of cycles. wanefarm 1 g points
When a waveform starts and ends at the same amplitude, :
there are no artificial discontinuities in the signal shape, and
both the frequency and amplitude information is accurate.

A nonintegral number of cycles in the waveform record

| Discontinuities

causes the waveform start and end points to be at different |

amplitudes. The transitions between the start and end

points cause discontinuities in the waveform that introduce i

high-frequency transients. These transients add false

frequency information to the frequency domain record. ,._".

Applying a window function to the waveform record changes .

the waveform so that the start and stop values are close to Nithaut windawing

each other, reducing the discontinuities. This results in an Boure

FFT measurement that more accurately reflects the actual waeform VWV\

signal frequency components. The shape of the window o Waveform

determines how well it resolves frequency or magnitude data peints |

information. @ | Paintty-paint
bomulliphy

_A_ Wirdow
O | Furetion
| (Hannirkg)

P R
L ~— Wavefemn after

=
b

With windawing
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FFT window characteristics

260

FFT window characteristics

Each FFT window is a trade-off between frequency resolution and magnitude accuracy. What you want to
measure and your source signal characteristics help determine which window to use. Use the following
guidelines to select the best window.

FFT window

Characteristics

Best for measuring

Rectangular

Best frequency, worst magnitude
resolution. This is essentially the
same as no window.

Transients or bursts where the signal
levels before and after the event are
nearly equal.

Equal-amplitude sine waves with
frequencies that are very close.

Hamming, Hanning

Better frequency, poorer magnitude
accuracy than Rectangular. Hamming
has slightly better frequency resolution
than Hanning.

Sine, periodic, and narrow-band
random noise.

Transients or bursts where the signal
levels before and after the event are
significantly different.

Blackman-Harris

Best magnitude, worst frequency
resolution.

Predominantly single frequency
signals to look for higher order
harmonics.

You can also determine the best window empirically by first selecting the Rectangular window, and
then selecting (in the following order) the Hamming, Hanning, and Blackman-Harris windows until the
frequency components merge. Use the window just prior to where the frequencies emerge for the best
compromise between resolution and amplitude accuracy.
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Time domain gating

You can use time domain gating to select a specific segment of your signal for spectral analysis. Two
controls, gate position and gate duration, determine the location and size of the gate.

The resulting spectrum corresponds to the frequency components of the signal in the gated segment.

l-'- Gate posiion ———=

Duration
p—— J7aro phaze refarence

Time domain acquisiton

1

Trigger
position

Freguency domain samples

Time domain gating

Time domain gating is inversely proportional to the resolution bandwidth of the spectral waveform. The
narrower the gate, the larger the resolution bandwidth and the lower the frequency resolution. To obtain
the best frequency resolution, use as wide a gate as possible.
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Aliasing

Problems occur when the instrument acquires a signal containing frequency components that are higher
in frequency than the Nyquist frequency (see page 177). The frequency components that are above the
Nyquist frequency are under sampled and appear to "fold back" around the Nyquist frequency, showing as
lower frequency components. These incorrect components are called aliases.

To quickly check for aliasing, slowly decrease the horizontal time scale. If the shape of the displayed
waveform changes drastically or becomes stable, your waveform is probably aliased. You can also check
for aliasing by turning on peak detect acquisition mode. To remove aliasing, modify the record length.

Myquist frequensy
O Hz {12 samphe rate)

b Frequeney 4
Ir ....................................

Arnplilude

Eliminate aliasing

262

Use the following methods to eliminate aliases:

B [ncrease the sample rate by adjusting the horizontal scale to a faster time-per-division setting. Since
you increase the Nyquist frequency (see page 177) as you increase the time per division, the aliased
frequency components should appear at their proper frequency. If the increased number of frequency
components shown on the screen makes it difficult to measure individual components, use MultiView
Zoom to magnify the FFT waveform.

B Use a filter on the source signal to limit the bandwidth of the signal to frequencies below that of
the Nyquist frequency. If the frequency components that you want to view are below the built-in
bandwidth settings, set the source channel bandwidth to the appropriate value.

m  Push the Autoset button.

B Switch the acquisition to Envelope mode or Peak Detect mode (see page 198). Envelope mode
searches for samples with the highest and lowest values over multiple acquisitions and can detect
faster signal components over time. In Peak Detect mode, the acquisition alternates between saving
the highest sample in one acquisition interval and lowest sample in the next acquisition interval.
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Math Equation Editor control window

From the Math menu, select Equation Editor, or click the Editor button in the Math Setup or Spectral
Setup control windows.

Overview

Use the Math Equation Editor control window to define or edit math waveforms. The readout shows the
math expression as you construct it. New functions are added at the beginning of the expression each time
you click one of the function buttons.

To use

For information on the controls, click the buttons.

. Average Sqrt

Qe G @b

Integral

Behavior
You can create a math expression using one or more of the following approaches:

B Open the tabs and click one or more of the buttons to insert functions into the math expression. Then
select one of the waveforms as an operand by clicking one of the Channels Selector (see page 264).
Use the edit controls to add additional numbers and operators to complete the math expression.

B Connect an external keyboard and use it to enter the math expression.

B Create a math expression using an external text editor or another application. Copy the text to the
Windows clipboard. Right-click with the mouse to paste the text into the math expression.

If you create a math expression that is longer than the physical space in the control window readout, you
can scroll through the expression using the Text Edit controls (see page 265).
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To edit another math waveform, select the waveform from the Math (n) drop-down list in the Equation
Editor control window.

To open a Math Averaging (see page 247) control window, where you can specify the number of times
the math waveform is to be averaged, click Avgs.

Click Apply to apply the math expression to the selected waveform.

For additional information on creating math waveforms, see Guidelines for Working with Math Waveforms

(see page 826).

What do you want to do next?

B Learn about the Math Setup controls. (see page 247)

® Learn about using math functions with math waveforms. (see page 265)

Channels selector

Specify the Ch <1 - 4> and waveform type (Channel, Math, or Reference) for oscilloscope operations.
m  Click Ch and specify a channel to dedicate the controls for use with an input on the front panel.

B Click Math to dedicate the controls for use with a math waveform.

B Click Ref to dedicate the controls for use with a reference waveform.

®  Shaded buttons Indicate unused or undefined waveforms.

Il o G

|

264 MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series



Math setups Math equation editor (Time tab)

Text edit controls
Use the following controls to edit the Math expression.

Moves the text insertion point to the left of the first
character in the expression.

Moves the text insertion point one character to the left.

Moves the text insertion point one character to the right.

Deletes the character to the left of the insertion point.

Moves the text insertion point to the right of the last
character in the expression.

Clears the entire math expression.

feree

Math equation editor (Time tab)

From the Math menu, select Equation Editor; then open the Time tab.

To use

Click a control to insert time domain functions into the math expression.

Average (see Sart (see FABS (see Sin (see Cos (see Tan (see

page 919) age 266 age 266 page 267) age 267 page 268)
Integral (see Log 10 (see Ceil (see ASin (see ACos (see ATan (see
page 266) page 267) age 267 page 268) age 268 page 268)
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266

Derivative (see Log e (see Floor (see Sinh (see Cosh (see Tanh (see
page 266) page 267) page 267) page 268) page 268) page 268)
Invert (see Exp (see Min (see Max (see WImDB (see
page 267) age 267 age 278 page 278) page 268)

2. Click More to add additional functions.

Behavior

You can use any of the channels as arguments for the function. You can also create nested functions by
inserting one function into the argument portion of another.

Consider the following when working with math waveforms:

B Scale and position the source waveform so it is contained on-screen; off-screen waveforms may be
clipped, resulting in errors in the math waveform.

B Use the vertical position and vertical offset to position the source waveform. The vertical position will
not affect the math waveform unless you position the source waveform off screen so that it is clipped.

What do you want to do next?

B Learn about the Spectral Setup controls. (see page 268)

B [ earn about using the measurement list with math waveforms. (see page 270)

Integral

Inserts the text INTG( into the math expression. Enter an argument to the function. The integral
function produces the integral of the argument.

Derivative

Inserts the text DIFF( into the math expression. Enter an argument to the function. The derivative
function produces the derivative of the argument.

Absolute value

Inserts the text FABS( into the math expression. The FABS function takes the absolute value of
the expression.

Square root

Inserts the text SQRT( into the math expression. Enter an argument to the function. The square root
function produces the square root of the argument.
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Math equation editor (Time tab)

Base 10 logarithm

Inserts the text LOG( into the math expression. Enter an argument to the function. The log function
produces the base 10 logarithm of the argument.

Smallest integer

Inserts the text CEIL( into the math expression. The CEIL function takes the largest integer > the
expression.

Natural logarithm
1. Inserts the text LN( into the math expression.
2. Enter an argument to the function.

The LN function produces the natural logarithm of the argument.

Largest integer

Inserts the text FLOOR( into the math expression. The FLOOR function takes the largest integer <
the expression.

Invert

Inserts the text INV( into the math expression. Enter an argument to the function. The invert function
inverts the argument within the parentheses.

Natural antilog
1. Inserts the text EXP( into the math expression.
2. Enter an argument to the function.

The natural antilog function raises e to the power of the argument.

Sine

Inserts the text SIN( into the math expression.

Cosine

Inserts the text COS( into the math expression.
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Math equation editor (Spectral tab)

Tangent

Inserts the text TAN( into the math expression.

Arc sine

Inserts the text ASIN( into the math expression.

Arc cosine

Inserts the text ACOS( into the math expression.

Arc tangent

Inserts the text ATAN( into the math expression.

Hyperbolic sine

Inserts the text SINH( into the math expression.

Hyperbolic cosine

Inserts the text COSH( into the math expression.

Hyperbolic tangent

Inserts the text TANH( into the math expression.

WfmDB

Inserts the text WFMBD( into the math expression. The WfmBD features accumulates sampling

information into a data base.

Math equation editor (Spectral tab)

From the Math menu, select Equation Editor; then open the Spectral tab.

To use

Click a control to insert spectral analysis functions into the math expression.

1.

268

Click one of the Predefined Functions to insert a Spectral function into the math expression.
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Mag (see page 269) Real (see page 269) Phase (see page 290) Imaginary (see page 269)

2. Select one of the defined waveforms as an argument using the Channels Selector (see page 264).

Prrimifive

Predefined
Satup Functions

| - @
- G

Behavior

You can use any of the channels as arguments for the function. Create nested functions by inserting
a function into the argument portion of another.

What do you want to do next?

B [earn about the Spectral Setup controls. (see page 252)

B Learn about using math functions with math waveforms. (see page 265)

B Learn about using the Measurement list with math waveforms. (see page 270)

Magnitude

Inserts the text SpectralMag( into the math expression. Select one of the waveforms as an argument to
the function. This function creates an FFT magnitude waveform.

Real number

Inserts the text SpectralReal( into the math expression. Select one of the waveforms as an argument to
the function. This function creates a waveform that displays only the real part of the FFT.

Imaginary number

Inserts the text Spectrallmag( into the math expression. Select one of the waveforms as an argument
to the function. This function creates a waveform that displays only the imaginary part of the FFT.
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Math equation editor (Var tab)

From the Math menu, select Equation Editor; then open the Var tab.

To use

1. Click in a Var <1-8> = entry box and use the multipurpose knobs to enter a value for the variable.
2. Click More to add additional variables

3. Click the associated button to enter that variable into the math expression.

4

Click Controls to access the Math Variables (see page 248) control window.

Primitine
- R
@v[ [T
& v
m;@ e

Behavior

You can assign up to eight different variables to add to your math expression.
B Clicking a Var <1-8> button enters the variable into the math expression.
®  Clicking the More button accesses the other four variables.

B The Controls button activates the Math Variables control window where you can quickly set or
change the math variables.

What do you want to do next?

®m Learn about the Edit controls. (see page 818)

B earn about the Math Variable controls. (see page 248)

Math equation editor (Meas tab)

From the Math menu, select Equation Editor; then open the Meas tab.
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To use
1. Use the list to enter one of the predefined measurements into the math expression.

2. Click the button adjacent to an item to insert the measurement into the expression.

Prrimifive

eeee
eeee

Behavior

The list contains the measurements defined in the Measurement control window. The buttons are only
active for defined measurements; they are unavailable for any undefined measurements.

Measurements are continuously updated on live acquisitions. The most recent measurement values are
always used in math expressions.

What do you want to do next?

® [earn about the Edit controls. (see page 818)

Math equation editor (Filter tab)

From the Math menu, select Equation Editor; then open the Filter tab.

To use
Use these controls to insert spectral analysis-based functions into the math expression.
1. In the Math Equation Editor control window, click a Load button.

2. In the Open dialog box, navigate to the location of the filter you want to load. You will find a selection
of available Math Arbitrary Filters (see page 859) in C: /TekScope/Math Arbitrary Filters,
or browse to the location of any custom filters.

3. Select the filter you want to use; then click Open.

4. Click the corresponding Flt <1-8> button (that you used to load the filter) to insert its function into
the math expression.

5. You can select one of the defined waveforms as an argument using the Channels Selector (see

page 264).
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6. Edit the math expression using the Operands and edit controls if needed.

7. When you finish building the expression, click Apply.

User-defined Arbitrary Filters

Re-load from file

T ‘

Behavior

You can use any of the channels as arguments for the function. Create nested functions by inserting
a function into the argument portion of another.

What do you want to do next?

®m Learn about the Spectral Setup controls. (see page 252)

B earn about using math functions with math waveforms. (see page 265)

B [Learn about using the Measurement list with math waveforms. (see page 270)
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Measurement Snapshot control window

From the Measure menu, select Measurement Snapshot.
Overview
Measurement Snapshot lists all of the automated measurements that are available for a selected waveform.

Measurement Snapshot on Ch 2

Heasurement Context

Period 995 Aus Fren 1 lkHz
Pos Width 406 Ahps Meg Width 02 24 Base, Top Form Histogram Mode
Burst id 3 Mz High Ref A0.0%
Rise: Tirme 251 Bps Fall Titne 281 Hps hidl Rt 50.0%
+ Duty Gy 49 72% - Duty Gy Al 28% Lo Ref 10 0%

+(hiershact 4 73% -Owershact i 4%
Max 2 By High P
Wlin 2 By Lowy i
Armpliade 4 Tyt Pk-Pk a2
Mean 1 Af Cyele Mean 1 3T
RME 1. Ty Cycle RMS 176y
Prea A 2Bvs  Cye Area 1 30w

To use
1. Select the waveform for which you want to take a snapshot.

2. Click the Snapshot button in the Measurement control window, or select Snapshot from the Measure
menu.

3. Click either General or Comm in the Snapshot Type group box to begin the snapshot.

Behavior

When the instrument has completed all of the measurements, the snapshot window is updated with the
measurements.

Measurement Snapshot executes all of the single waveform measurements once; the measurements are not
continuously updated. Any measurements previously taken are retained on the display until you complete
a new snapshot. To take another snapshot, click the Refresh button.

NOTE. Automatic measurements are not available on digital channels.

TIP. Before taking a snapshot, be sure to properly display the waveform. Measurement Snapshot does
not warn you if a waveform is improperly scaled (for example, clipped, low signal amplitude, low
resolution, and so on).
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To change the source for taking a snapshot, select another channel, math, or reference memory waveform
and then execute snapshot again.

TIP. For information on measurement algorithms, refer to the Automatic Measurement Algorithms and
Methods for High-Performance Communications Applications application note, 85w _15763.pdf. This
application note is available from the www.tektronix.com Web site.

What do you want to do next?

B Return to the Measurement control window overview. (see page 274)

Measurement Setup control window (Amplitude tab)

274

From the Measure menu, select Measurement Setup; then open the Ampl tab.

Overview

Use this control window to set up the instrument for taking automatic amplitude measurements.

To use

For information on the controls, click the buttons.

Behavior
From this control window, you can do the following:
B Define amplitude measurements for the selected waveforms.

m  Select a waveform source using the Channels Selector (see page 264). You can measure live
waveforms, math waveforms, or reference waveforms.
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Measurement setups Measurement readouts

B Create a list of measurements to appear in the main graticule or in a separate measurement window.
B Define the unique reference levels for each measurement.

= Use gating to limit the measurements to a specific area of the waveform.

B Set up measurement statistics.

®  Set up histograms to evaluate specific regions of the waveform.

TIP. Turn on Fast Acquisitions to enhance your measurements. In Fast Acquisitions mode, measurements
are calculated on an array of acquired waveforms.

If three or more channels are displayed, Fast Acquisitions mode is turned off, and then the requested
measurements are made. Fast Acquisitions mode is not automatically turned back on when you select
fewer than three channels.

NOTE. Some measurements are less accurate using Fast Acquisitions mode, for example, timing
measurements.

Automatic measurements are not available on digital channels.

What do you want to do next?

®  Go to a step-by-step procedure to set up the instrument for taking measurements. (see page 608)

Measurement readouts

An Info (information) column in the measurement readout area displays icons that indicate the status of
each measurement. When an error icon displays, the instrument also displays an error code.

For a list of instrument error codes, messages, and definitions, refer to the Programmer guide available
on the product software DVD or from www.tektronix.com/manuals.

The next table shows some of the icons with examples of their meaning.

TIP. If you hover the mouse pointer over the displayed icon, the instrument displays more specific
information on the measurement status.

Icon Meaning example

r@ The instrument is in the process of acquiring data and calculating the measurement.
b=

- The instrument encountered an error.

&,
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Icon Meaning example

[, The instrument cannot locate the specified edge of the signal.

&)

rm The instrument cannot measure a waveform that is “clipped” on the screen.
=

Fa The instrument cannot locate the specified signal.

&

Null waveform data that is seen during measurements is usually seen when using ET mode, when the
instrument is still filling the waveform record. Warnings appear in the measurement readouts because of
ET mode, but eventually go away once the waveform record fills in. Filters can also cause null waveform
data, and measurements on the resulting math waveforms result in warnings.

Select an amplitude measurement

From the Measure menu, select Measurement Setup; then open the Ampl tab.

To use
Use the Ampl tab to select automatic amplitude measurements.

1. Select a source with the Channels Selector (see page 264).

2. Click a Measurements button to add an Amplitude measurement to the Measure list:

Amplitude (see page 277) Low (see page 278) +Qvrshoot (see page 279)
AC RMS (see page 277) Max (see page 278) -Ovrshoot (see page 279)
Pk-Pk (see page 278) Min (see page 278 Mean (see page 279)

RMS (see page 278) Cycle RMS (see page 278) Cycle Mean (see page 279)

High (see page 278)
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Measurements Measurements

RMS Max Cycle RMS Mean

High Min +0vrshoot Cycle Mean
Low -Ovrshoot

3. Click Display On in the upper-right corner of the Measurement Setup Control Window (see page 274)

to turn the measurement display on and off.

Behavior

Measurements are updated approximately three times a second, or less for long record lengths.
Measurements are calculated after each acquisition. You can display up to eight automatic measurements.

TIP. Select the individual measurements directly from the Measure menu Amplitude submenu.

What do you want to do next?

Learn about taking timing measurements. (see page 279)

Learn about taking histogram measurements. (see page 296)

Learn about other measurements. (see page 288)

Learn about communication measurements. (see page 284)

Learn more about the Measurements list. (see page 872)

Learn more about the Measurement controls. (see page 292)

Amplitude

This voltage measurement is the high value minus the low value measured over the entire waveform
or gated region:

Amplitude = High — Low

AC RMS

This voltage measurement is the true Root Mean Square voltage over the measurement region.
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Peak to Peak

This voltage measurement is the absolute difference between the maximum and minimum amplitude
in the entire waveform or gated region.

RMS

This voltage measurement is the true Root Mean Square voltage over the entire waveform or gated
region.

High

The high level measurement is the value used as 100% whenever high reference, mid reference, or
low reference values are needed, such as in fall time or rise time measurements. This value can be
calculated using either the min/max or histogram method. The min/max method uses the maximum
value found. The histogram method uses the most common value found above the midpoint. This
value is measured over the entire waveform or gated region.

Low

The low level measurement is the value used as 0% whenever high reference, mid reference, or low
reference values are needed, such as in fall time or rise time measurements.

This value can be calculated using either the min/max or histogram method. The min/max method
uses the minimum value found. The histogram method uses the most common value found below the
midpoint. This value is measured over the entire waveform or gated region.

Maximum

This voltage measurement is the maximum amplitude. It is typically the most positive peak voltage
and is measured over the entire waveform or gated region.

Minimum

This voltage measurement is the minimum amplitude. It is typically the most negative peak voltage
and is measured over the entire waveform or gated region.

Cycle RMS

This voltage measurement is the true Root Mean Square voltage over the first cycle in the waveform
or the first cycle in the gated region.
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Positive Overshoot
This voltage measurement is measured over the entire waveform or gated region.

Positive Overshoot = (Maximum — High) x Amplitude 100%

Negative Overshoot
This voltage measurement is measured over the entire waveform or gated region and is expressed as:

Negative Overshoot = (Low — Minimum) x Amplitude x 100%

Mean

This voltage measurement is the arithmetic mean over the entire waveform or gated region.

Cycle Mean

This voltage measurement is the arithmetic mean over the first cycle in the waveform or the first
cycle in the gated region.

Measurement Setup control window (Time tab)

From the Measure menu, select Measurement Setup; then open the Time tab.

Overview

Use this control window to set up the instrument for taking automatic time measurements.

To use

For information on the controls, click the buttons.

MmN S
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Behavior

From this control window, you can do the following:

Define time measurements for the selected waveforms.

Select a waveform source using the Channels Selector (see page 264). You can measure live
waveforms, math waveforms, or reference waveforms.

Create a list of measurements to appear in the main graticule or in a separate measurement window.
Define the unique reference levels for each measurement.

Use gating to limit the measurements to a specific area of the waveform.

Set up measurement statistics.

Set up histograms to evaluate specific regions of the waveform.

NOTE. Automatic measurements are not available on digital channels.

TIP. Turn on Fast Acquisitions to enhance your measurements. In Fast Acquisitions mode, measurements
are calculated on an array of acquired waveforms. As the waveforms accumulate (with persistence on),
your measurement accuracy may increase. However, only one or two channels can be displayed when you
take automatic measurements using Fast Acquisitions mode.

If three or more channels are displayed, Fast Acquisitions mode is turned off, and then the requested
measurements are made. Fast Acquisitions mode is not automatically turned back on when you select
fewer than three channels.

What do you want to do next?

m Go to a step-by-step procedure to set up the instrument for taking measurements. (see page 608)

Select a time measurement

Type From the Measure menu, select Measurement Setup; then open the Time tab.

To use

Use the Time tab to select automatic time measurements.

1.
2.

280

Select a source with the Channels Selector (see page 264).

Click a Measurements button to add a Time measurement to the Measure list:
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Rise Time (see page 281) Pos Width (see page 282) Period (see page 282)

Fall Time (see page 281) Neg Width (see page 282) Freq (see page 282)

+Duty Cycle (see page 282) -Duty Cycle (see page 282) Delay (see page 282)
Fdras erenils

3. Click Display On in the upper-right corner of the Measurement Setup Control Window (see page 279)
to turn the measurement display on and off.

Behavior

Measurements are updated approximately three times a second, or less for long record lengths.
Measurements are calculated after each acquisition. You can display up to eight automatic measurements.

A new control window opens when you click Delay (see page 888). Enter the parameters for the
delay measurement, and then click Ok to return to the Measurement Setup control window. The delay
measurement is added to the list.

TIP. Select the individual measurements directly from the Measure menu Time submenu.

Rise Time

This timing measurement is the time required for the leading edge of the first pulse in the waveform
or gated region to rise from the low reference value (default = 10%) to the high reference value
(default = 90%) of the final value.

Fall Time

This timing measurement is the time required for the falling edge of the first pulse in the waveform
or gated region to fall from the high reference value (default = 90%) to the low reference value
(default = 10%) of the final value.
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Positive Duty Cycle

This timing measurement is the ratio of the positive pulse width to the signal period expressed as a
percentage.

The duty cycle is measured on the first cycle in the waveform or gated region.

Positive Duty Cycle = (Positive Width) x Period x 100%

Positive Width

This timing measurement is the distance (time) between the mid reference (default 50%) amplitude
points of a positive pulse.

The measurement is made on the first pulse in the waveform or gated region.

Negative Width measurement

This timing measurement is the distance (time) between the mid reference (default 50%) amplitude
points of a negative pulse.

The measurement is made on the first pulse in the waveform or gated region.

Negative Duty Cycle

This timing measurement is the ratio of the negative pulse width to the signal period expressed as a
percentage. The duty cycle is measured on the first cycle in the waveform or gated region.

Negative Duty Cycle = (Negative Width) X Period x 100%

Period

This measurement is the time required to complete the first cycle in a waveform or gated region.
Period is the reciprocal of frequency and is measured in seconds.

Frequency

This timing measurement is a measure of the first cycle in a waveform or gated region. Frequency is
the reciprocal of the period; it is measured in Hertz (Hz) where one Hz is one cycle per second.

Delay

This timing measurement is the time between the mid reference (default 50%) amplitude point
of two different waveforms
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Measurement Setup control window: (Communications tab)

From the Measure menu, select Measurement Setup; then open the Comm tab.

Overview

Use this control window to set up the instrument for taking automatic communications measurements.

To use

For information on the controls, click the buttons.

llllnﬂm Setup

Behavior
From this control window, you can do the following:
B Define communications measurements for the selected waveforms.

m  Select a waveform source using the Channels Selector (see page 264). You can measure live
waveforms, math waveforms, or reference waveforms.

B Create a list of measurements to appear in the main graticule or in a separate measurement window.
m  Define the unique reference levels for each measurement.

B Use gating to limit the measurements to a specific area of the waveform.

®  Set up measurement statistics.

m  Set up histograms to evaluate specific regions of the waveform.

NOTE. Automatic measurements are not available on digital channels.
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TIP. Turn on Fast Acquisitions to enhance your measurements. In Fast Acquisitions mode, measurements
are calculated on an array of acquired waveforms. As the waveforms accumulate (with persistence on),
your measurement accuracy may increase. However, only one or two channels can be displayed when you
take automatic measurements using Fast Acquisitions mode.

If three or more channels are displayed, Fast Acquisitions mode is turned off, and then the requested
measurements are made. Fast Acquisitions mode is not automatically turned back on when you select
fewer than three channels.

What do you want to do next?

B Go to a step-by-step procedure to set up the instrument for taking measurements. (see page 608)

Select a communications measurement

From the Measure menu, select Measurement Setup; then open the Comm tab.

To use
Use the Comm tab to select automatic communications measurements.

1. Select a source with the Channels Selector (see page 264).

2. Click a Measurements button to add a Communications measurement to the Measure list:

Ext Ratio (see page 285) Eye Width (see page 286) Jitter P-P (see page 286) Noise RMS (see

page 287)
ExtRatio% (see page 285) Crossing% (see Jitter RMS (see page 287) SIN Ratio (see page 287)
page 286)
Ext Ratio (dB) (see Eye Top (see page 286) Jitter 6s (see page 287) CycDistorition (see
page 286) page 287)
Eye Height (see page 286) Eye Base (see page 286) Noise P-P (see page 287) Q-Factor (see page 287)
Fdsas s 1 Measuraments
m ExlRatio  EynHeight  Fyve Top | MErPP  WossPP  Distersion
m ExRalich  EyeWillh  Eyn Base | Jiler AMS  NoisePMS  O-Factor
3 ;ﬂm () | - @ @
et | (4] Crossmips . Juter gg S.M Ratin

3. Click Display On in the upper-right corner of the Measurement Setup Control Window (see page 283)
to turn the measurement display on and off.
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Behavior

Measurements are updated approximately three times a second (or less for long record lengths).
Measurements are calculated after each acquisition. You can display up to eight automatic measurements.

TIP. Most Comm measurements require either WfinDB or FastAcq mode.

You may need to select Infinite Persistence display mode (see page 173) to accumulate enough data
for the Comm measurement to work.

NOTE. You can also select the individual measurements directly from the Measure menu Comm submenu.

What do you want to do next?

®m  Learn about taking amplitude measurements. (see page 276)

Learn about taking timing measurements. (see page 279)

Learn about other measurements. (see page 288)

B Learn more about the measurement list. (see page 872)

B Learn more about the measurement controls. (see page 292)

Extinction Ratio

Extinction ratio is the ratio of eye top to base. This measurement is only valid when the acquisition
mode is set to WmDB, FastAcq is enabled, or the measurement is taken on a reference waveform
saved in FastAcq mode.

Ext Ratio = pTopMean/pBaseMean

Extinction Ratio Percent
Extinction ratio percent is the ratio of eye base to top expressed as a percentage.

This measurement is only valid when the acquisition mode is set to WfmDB, FastAcq is enabled, or
the measurement is taken on a reference waveform saved in FastAcq mode.

Ext Percent = 100 x (pTopMean/pBaseMean).
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Extinction Ratio Decibel
Extinction ratio decibel is the ratio of eye top to base expressed in decibels.

This measurement is only valid when the acquisition mode is set to WfmDB, FastAcq is enabled, or
the measurement is taken on a reference waveform saved in FastAcq mode.

ExtdB = 10 x Log(pTopMean/pBaseMean)

Eye Height
Eye height is the measurement of the eye height in volts.

Eye Height = (pTopMean-3 x pTopSigma) - (pBaseMean + 3 X pBaseSigma)

Eye Width
Eye width is the measurement of eye width in seconds.

Eye Width = (tCross2Mean-3 x pTopSigma) - (tCross1Mean + *tCross1Sigma)

Crossing Percent
Crossing percent measurement is the eye crossing point expressed as a percentage of eye height.

Crossing Percent = 100 % [(pCross1Mean - pBaseMean)/(pTopMean - pBaseMean)]

Eye Top
Eye Top is the top value used in the extinction ratio measurements.

Eye Top = pTopMean

Eye Base
Eye Base is the base value used in the extinction ratio measurements.

Eye Base = pBaseMean

Jitter Peak-to-Peak

Jitter p-p is the peak-to-peak value for the edge jitter in the current horizontal units.

Jitter PP = TCross1PP
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Jitter Root Mean Square
Jitter RMS is the RMS value of the edge jitter in the current horizontal units.
Jitter RMS = TCross lsigma

Jitter 6 Sigma
Jitter 6 sigma is six times the RMS value of the edge jitter in the current horizontal units.

Jitter 6 sigma = 6 X (JitterRMS)

Noise Peak-to-Peak
Noise p-p is the peak-to-peak value of the noise of the top or base of the signal as specified by you.
To ensure accurate noise values, be sure to set the signal type to Eye when measuring an Eye signal.

Noise Pk-Pk = PToppk-pk or PBasepk-pk

Noise Root Mean Square
Noise RMS is the RMS value of the noise of the top or base of the signal as specified by you.
To ensure accurate noise values, be sure to set the signal type to Eye when measuring an Eye signal.

Noise RMS = PTopsigma or PBasesigma

Signal to Noise Ratio

S/N ratio is the ratio of the signal amplitude to the noise of the top or base of the signal as specified
by you.

S/N Ratio = (Ptop — Pbase)/(PTopsigma or PBasesigma)

Duty Cycle Distortion

Duty cycle distortion is the peak-to-peak time variation of the first eye crossing measured at the
MidRef as a percent of the eye period.

DCD(sec) = 100% x TDCDp-p/(TCross2mean — TCross1mean)

Quality Factor
Quality factor is the ratio of eye size to noise.

Quality Factor = (PTopmean — PBasemean)/(PTopsigma + PBasesigma)
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Measurement Setup control window (More tab)

288

From the Measure menu, select Measurement Setup; then open the More tab.

Overview

Use this control window to set up the instrument for taking miscellaneous measurements.

To use

For information on the controls, click the buttons.

_HII“III"IIH Setup

Behavior
From this control window, you can do the following:
B Define miscellaneous measurements for the selected waveforms.

m  Select a waveform source using the Channels Selector (see page 264). You can measure live
waveforms, math waveforms, or reference waveforms.

B Create a list of measurements to appear in the main graticule or in a separate measurement window.
m  Define the unique reference levels for each measurement.

B Use gating to limit the measurements to a specific area of the waveform.

®  Set up measurement statistics.

m  Set up histograms to evaluate specific regions of the waveform.

NOTE. Automatic measurements are not available on digital channels.
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TIP. Turn on Fast Acquisitions to enhance your measurements. In Fast Acquisitions mode, measurements
are calculated on an array of acquired waveforms. As the waveforms accumulate (with persistence on),
your measurement accuracy may increase. However, only one or two channels can be displayed when you
take automatic measurements using Fast Acquisitions mode.

If three or more channels are displayed, Fast Acquisitions mode is turned off, and then the requested
measurements are made. Fast Acquisitions mode is not automatically turned back on when you select

fewer than three channels.

What do you want to do next?

B (Go to a step-by-step procedure to set up the instrument for taking measurements. (see page 608)

Select a miscellaneous measurement

From the Measure menu, select Measurement Setup; then open the More tab.

To use

Use the More tab to select measurements not found under any of the other measurement tabs.

1. Select a source with the Channels Selector (see page 264).

2. Click a Measurements button to add a More measurement to the Measure list:

Area (see page 290) Cyc Area (see page 290)
Phase (see page 290) Burst Width (see page 290)
Measurements

Area Burst Width
Cyc Area

Phase

3. Click Display On in the upper-right corner of the Measurement Setup Control Window (see page 288)
to turn the measurement display on and off.
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290

Behavior

Measurements are updated approximately three times a second, or less for long record lengths.
Measurements are calculated after each acquisition. You can display up to eight automatic measurements.

A new control window opens when you click Phase (see page 890). Enter the parameters for the
phase measurement, and then click Ok to return to the Measurement Setup control window. The phase
measurement is added to the list.

TIP. Select the individual measurements directly from the Measure menu More submenu.

What do you want to do next?

B [earn about taking automatic phase measurements. (see page 890)

B [earn about taking amplitude measurements. (see page 276)

®  [earn about taking timing measurements. (see page 279)

B [earn about taking histogram measurements. (see page 296)

B [earn about communications measurements. (see page 284)

®  [earn more about the Measurements list. (see page 872)

B [earn more about the Measurement controls. (see page 292)

Area

Area is a voltage-over-time measurement. The measurement is the area over the entire waveform or
gated region expressed in volt-seconds. The area above the common reference point is positive while
the area below the common reference point is negative.

Cycle Area

The cycle area is a voltage over time measurement. The measurement is the area over the first cycle
in the waveform or the first cycle in the gated region expressed in volt-seconds. The area above the
common reference point is positive while the area below the common reference point is negative.

Phase

This timing measurement is the amount of time that one waveform leads or lags another waveform.
The measurement is expressed in degrees where 360° comprise one waveform cycle.

Burst Width

This timing measurement is the duration of a burst (a series of transient events) and is measured over
the entire waveform or gated region.
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Set up measurement statistics

From the Measure menu, highlight Statistics; then select Statistics Controls from the submenu, or click the
Statistics button in the Measurement Setup window.

Overview

Use the Measurement Statistics control window to display statistical calculations on measurements. The
control window contains controls that determine which statistics are displayed in the measurement window.

Measurement Statistics
o Pdan Al Wsightl n=-

() L =

To use
B Click Off to turn the measurement statistics display off.
B Click Mean to display the value and the mean (p) of each measurement.
m  Click All to display the statistics for each measurement value.
(n) Mean
(m) Minimum
(M) Maximum
(s) Standard Deviation
(n) Population
m  Click in the Weight entry box, and then use the multipurpose knobs to set the statistics weight.

B Click Reset to restart the statistics calculations.

TIP. Select the individual statistics directly from the Measure menu Statistics submenu.

Behavior

Measurement values continue as live updates while the statistics accumulate over time. The statistics
appear on the main screen when a control window is open or on the right side of the screen when no
control windows are open and there are less than four measurements active. The color of the statistics
match the color of the waveform from which the measurement was taken.

The statistics weight specifies the constant used to calculate the mean and standard deviation; the minimum
and maximum values are unaffected by weighting. A large value produces statistics that vary less over time.
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All statistics (mean, minimum, maximum, standard deviation, and population) are always gathered even
though the mean may be the only statistic shown. When measurements are turned on, the acquisitions take
longer because measurements and statistic calculations are done on each acquisition.

What do you want to do next?

B Return to the Measurement Setup control window overview. (see page 274)

B Learn about setting the Reference Level controls. (see page 292)

®m  Learn about using gating to specify measurement areas. (see page 295)

Set up reference levels

292

From the Measure menu, select Reference Levels, or click the Ref Levs button in the Measurement
Setup window.

Overview

Use the Reference Levels control window to define unique reference levels for each measurement. The
default reference levels serve most general-purpose measurements. You can customize all measurements
to use different reference levels.

Reference Levels Setup
B Lt =, e

All Measures

To use

®  Click the Min-Max button to derive the reference levels from the minimum and maximum values of
the waveform record. If you want to derive the reference levels based on statistical data, click the
Histogram or the Histogram mean button.

B Refer to the graphic in the center of the control window and determine the reference levels you
want to define. Click in the entry boxes associated with the desired reference level, and use the
multipurpose knobs to adjust the value.
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®  [fyou want the reference levels to be measured by volts, click the Absolute button under Units. To
measure the reference levels as a percentage, click the Percentage button.

B C(Click either Eye or Pulse to select the signal type.

Behavior

The following reference levels are included: High Reference (see page 294), Mid Reference (see
page 891), Low Reference (see page 295), and Mid2 Reference (see page 295).

Define the reference levels as percentages of the signal amplitude or as absolute values in vertical units by
clicking the appropriate button to define the Units selection. Use Percentage to have reference levels track
the signal. Use Absolute to set the reference levels to fixed values.

The top and base levels that the measurement system derives from a waveform influence the fidelity of
measurements. The measurement system can derive the reference levels from either the minimum and
maximum values of the waveform or from statistical data.
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Min-max uses the highest and lowest values of the
waveform record. This setting is best for examining
waveforms that have no large, flat portions at a common
value, such as sine waves and triangle waves - almost any
waveform except for pulses.

Set up reference levels

Min/Max Tracking Method

High [Max) H

Mid Ref

Low Min) U

Histogram Mode sets the values statistically. Using a
histogram, it selects the most common value either above or
below the midpoint (depending on whether it is defining the
high or low reference level). Since this statistical approach
ignores short-term aberrations (overshoot, ringing, and so
on), Mode is the best setting for examining pulses.

Mode Tracking Method

High §
i Histogram High

Rief Histogram Low

Histogram Mean sets the values statistically. Using a
histogram, it selects the mean or average value derived
using all values either above or below the midpoint
(depending on whether it is defining the high or low
reference level). This setting is best for examining eye
patterns and optical signals.

High F!.’..q;.— :
T E
[
Mg =]
Ret &
L..
I

What do you want to do next?

B Return to the Measurement Setup control window overview. (see page 274)

B [earn more about Measurement controls. (see page 295)

®  Learn about using Gating to specify measurement areas. (see page 295)

B [carn about using measurement Statistics. (see page 291)

High reference

The High Reference defines the high reference level of a waveform; the default level is 90%. This
reference level is used with the Low Reference level in the calculation of rise and fall times. To
change this level, click the control, and then set the level with the multipurpose knob.
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Low reference

The Low Reference defines the low reference level of a waveform; the default level is 10%. This
reference level is used with the High Reference level in the calculation of rise and fall times. To
change this level, click the control and then, set the level with the multipurpose knob.

Mid2 reference

The Mid2 reference defines the middle reference used on the second waveform specified in delay or
phase measurements; the default level is 50%. To change this level, click the control, and then set
the level with the multipurpose knob.

Set up measurement gating

From the Measure menu, highlight Gating; then select Gating from the submenu or click the Gating
button in the Measurement Setup window.

Overview

Use the Gating control window to limit the measurement area of the waveform to the region bounded by
the vertical bar cursors or to the left and right edges of a Zoom window.

[Huuummntﬁzﬁn: @ @ @ Tt =—
T ) @m) GO () ew

To use

m  To define the gating area with the vertical bar cursors, click Cursor, and then click either Indep or
Tracking to select the Track Mode. These buttons are only displayed when you click Cursor.

m  To define the gating area from a Zoom area, click one of the four Zoom buttons.
B To turn off measurement gating, click the Off button.

B Click Setup to return to the Measurement control window.

Behavior

Normally the instrument takes measurements over the entire waveform record. Gating lets you limit
measurements to a specific portion of the waveform. You can limit gating to the region bounded by the
vertical bar cursors or to the left and right edges of a Zoom area.

When you click Zoom (1-4) the Zoom window appears in the lower half of the display. Measurements are
taken within the boundaries of the Zoom area. You can only take measurements on one Zoom area at a time.
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When you click Cursor, measurements are taken within the boundaries of the vertical cursors. Use the
multipurpose knobs to move the cursors.

When you use vertical cursors to control the gating, you can also specify the cursor mode (see page 84).
Use the independent cursor mode to move the cursors one at a time with the multipurpose knobs. Use
the tracking mode to have the cursors track one another; moving Cursor 1 automatically moves Cursor
2 in tandem.

TIP. Click, hold, and drag across the part of the graticule that you want to measure. After you define the
measurement area, select Measurement Gating from the shortcut menu to place gating cursors around
the measurement area.

Use the same click, hold, and drag method to turn measurement gating off; just select Measurement
Gating Off in the shortcut menu.

What do you want to do next?

m  Return to the Measurement Setup control window overview. (see page 274)

B [earn more about using vertical bar cursors. (see page 81)

B [earn more about the Measurement controls. (see page 291)

m  [earn about setting the Reference Level controls. (see page 292)

B [earn about using Measurement Statistics. (sec page 291)

Set up histogram measurements

296

From the Measure menu, select Measurement Setup; then open the Histog tab.

To use
Use this control window to set up the instrument for taking histogram measurements.

For information on the controls, click the buttons.
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Measurement Setup

Behavior
From this control window, you can do the following:

B Define histogram measurements for the selected waveforms.

m  Select a waveform source using the Channels Selector (see page 264). You can measure live
waveforms, math waveforms, or reference waveforms.

®m  Create a list of measurements to appear in the main graticule or in a separate measurement window.
m  Define the unique reference levels for each measurement.

®m  Use gating to limit the measurements to a specific area of the waveform.

B Set up measurement statistics.

m  Set up histograms to evaluate specific regions of the waveform.

NOTE. Automatic measurements are not available on digital channels.

TIP. Turn on Fast Acquisitions to enhance your measurements. In Fast Acquisitions mode, measurements
are calculated on an array of acquired waveforms. As the waveforms accumulate (with persistence on),
your measurement accuracy may increase. However, only one or two channels can be displayed when you
take automatic measurements using Fast Acquisitions mode.

If three or more channels are displayed, Fast Acquisitions mode is turned off, and then the requested
measurements are made. Fast Acquisitions mode is not automatically turned back on when you select
fewer than three channels.

What do you want to do next?

B Go to a step-by-step procedure to set up the instrument for taking measurements. (see page 608)
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Set up histograms

From the Measure menu, select Waveform Histograms, or click the Histogram button in the Measurement
Setup window.

Overview

Use the Histogram control window to set up a vertical or horizontal histogram. Use vertical histograms to
measure signal noise and horizontal histograms to measure signal jitter.

istogram

Made is Off

To use

1. Use the Channels Selector (see page 264) to select the source waveform for the histogram
measurements.

2. Click the type of histogram you want to use for your measurement, Horiz (Horizontal) or Vert
(Vertical). When you make this selection, the instrument continues to calculate histograms until
you set Display to Off.

3. Click either Linear or Log to set the scaling.

4. Adjust the size of the histogram box (Horiz (see page 300) or Vert (see page 301)) by clicking Limits
under Adjust Histogram Box. Use the multipurpose knobs or keypad (see page 42) keypad to set the
box boundaries.

5. Move the location of the histogram box (Horiz (see page 302) or Vert (see page 303)) by clicking
Location under Adjust Histogram Box, and then use the multipurpose knobs or keypad to set the X
and Y locations.

NOTE. You must explicitly click the Histogram Mode Off button to stop accumulating histogram data.
You can also click Reset to start a new histogram.
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Behavior

A histogram consists of a series of narrow bins into which samples are counted. The histogram box defines
the graticule area of the histogram and the number of vertical or horizontal bins. Horizontal histograms
have a maximum of 1000 bins while vertical histograms have a maximum of 252 bins. The upper-most
and bottom-most bins are not displayed. They are used for tracking over-range and under-range hits and
can be obtained by saving the histogram data to a file.

The displayed width or height of the bin that contains the most counts is determined by the Histogram
Size control. The relative sizes for all other bins are scaled proportionally to the bin that contains the
most counts.

Histogram limits use the same units as the horizontal and vertical scale controls. When you specify the
histogram box in terms of location, the Y location control adjusts the bottom edges of the histogram while
the X location control adjust the left edge of the histogram box.

TIP. Here are several tips for using histograms:

Right-click in the Histogram box to access a shortcut menu that will allow you to quickly make changes
to the histogram.

Use the Measure menu or shortcut menu Reset Histogram command to reset all bin counts to 0.

Click, hold, and drag across part of the graticule where you want to set up a histogram and select
Histogram from the shortcut menu.

Use the same click, hold, and drag method to remove a histogram from the display. Select Histogram
Off from the shortcut menu.

You can turn the histogram display off and still accumulate histogram data. This enables you to view the
waveform without having the histogram obscure the data. Turn the histogram display on (use the Display
button on the right side of the control window) at any time to view the histogram.

Use the front-panel channel buttons to turn the source waveform display off so that the waveform does not
obscure the histogram. Data accumulation continues whether the waveform display is on or off-

The instrument can perform up to eight automated statistical measurements (see page 296) on the
histogram. Allow the histogram to accumulate data for a while, and then turn on the desired measurements.

You can use Fast Acquisitions mode with histograms. However, only one or two channels can be displayed.
If three or more channels are displayed, the Fast Acquisitions mode is turned off. The Fast Acquisition
mode is automatically turned back on when you select fewer than three channels.

What do you want to do next?

B Return to the Measurement Setup control window overview. (see page 274)
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Histogram box limits - horizontal

1. Select a mode:

3. Enter limits:

“[ coons] @ [ e0Oms @B
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Set histogram box limits - vertical

1. Select a mode:

2. Specify the adjustment:

3. Enter limits:

Top Lima

f 200wV @
Buottom Limit
[ 20myv B
Left Limit Fght Limit
| s00ns [ e0Ons
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Set histogram box location - horizontal

1. Select a mode:

3. Enter limits:

Y

 Pasilion
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® Position
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302 MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series



Measurement setups Set up histograms

Set histogram box location - vertical

1. Select a mode:

2. Specify the adjustment:

3. Enter limits:

Y Position
] wrom e
—
X Positbon
[ G0Ons @
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Control marks

From the Analyze menu, select Mark.

Overview

Use the Mark Control Window to manually set and clear marks on acquired waveforms in areas of interest.

To use

Use the controls in this window to set a mark on a waveform. You can return to the mark and analyze the
waveform in the area at a later time.

1.

Press the MultiView Zoom button on the instrument front panel. The instrument uses Zoom 1 to
set marks.

From the Menu bar, select Analyze > Mark.
Move the zoom box to the area of interest on the waveform with the multipurpose knob.

Use the controls described below to set and clear marks.

NOTE. Marks appear as either green or white triangles on-screen. Green triangles represent locations
placed automatically by the instrument; white triangles represent locations placed manually by the user.

Behavior

Use the Mark controls to set marks and analyze waveforms.

Description. Click in the entry box and use the pop-up keyboard to enter a description for the mark
you place.

Set/Clr. Click this button to add or delete a mark. Marks are placed on the waveform at center screen.

Prev/Next. Click these buttons to advance from one mark to another along the waveform.
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®  Cursor 1/Cursor 2. Click one of these buttons to position a cursor at the active mark.

B Zoom 2/Zoom 3. Click one of these buttons to zoom the area around the active mark. Zoom 1 is the
default used by the Search and Mark feature.

Select a search type

From the Analyze menu, select Search; then open the Select tab.

Overview

Use the controls in this window to set up the instrument to automatically search and place mark(s). The
instrument can search for and mark many of the same conditions that are available for triggers.

NOTE. Search and mark operations are not available on digital channels.

To use

For information on the controls, click the buttons.

Search - Select

Glitch Width Setup/Hold

Results Runt Window Pattern

® @ @

Transition Timeout

NOTE. The Edge search type is standard, all other search types are optional.

Behavior

You can search for and mark regions with particular edges, pulse widths, runts, logic states, rise and fall
times, setup and hold violations and bus types. You can also search on math and reference waveforms.
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Select the search type

From the Analyze menu, select Search; then open the Select tab.

Overview

Use these controls to select the type of search you want the instrument to perform to automatically place
marks on a waveform.

Edge Glitch Width Setup/Hold DDR Read A
& v v @ G
Bus Runt Window Pattern DDR Write
@ W o &
Transition Timeout State ngzd
@ W @ @

=d

To use
®  (Click a button to identify the type of search to perform.

B The search Type will appear under Type in the Type-Source table.

Behavior

Clicking a button places the search selection in the Type column of the Type-Source table

Select the search source

From the Analyze menu, select Search; then open the Select or Configure tabs.

Overview

The Source Selection windows allow you to specify the channel parameters used in the search.
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To use

1. In the Type-Source table, identify the search Type you want to use; then click the right arrow for
that search type under Source.

2. After the Source Selection window opens, identify the Channel, Source, Clock, or Logic parameters to
be used in the search.

3. Click OK

Behavior

Use the single Source Selection window to set the Channel parameters for an Edge, Glitch, Runt,
Transition, Width, Window, or Timeout search.

Use the dual Source Selection window to set the Clock and Data Source parameters for a Setup and
Hold search.

Search 1{Setup/Hold) n

E

Use the Logic Source Selection window to set the threshold parameters for a Pattern or State logic search.
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Configure a search

From the Analyze menu, select Search; then open the Configure tab.

Overview

Use the controls in this window to set up the instrument to automatically search and place marks.

NOTE. Search and mark operations are not available on digital channels.

To use

For information on the controls, click the buttons.

Search - Configure

[-]an | Type
Vv Edge
Configure BriPi 4 Bus

Behavior

Clicking an entry in the Type column activates the individual search controls, similar to the one shown
above. These controls vary depending on the search Type. Setting the search conditions is similar to
setting the parameters for an Event Trigger (see page 394).

NOTE. No information will be displayed in this window until you specify at least one search Type in
the Search Select Control Window (see page 306).

Copy search settings

From the Analyze menu, select Search; then open the Configure tab and press the Copy Settings button.
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Overview

Use these controls to copy settings from one search to another. You can also copy a trigger setting to a
search.

(Copysemings WY

To use

1. Set up the desired search(s) in the Search - Select window.

2. Set up the parameters for the search in the Search - Configure window.

3. Click the Copy Settings button to open the Copy Settings window.

4. In the From drop-down list box, select the search or trigger you want to copy.
5. In the To drop-down list box, select the search to copy the settings to.

6. Click the Copy button.

What do you want to do next?

B [earn about Search Advanced DDR Control Settings. (see page 311)

Set advanced DDR search settings

From the Analyze menu, select Search; then open the Configure tab.

Overview

Use the controls in these windows to set conditions for the instrument to automatically search and place
marks.
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To use

1. Under Type, select one of the following entries DDR Read, DDR Write, and DDR Read & Write
in the Select tab.

2. Specify a source for the selected DDR search in the Configure tab.
3. Click the Settings button to configure the advanced DDR settings.

Advanced DDR Control

= Use either Auto or Manual option in the Mode drop-down (under CS Level). When auto is
selected, the midlevel of the chip select source is automatically calculated, and values above
or below this voltage are used to gate mark generation. In custom mode, the specified level is
used as the midlevel.

= Specify a value in the Level entry box (under CS Level). This value is used when the CS Level
Mode is set to manual.

= Specify a value in the Hysteresis entry box (under Edge Detection). This value is used for edge
detection in the DDR algorithm.

= Specify a value in the Margin entry box (under Termination Logic).
What do you want to do next?

B Learn about Search Copy Settings (see page 310).

B earn about setting up DDR search parameters (see page 375).

Set search parameters

From the Analyze menu, select Search; then open the Configure tab.

Overview

Use the controls in these windows to set conditions for the instrument to automatically search and place
marks.
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To use

Set search parameters

The available controls depend on the searches you selected in the Search - Select Control Window.

1. Under Type, click on an entry in the Type-Source table.

2. Set up the controls for each search you want to perform.

3. Click the Search button to On to initiate a search.

Behavior

Refer to the following table for information on automated searches the instrument can perform. The search
controls are functionally similar to the trigger controls.

Search type Description Equivalent trigger
Edge Searches for edges (rising or falling) Edge Trigger Control Window (see
with a user-specified threshold level. page 431)
Glitch Searches for pulses narrower (or Glitch Trigger Control Window (see
wider) than the specified width, or page 431)
ignores glitches narrower (or wider)
than the specified width.
Pattern Search for a logic pattern (AND, Serial Pattern Control Window (see
OR, NAND, or NOR) across multiple page 438)
waveforms with each input set to
either High, Low, or Don'’t Care.
Search for when the event goes true,
goes false, or stays valid for >, <, =, or
# a user-specified time. Additionally,
you must define one of the inputs
as a clock for synchronous (state)
searches.
Pulse Width Searches for positive or negative Width Trigger Control Window (see
pulse widths that are >, <, =, or# a page 449)
user-specified pulse width
Runt Searches for positive or negative Runt Trigger Control Window (see

pulses that cross one amplitude
threshold but fail to cross a second
threshold before crossing the first
again. Search for all runt pulses or
only those with a duration >, <, =, or #
a user-specified time.

page 435)

Setup and Hold

Search for violations of user-specified
setup and hold times.

Setup and Hold Trigger Control
Window (see page 439)

State

Searches for the condition when

all logic inputs to the selected logic
function cause the function to be True
or False when the clock input changes
state.

Logic State Trigger Control Window
(see page 443)
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Set search parameters

Search type Description Equivalent trigger
Timeout Searches for no pulse in a specified Timeout Trigger Control Window (see
time. page 444)
Transition Search for rising and or falling edges Transition Time Trigger Control
that are >, <, =, or # a user-specified Window (see page 446)
time.
Window Searches for a signal that is entering Window Trigger Control Window (see
or leaving the threshold window. page 451)
Qualify the search in terms of time
by using the When Wider option, or
by the logical state of other channels
using the When Logic option.
DDR Searches Searches for DDR read or write events None
on source waveforms.
Bus Search for bus events on source Bus Trigger Control Window for

waveforms.

Parallel (see page 399)

Bus Trigger Control Window for 12C
Serial (see page 403)

Bus Trigger Control Window for SPI
Serial (see page 405)

Bus Trigger Control Window for
RS232 Serial (see page 406)

Bus Trigger Control Window for USB
Serial (see page 408)

Search MIPI Bus (see page 345)
Bus Trigger Control Window for PCle
Serial (see page 415)

Bus Trigger Control Window for CAN
Serial (see page 415)

Bus Trigger Control Window for LIN
Serial (see page 416)

Bus Trigger Control Window for
FLEXRAY Serial (see page 418)
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Check search results

From the Analyze menu, select Search; then open the Results tab.

Overview

The table in this window displays timing information for all marks placed during a search.

To use

For information on the controls, click the buttons.

Results: Mark Table ' LX ]
|_ Index Type Src | Location ey mT1E:me Deitans e Description
1 Edge C1 | -980ps +Edge: level=0V -

LT | 2 Edge C1| -928ps |000 000 000 000 052 +Edge: level=0V
a =) Edge C1| -862ps | 000 000 000 000 066 +Edge: level=0V
' 4 Edge C1| -808ps [000 000 000 000 054 +Edge: level=0V
= 5 Edge C1 | -762ps | 000 000 000 000 D046 +Edge: level=0V
i i} Edage C1 | -688ps | 000 000 000 000 074 +Edge: level=0V o

ad
Behavior

The Location and Time Delta columns list the search results for each mark placed by the instrument for the
search Type indicated. You can also use the buttons to edit or change the format of the table and save
results to a file.
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View the search counts results

From the Analyze menu, select Search; then open the Results tab and click the Count button.

Overview

Use the controls in this window to view the number of times the search criteria was met and the instrument
placed a mark on the waveform.

To use

For information on the controls, click the buttons.

_Resulls: Counts
Edge

Configure

Behavior

The table in this window displays count results for automated search and mark operations. The Count
column displays the number of times the search conditions were met for a specific Type of search.

You can also use the buttons to edit the Results Mark Table and save results to a file.

View search marks

From the Analyze menu, select Search; then open the View tab.

Overview

Use the controls in this window to display marks.
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To use

B Click the Show Marks button On or Off to display the marks placed on a waveform.

Set the search mode

From the Analyze menu, select Search; then open the Mode tab.

Overview

You can set up the instrument to stop acquiring waveforms when a search criteria is met and the instrument
finds a match.
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To use

®  Check the Stop Acquisitions if event found option box to stop acquisitions during a search, if a
match is found.

Use Search and Mark controls

318

From the Analyze menu, select Search, and then open any of the tabs.

Overview

Use these controls to find points of interest, and place or edit marks on the waveform. The Search and
Mark controls are also available through front panel buttons.

NOTE. Search and mark operations are not available on digital channels.

Cursors
Re

Push -(Fing)
¢
Mark 18
4| D

S
o )

0225008

To use

®m  Search. Click this button to turn the Search and Mark feature On or Off. Use the corresponding
Search button on the front panel to also turn the feature On or Off.

m  Prev /Next. Click this button to advance from one mark to another along the waveform. Use the
corresponding Mark <] and [> buttons on the front panel to also move from mark to mark.

E  Set /Clr. Click this button to add or delete a user mark. User marks are placed on the waveform at
center screen. Use the corresponding Mark Set/Clr button on the front panel to also add or delete a
user mark.

B Cursor 1/Cursor 2. Click one of these buttons to position a cursor at the active mark.

m  Zoom 2/ Zoom 3. Click one of these buttons to zoom the area around the active mark. Zoom 1 is the
default used by the Search and Mark feature.
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Behavior

Use the Search and Mark controls to set a mark on a waveform at a point of interest. You can return to a
mark and analyze the waveform at a later time.

Marks appear as either green or white triangles on-screen. White triangles represent locations placed
manually by the user. Other triangles represent locations placed automatically by the instrument; the color
of the triangles depend on the selected search index.

Control user marks in table

From the Analyze menu, select Search; then open the Results tab.

Overview
Use these controls to convert search marks to user marks and to edit the Result: Mark Table.

User Marks in Tahle
—a —

To use

®  Set. Click this button to add a user mark where a search mark was placed by the system. If a search
mark is not selected, then you are asked to select a search mark.

m  Set All. Click this button to add a user mark at all places where there is a search mark.

B Clear. Click to remove the currently selected user mark. If a user mark is not selected, you are
asked to first select a user mark.

B (Clear All. Click this button to remove all user marks from the Results: Mark Table.

Change mark display digits

From the Analyze menu, select Search; then open the Results tab.

Overview

Use this control to change the type of notation used in the Results: Mark Table.

T
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To use
B Click the Digits button to toggle the display notation between engineering or high precision form.

Export a mark table

From the Analyze menu, select Search; then open the Results tab.

Overview

Use these controls to export the Mark Table to a file.

To use

m  Export. Click this button to open the Save Marks Table dialog box and export the table to a file
in CSV format.

Save Mark Tahle E|
| &5 E8-
Name: emoom7_tiassn | [
Save a3 bype: |SearchMark files [*.C5Y) j Cancel
Help

View mark counts

From the Analyze menu, select Search; then open the Results tab.
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Overview

Use this control to view event and timing information for marks.

To use

B Click the View Time / Count button to toggle between the Results Mark and Results Count tables.

Set up a visual search

Overview

A visual search is performed with the same settings as the main trigger. The results of a visual search are
displayed as marks with a color distinct from those of an Analyze search.

To use
Do the following steps to set up a visual search.

1. Set up pinpoint triggers. Set up trigger controls A Event tab (see page 393)

2. Setup a visual trigger. Visual Trigger Setup (see page 467)

3. Click Mark All Trigger Events in Record.

A Event

B Event

Options

2980046

4. Visual Trigger areas are displayed in blue, or they inherit the source channel color.

5. Visual Search areas are displayed in green.
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File | Edit | Vertical | Digital

A AR AR S R AL M BN AR S A LVL’&M A A ‘-Vl- L L A S AR S AR S LT S
{c1 outa2) & (¢1 putal)

(m outa2) & (c1 on|a1)

| o]

@H 100mVidiv 500 \'mm_/'m:mv iv 312.5MSis  3.2nsipt
T 100mV 640us  -22ms 4.2ms

2080047

6. Only the active visual search area is displayed. Press the Mark Next and the Mark Prev buttons to
move the active area to other visual search areas. Active search areas only appear in the zoom window.

2080048

Use the other Analyze Search control windows to control or view the results of the Visual Search.
What do you want to do next?

B Learn about bus setups (see page 97).

B Learn about trigger setups (see page 393).

m Learn about setting up a Visual Trigger (see page 467).

B Learn about setting up a search (see page 306).
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Set up 8B10B search parameters

After setting up an 8B10B bus, go to the Analyze menu, select Search, and then select the Bus trigger type;
then open the Configure tab.

Overview

Use the controls to set up the 8B10B Bus parameters.

To use

For information on the controls, click the buttons.

_Search - Configure

Select R Type Source
¥ 1v| Bus | Bs3BI0E (> v

Configure

Results

Behavior

Clicking an entry in the Type column activates the individual search controls, similar to the one shown
above. These controls vary depending on the search Type. Setting the search conditions is similar to
setting the parameters for an Event Trigger (see page 394).

NOTE. No information will be displayed in this window until you specify at least one search Type in
the Search Select Control Window (see page 306).

To use

®  Click the Source box and select the bus number or name from the window. Bus Search Selection List

(see page 100)

m  Select the type of bus cycle or activity to search for from the Search For drop-down list.

B For some Search For selections, you must set additional fields to define other parameters such
as for an Error.
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In this example, you need to the errors to search for. Optionally, you can also set the component threshold
levels through the Logic Thresholds Setup button.

—Seamh - Configure
[]

T ] b lwwos © | -

Results

Click the Search For selections Error (see page 324), Pattern (see page 325), Character/Symbol (see
page 325), or Any Character (see page 326) to view their parameters.

What do you want to do next?

B Learn about bus setups. (see page 97)

Search for error

—Seanch - Configure
Iv]

v me mme © |

Configure

Results
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Search for pattern

IliEiiEIIlliaiiiiiiilllllllllll
[~]
Fiv| s Jwwue G fratem _|v. reshel

Select
Configure

Results

() | K28.5 | K28.5 [ K28.5 [ K28.5 |
®

1100000101 0011111010 §| 1100000101 0011111010 W N
mn 0011111010 | 1100000101 0011111010 | 1100000101 prrn— i

Search for character/symbol

The mode options available in Search For Character/Symbol are Character, Symbol, and Disparity.
| Search - Configure
i e G T resin

Results

© | K28.5 |
L]

1100000101

Eer v B oorririono |

Select the Disparity from the drop-down list. Click Character to search for a character. Click Symbol
to search for a symbol. Click Setup to adjust the logic thresholds.
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Search for any character

_Seamh - Configure

Select ]

v oe Jwem | N

Configure

Results

Set up RS-232 search parameters

After setting up an RS-232 bus, go to the Analyze menu, select Search, and then select the Bus trigger
type; then open the Configure tab.

Overview

Use the controls to set up the RS-232 Bus parameters.

To use

For information on the controls, click the buttons.

_Search - Configure
[~]
Fiv| s Jowmsz &)

Configure

Results
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Behavior

Clicking an entry in the Type column activates the individual search controls, similar to the one shown
above. These controls vary depending on the search Type. Setting the search conditions is similar to
setting the parameters for an Event Trigger (see page 394).

NOTE. No information will be displayed in this window until you specify at least one search Type in
the Search Select Control Window (see page 306).

To use

B Click the Source box and select the bus number or name from the window. Bus Search Selection List

(see page 100)

B Select the type of bus cycle or activity to search for from the Search For drop-down list.

B For some Search For selections, you must set additional fields to define other parameters such as
for a Data.

In this example, you need to set a Number of Bytes, Data Format, and Data Value (click the Edit
(see page 942) button). Optionally, you can also set the component threshold levels through the Logic
Thresholds Setup button.

Search - Configure

Source
Bus B4RS-232 »

Diara Word
Start —————————
Bt 1 1 0 1 0 0 1 1
L |es .

Click the Search For selections Start (see page 328), Parity Error (see page 328), or Data (see page 329) to
view their parameters.

What do you want to do next?

®  Learn about bus setups. (see page 97)
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Search for start

Configure

Drata Word
Slan,—’*'—.|smp
Bt 1 1 0 1 0 0 1 1

Configure

Drata Word
Slan,—’*'—.|smp
Bt 1 1 0 1 0 0 1 1
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Search for data

The data type options available in Search For Data are Number of Bytes, Data Format, and Data Value.

_Sean:h - Configure

Results

Select the Data Format from the drop-down list. Click Edit to enter the data value. Click Setup to
adjust the logic thresholds.

Set up SPI search parameters

After setting up an SPI bus, go to the Analyze menu, select Search, and then select the Bus trigger type;
then open the Configure tab.

Overview

Use the controls to set up the SPI Bus parameters.

To use

For information on the controls, click the buttons.

_Sean:h - Configure
[~]

Fov] o Jme  ©

Configure

Results

MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series 329



Analyzing waveforms Set up SPI search parameters

Behavior

Clicking an entry in the Type column activates the individual search controls, similar to the one shown
above. These controls vary depending on the search Type. Setting the search conditions is similar to
setting the parameters for an Event Trigger (see page 394).

NOTE. No information will be displayed in this window until you specify at least one search Type in
the Search Select Control Window (see page 306).

To use

B (Click the Source box and select the bus number or name from the window. Bus Search Selection List

(see page 100)

B Select the type of bus cycle or activity to search for from the Search For drop-down list.

B For some Search For selections, you must set additional fields to define other parameters such as for
Data.

In this example, you need to set a Data Format, Number of Words, and Data Value (click the Edit (see
page 942) button). Optionally, you can also set the component threshold levels through the Logic
Thresholds Setup button.

Search - Configure

Select =L Type Source
Vv Bus B3:SPI

Click the Search For selections Data (see page 331) or SS Active (see page 331), to view their parameters.

What do you want to do next?

B Learn about bus setups. (see page 97)
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Search for SS Active

_Sean:h - Configure

Select Type Source
Vv Bus B3:SPI

Configure

Search for data

The data type options available in Search For Data are Number of Bytes, Data Format, and Data Value.

_Sean:h - Configure

Select Type Source
Vv Bus B3:SPI

Results

Select the Data Format from the drop-down list. Click Edit to enter the data value. Click Setup to
adjust the logic thresholds.

Set up 12C search parameters

After setting up an [12C bus, go to the Analyze menu, select Search, and then select the Bus trigger type;
then open the Configure tab.

Overview

Use the controls to set up the I12C Bus parameters.
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332

To use

For information on the controls, click the buttons.

_Search - Configure

o [~ Type Source
Vv Bus

Results

Behavior

Clicking an entry in the Type column activates the individual search controls, similar to the one shown
above. These controls vary depending on the search Type. Setting the search conditions is similar to
setting the parameters for an Event Trigger (see page 394).

NOTE. No information will be displayed in this window until you specify at least one search Type in
the Search Select Control Window (see page 306).

To use

®  Click the Source box and select the bus number or name from the window.Bus Search Selection List

(see page 100)

B Select the type of bus cycle or activity to search for from the Search For drop-down list.

B For some Search For selections, you must set additional fields to define other parameters such as
for a Data.
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In this example, you need to set a Addressing Mode, Number of Bytes, Data Format, and Data Value (click
the Edit (see page 942) button). Optionally, you can also set the component threshold levels through the
Logic Thresholds Setup button.

Fav] se Jwm  ®

Configure

Results

e v

Click the Search For selections Start (see page 333), Stop (see page 334), Repeated Start (see page 334),
Missing ack (see page 334), Address (see page 335), Data (see page 335), orAddress and Data (see
page 336) to view their parameters.

What do you want to do next?

®  [earn about bus setups. (see page 97)

Search for start
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Search for stop

_Sean:h - Configure
] :
Pov| e e |

Configure

Search for repeated start

_Sean:h - Configure
Iv]
Fov| ae Jo  ®|

Configure

Search for missing ack

_Sean:h - Configure
Iv]
Fov| o Jo  ®]

Configure

Results

334 MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series



Analyzing waveforms Set up I12C search parameters

Search for address

The address mode options available in Search For Address are Address Format, Address Value,
Addressing Mode, Special Address, and Direction.

_Sean:h - Configure
= .
Fav| ms |mec )| v fBinary | v

7o vhnoe v oomiCare ) | v I s

Select the Address Format, Addressing Mode, special Address, and Direction from the drop-down
lists. Click Edit to enter the address value. Click Setup to adjust the logic thresholds.

Search for data

The data type options available in Search For Data are Addressing Mode, Number of Bytes, Data
Format, and Data Value.

_Sean:h - Configure

Configure

Results

Select the Addressing Mode and Data Format from the drop-down lists. Click Edit to enter the data
value. Click Setup to adjust the logic thresholds.
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Search for address and data

The address and data mode options available in Search For Address are Address Format, Address
Value, Addressing Mode, Special Address, Direction, Number of Bytes, Data Format, and Data Value.

_Sean:h - Configure
¥ e
"ov| s |eec ) | v feinary v |

Configure

Results

s viNore v |oentca 00 v Meseun

T ey v o000 ey

Select the Address Format, Addressing Mode, special Address, Direction, and Data Format from
the drop-down lists. Click Edit to enter the address and data values. Click Setup to adjust the logic
thresholds.

Set up USB search parameters

After setting up an USB bus, go to the Analyze menu, select Search, and then select the Bus trigger type;
then open the Configure tab.

Overview

Use the controls to set up the USB Bus parameters.

To use

For information on the controls, click the buttons.

_Sean:h - Configure
< 7

P1v| s Jesus @) -
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Behavior

Clicking an entry in the Type column activates the individual search controls, similar to the one shown
above. These controls vary depending on the search Type. Setting the search conditions is similar to
setting the parameters for an Event Trigger (see page 394).

NOTE. No information will be displayed in this window until you specify at least one search Type in
the Search Select Control Window (see page 306).

To use

®  Click the Source box and select the bus number or name from the window. Bus Search Selection List

(see page 100)

B Select the type of bus cycle or activity to search for from the Search For drop-down list.

®  For some Search For selections, you must set additional fields to define other parameters such as
for a Error.

In this example, you need to set an Error Type. Optionally, you can also set the component threshold
levels through the Logic Thresholds Setup button.

_Search - Configure

Select All Type Source

Wav Bus  |B5USE » PID Check Bits | ¥ |

Configure

Click the Search For selections Sync (see page 338), Reset (see page 338), Suspend (see page 338),
Resume (see page 339), End of Packet (see page 339), Token (Address) Packet (see page 340), Data
Packet (see page 340), Handshake Packet (see page 341), Special Packet (see page 341), or Error (see
page 342) to view their parameters.

What do you want to do next?

®  Tearn about bus setups. (see page 97)
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Search for sync

I¥]

v oe Jmum

Configure

Results

Search for reset

_Seanch - Configure
Iv]

(P 1v] s fesuse & | i

Configure

v me e o

Configure

Results
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Search for resume
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Search for token (address) packet

The token address packet mode options available in Search For Token (Address) Packet are Token
Type, Address Format, Address, Endpoint Format, and Endpoint.

_Search - Configure
select All Type Source I

Wiv| Bus | BSUSE > v [ANY (xx01) | ¥

Configure

Hex (v xx (et

onary | v| L

Select the Token Type, Address Format, When address is, and Endpoint Format from the drop-down
lists. Click Edit to enter the address and endpoint values. Click Setup to adjust the logic thresholds.

Search for data packet

The data packet options available in Search For Data Packet are Data Packet Type, When data packet
is. Number of Bytes, Data Format, Offset, and Data Value.

_Search - Configure
Select All Type Source

Vv Bus B5:USB > ﬂ ﬂ
= |7]

Configure

Results

anay v [ x b
1

Select the Data Packet Type, When data packet is, Data Format, and Offset from the drop-down lists.
Click Edit to enter the data value. Click Setup to adjust the logic thresholds.
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Search for handshake packet

The handshake packet option available in Search For Handshake Packet is Handshake Type.

_Sean:h - Configure
[]
(@[ e e | v [y xio) v

Select the Handshake Type from the drop-down list. Click Setup to adjust the logic thresholds.

Search for special packet

The special packet option available in Search For Special Packet is Special Type.

_Sean:h - Configure
]

Fov] o mm v oy 000) v

Results

Select the Special Type from the drop-down list. Click Setup to adjust the logic thresholds.
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Search for error

The Error option available in Search For Error is Error Type.

Search - Configure
I¥]
P | e e 6| v [Pip check gis | v

Configure

Select the Error Type from the drop-down list. Click Setup to adjust the logic thresholds.

Search for pattern

The options available in Search For Pattern are Character, Symbols RD+, Symbols RD-, and Disparity.

Results

1100000110§0011111001 1100000101 j0011111010 e . N
u 0011111001 §1100000110§0011111010§1100000101 pum—— —

Select the Character, Symbols RD+, Symbols RD-, and Disparity
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Search for character/symbol

The options available in Search For Character/Symbol are Character, Symbol RD+, Symbol RD-,
and Disparity..

_Sean:h - Configure
]

(M1v| es feiuss ()

o
.
Either | ¥ B601 1111010

Select the Character, Symbol RD+, Symbol RD-, and Disparity.

Search for long ordered set

The options available in Search For Long Ordered Set are types of ordered sets.

_Sean:h - Configure
]

wiv| me lews | M L

Results

Select the ordered set.
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344

Search for packets

The data packet options available in Search For Packets are types of Packets.

Select v

Fiv[ ms fwe  ©

Configure

Results

Select the packet types.

Search for LFPS
_Seamh - Configure

[~]

(Fiv| ee feuss ) M

Configure

Results

Results
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Set up MIPI search parameters

After setting up a MIPI bus, go to the Analyze menu, select Search, and then select the Bus trigger type;
then open the Configure tab.

Overview

Use the controls to set up the MIPI Bus parameters.

To use

For information on the controls, click the buttons.

_Search - Configure

S All Type Source

Miv| euw |etmeosia o [(Sop [V

Configure

Behavior

Clicking an entry in the Type column activates the individual search controls, similar to the one shown
above. These controls vary depending on the search Type. Setting the search conditions is similar to
setting the parameters for an Event Trigger (see page 394).

NOTE. No information will be displayed in this window until you specify at least one search Type in
the Search Select Control Window (see page 3006).

To use
®  Click the Source box and select the bus number or name from the drop-down list.
m  Select the type of bus cycle or activity to search for from the Search For drop-down list.

B For some Search For selections, you must set additional fields to define other parameters such as for
a Long Packet.
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In this example, you need to set a Data Type Value, Virtual Channel, Direction, Word Count, Number of
Bytes, Payload Format, Payload Value, and Byte Offset (click the Edit (see page 942) button). Optionally,
you can also set the component threshold levels through the Logic Thresholds Setup button.

_Sean:h - Configure
]

(P 1v | e Jetmeosi & [ v RAny (v

Results n

Click the Search For selections Stop (see page 346), Start of Transmission (see page 347), End of
Transmission (see page 347), Bus Turn Around (see page 347), Escape Mode (see page 348), Warning
(see page 348), Error (see page 349), Short Packet (see page 350), or Long Packet (see page 351) to
view their parameters.

What do you want to do next?

®m Learn about bus setups. (see page 97)

Search for stop

_Sean:h - Configure
Iv]

(17| e [eturicsi2 & | -

Configure
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Search for start of transmission

—Seamh - Configure
]

17| es leiupcsz & | M

Search for end of transmission

—Seamh - Configure
[~]

v | me |stumcaz > M

Search for bus turn around

—Seamh - Configure
[~]
e Bus Tum Around | v

Results
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Search for escape mode

The escape mode command options available in Search For Escape Mode are as follows:
_Sean:h - Configure
Il
W 1v| e Jetwposit ) [EscapeMode v

Configure

Any

Any

87h: Low-Power Data Transmission
78h: Ultra-Low Power State

46h: Reset Trigger

BAh: Tearing Effect

84h: Acknowledge

Search for warning

The warning type options available in Search For Warning are as follows:
[]
v | o Jorurns & [Womne______Iv]

Configure

Results
Any
Any
ECC Warming
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Search for error

The error type options available in Search For Error Type are as follows:

_Seamh - Configure
[]
e | Ero
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350

Search for short packet

The data type options available in Search On Short Packet are as follows:

Any

00h: Frame Start

01h: Frame End

02h: Line Start

03h: Line End

08h: Generic Short Packet 1
09h: Generic Short Packet 2
0Ah: Generic Short Packet 3
0Bh: Generic Short Packet 4
0Ch: Generic Short Packet 5
0Dh: Generic Short Packet 6
0Eh: Generic Short Packet 7
0Fh: Generic Short Packet 8
Any v

=

=

The Search For Short Packet window allows you set the Virtual Channel, Direction, Packet Data
Format, and the Packet Data Value (see page 941).

_Search - Configure

T All Type Source

W v | s [smpipsit () [(ShortPacket v [ X efAny v

Configure

MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series




Analyzing waveforms

Set up MIPI search parameters

Search for long packet

The data type value options available in Search For Long Packet are as follows:

MIPI CSI-2 MIPI DSI-1

Any Any

10h: Null 09h: MNull

11h: Blanking 19h: Blanking

12h: Embedded 29h: Generic Long Write

18h: YUV420 8-bit 39h: DCS Long Write

19h: YUV420 10-bit 0Eh: Packed Pixel Stream 16-bit RGB, 56-5

1Ah: YUV420 8-bit (Legacy) 1Eh: Packed Pixel Stream 18-bit RGB, 6-6-6

1Ch: YUV420 8-bit (Chroma Shifted Pixel Sampling) 2Eh: Loosely Packed Pixel Stream 18-bit RGB, 6-6-6
1Dh: YUV420 10-bit (Chroma Shifted Pixel Sampling) 3Eh: Packed Pixel Stream 24-bit RGE, 8-8-8 B2
1Eh: YUV422 8-bit 0Dh: Packed Pixel Stream 30-bit RGB, 10-10-10

1Fh: YUWV422 10-bit 1Dh: Packed Pixel Stream 36-bit RGB, 12-12-12

20h: RGB444 0Ch: Loosely Packed Pixel Stream 20-bit YCbCr, 4:2:2
21h: RGB555 1Ch: Packed Pixel Stream 24-bit YCbCr, 4:2:2

22h: RGB565 2Ch: Packed Pixel Stream 16-bit YCbCr, 4:2:2

23h: RGBRGE 3Dh: Packed Pixel Stream 12-bit YCbCr, 4:2:0

24h: RGBS8S 1Ah: Generic Long Read Response ny
28h: RAWE 1Ch: DCS Long Read Response

29h: RAWT I any v
2Ah: RAWS

2Bh: RAW10

2Ch: RAW12

2Dh: RAW14

30h: User 8-bit 1

31h: User 8-bit 2

32h: User 8-bit 3

33h: User 8-bit 4

34h: User 8-bit 5

35h: User 8-bit 6

36h: User 8-bit 7

37h: User 8-bit 8

Search - Configure

Type Source
Bus BTMIPIDSIT (-

The Search For Long Packet window allows you to set the Virtual Channel, Direction, Data Type
Value, Word Count, Number of Bytes, Payload Format, Offset in bytes, and Payload Value (see

page 941).
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Set up PCle search parameters

352

After setting up a PCle bus, go to the Analyze menu, select Search, and then select the Bus trigger type;
then open the Configure tab.

Overview

Use the controls to set up the PCle Bus parameters.

To use

For information on the controls, click the buttons.

IliEHIEIIIliHIiiiiiHIIIIIIIIIIIIIIIIIIIIIII

select L Type Source
M1v| Bus |BIPCE » ||Pattern v il

Results

[ ]
o
[ ]

1100000101 0011110100 0011110100 0011110100 g
n 0011111010 1100001011 1100001011 1100001011 p— pr—

Behavior

Clicking an entry in the Type column activates the individual search controls, similar to the one shown
above. These controls vary depending on the search Type. Setting the search conditions is similar to
setting the parameters for an Event Trigger (see page 394).

NOTE. No information will be displayed in this window until you specify at least one search Type in
the Search Select Control Window (see page 306).

To use

®  Click the Source box and select the bus number or name from the window. Bus Search Selection List

(see page 100)

m  Select the type of bus cycle or activity to search for from the Search For drop-down list.

B For some Search For selections, you must set additional fields to define other parameters such as
for Character/Symbol.
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In this example, you need to set a Character, Symbol, and Disparity.

Trv| e leece )

Configure

Results

-]

[ ] 1100000101
Eiter | ¥ B 0011111010

Click the Search For selections Long Ordered Set (see page 353), Any Control Character (see page 354),
or Error (see page 354), to view their parameters.

What do you want to do next?

B [earn about bus setups. (see page 97)

Search for long ordered set
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Search for any control character

_Seanch - Configure
Iv]

X1 B BTG v |

Configure

Results

Select the Ordered Set from the drop-down list.

Search for error

Configure

Results

Set up CAN search parameters

354

After setting up a CAN bus, go to the Analyze menu, select Search, and then select the Bus trigger type;
then open the Configure tab.

Overview

Use the controls to set up the CAN Bus parameters.

To use

For information on the controls, click the buttons.

MSO/DPO70000DX, MSO/DPO70000C, DPO7000C, and MSO/DPO5000B Series



Analyzing waveforms Set up CAN search parameters

_Sean:h - Configure
[~]

(Fiv| Bis  |ecan ()

Configure

Results

Behavior

Clicking an entry in the Type column activates the individual search controls, similar to the one shown
above. These controls vary depending on the search Type. Setting the search conditions is similar to
setting the parameters for an Event Trigger (see page 394).

NOTE. No information will be displayed in this window until you specify at least one search Type in
the Search Select Control Window (see page 306).

To use

B (Click the Source box and select the bus number or name from the window. Bus Search Selection List

(see page 100)

m  Select the type of bus cycle or activity to search for from the Search For drop-down list.

m  For some Search For selections, you must set additional fields to define other parameters such
as for Ident & Data.

In this example, you need to set an Identifier, Direction, Data is, and Data value (click the Edit (see
page 942) button). Optionally, you can also set the component threshold levels through the Logic
Thresholds Setup button.

_Sean:h - Configure

[+]

IZM TR

Configure

Results Binary Standard _[¥ |
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Click the Search For selections Frame (see page 356), Identifier (see page 356), Data (see page 357),
End of Frame (see page 357), Missing ack (see page 357), or Bit Stuff Error (see page 358), to view
their parameters.

What do you want to do next?

B earn about bus setups. (see page 97)

Search for frame

_Seanch - Configure
Il
Tiv| ms Jeca G fFeme  [vhDma  |v] —

Configure Remote

Error

Results

Search for identifier

_Seanch - Configure
Iv]

(v B Jmoan ) fuentter v wreshol

Configure

Results Binary Standard _| ¥ |

[ ] L] o
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Search for data

The data type options available in Search For Data are Number of Bytes, Data, and Data is.
_Seamh - Configure
[¥]
B CETIRC)

Search for end of frame

Results

Results
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Search for bit stuff error

Configure

Set up LIN search parameters

After setting up an LIN bus, go to the Analyze menu, select Search, and then select the Bus trigger type;
then open the Configure tab.

Overview

Use the controls to set up the LIN Bus parameters.

To use

For information on the controls, click the buttons.
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Behavior

Clicking an entry in the Type column activates the individual search controls, similar to the one shown
above. These controls vary depending on the search Type. Setting the search conditions is similar to
setting the parameters for an Event Trigger (see page 394).

NOTE. No information will be displayed in this window until you specify at least one search Type in
the Search Select Control Window (see page 306).

To use

B Click the Source box and select the bus number or name from the window. Bus Search Selection List

(see page 100)

B Select the type of bus cycle or activity to search for from the Search For drop-down list.

B For some Search For selections, you must set additional fields to define other parameters such as for
Data.

In this example, you need to set a Data is, Number of Bytes, and Data value (click the Edit (see page 942)
button). Optionally, you can also set the component threshold levels through the Logic Thresholds Setup
button.

_Search - Configure

Select =Y Type Source
V1w Bus BILIN

Configure

Results

Click the Search For selections Identifier (see page 360) or Ident & Data (see page 360), Wakeup Frame
(see page 361), Sleep Frame (see page 361), or Error (see page 361) to view their parameters.

What do you want to do next?

®  Learn about bus setups. (see page 97)
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Search for identifier

_Sean:h - Configure
[l
(Fiv| ms fmun () |

Configure

Select the Identifier from the drop-down list. Click Edit to enter the data value.

Search for ident & data

The data type options available in Search For Ident & Data are Number of Bytes, Identifier, Data is,
and Data value.

_Sean:h - Configure
]
[Piv| Es min )

Configure

Select the Data from the drop-down list. Click Edit to enter the data value.
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Search for wakeup frame

Configure

Results

Results

Search for error

Results
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Set up FLEXRAY search parameters

After setting up an FLEXRAY bus, go to the Analyze menu, select Search, and then select the Bus trigger
type; then open the Configure tab.

Overview

Use the controls to set up the FLEXRAY Bus parameters.

To use

For information on the controls, click the buttons.

_Search - Configure
Select All Type Source

M1v| Bus |B4FLEXRAY (») [|Startof Frame |V | e shoN

Configure

Results

Behavior

Clicking an entry in the Type column activates the individual search controls, similar to the one shown
above. These controls vary depending on the search Type. Setting the search conditions is similar to
setting the parameters for an Event Trigger (see page 394).

NOTE. No information will be displayed in this window until you specify at least one search Type in
the Search Select Control Window (see page 306).

To use

®  Click the Source box and select the bus number or name from the window. Bus Search Selection List

(see page 100)

m  Select the type of bus cycle or activity to search for from the Search For drop-down list.

®  For some Search For selections, you must set additional fields to define other parameters such as for
Data.
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In this example, you need to set a Qualifier, Number of Bytes, Offset, and Data value (click the Edit
(see page 942) button). Optionally, you can also set the component threshold levels through the Logic
Thresholds Setup button.

_Seamh - Configure
[]

25 I CEEEC) K

Configure

sy | [y

[ x|
- |

Click the Search For selections Indicator Bits (see p